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Introduction

Purpose of this document

This document provides an overview of the FSEC Toolkit review process and
describes the detailed checks to be undertaken by the review team when undertaking
a review of the F&RS configuration of the FSEC Toolkit.

Scope and approach to reviewing the FSEC Toolkit

The review is limited to the ‘as-is’ base case. It does not cover any strategy datasets or
the application of the FSEC Toolkit to the assessment of new F&RS resource changes.

The approach is to:

e First check that the read only (Risk Assessment Definitions) settings are unaltered

e Check those elements of FSEC that are common to all risk assessment modules,
namely road network and resources (stations, vehicles, crews and planning
scenarios)

e Then check the process of using the incident and other data for the risk
assessment of dwellings, special services, other buildings and major incidents, and
then

e Check the FSEC results (Performance Predictors) to see if the results are valid.

Thus, as illustrated in Figure 1, the approach is to review the Inputs, the Processing
and the Outputs.
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Overview of the FSEC Toolkit

Figure 1

SAB[IOAQ o
sjuapIoul JoleN

1500 SYX o
SAB[IOAO0 9)el A)ITeIR]
(sSO[ F 79 SUIeap)
$10101pa1d 9OUBULIOTIOd
sSuIp[Ing JOYIO

1500 SUX o
SAB[IOAO0 9)BI A)ITRIR]
(syyeap)
$10101paid 9OUBULIOJIO]
S901AI0S [e109dg

1500 SYW
SAe[IOAO 9)BI AJITRIR]
(speap)
$10301pai1d 9OUBULIOJIO]
sSuremg

sindinQ

SOLIBUQS SUIUUE[J o
SBOJE NSIY o
syuaproul Jole]\

SJUSUISSOSSE IS o
SOLIBUQOS SUTUUR[ o
SVILODL o
sdnoi3 sy

SBOIE SIY o

SSUIp[Ing JOYI0

SOLIBUSOS FUIUUB[ e

sdnoiS sy

SBOJE NSIY o
$901AI9S [B103dS

SOLIEUQ0S Suruue[d e

sdnoiS sy

SBOJE NSTY o
sSurem

-

Surssao0Id

spoads pue
$1S00 ‘SMAID ‘SIS A

BIRD 901JJO UOneNneA
A9AIns 9douUBUPIQ
— JI0M}oU PROY

-

sSuIp[Ing Joyjo uo

BJEp JO S90INOS IO
siefJ

J11nq esodand 29 SQINH
Uo BJEP JO S90INOS OSIA
SO[1J AJoJes oI1,]

BIED 9010 UOnEN[BA

/ dewe)selN

$9NJsal Io
sanensed ‘syIeap ‘Yum
SJUSPIOUI 901AISS [e10adg

SONOSII 29 SAN[BNSED
‘SYpRaP ‘soJIJ Sulem(g
SNSUd))

sindug

10



Introduction

Overview of the FSEC Toolkit Review process

Requesting a Review

A review can be requested from the FSEC helpdesk. The request from the F&RS
needs to be confirmed by the CFO or DCFO of the respective F&RS.

Before the request is confirmed the F&RS should be aware that, although guided, they
will need to commit significant effort themselves to the review. Also they should note
that in order to qualify for a review the F&RS needs to have, as a minimum,
completed:

e The preparation of the road network, creation of crews, vehicles, stations and
costs

e At least one* of dwelling, special services or other buildings modules

e The running of the travel time matrix (all 3 stages), re-linked the areas and have
run FSEC

*It is possible to review one module at a time, such as reviewing dwelling first and

then special services. However, the F&RS should note that second or third reviews
will not be funded by the ODPM.

Review Process

Stage 1: Pre-review checks and preparation by the F&RS (Section 1)

Before the review is scheduled the F&RS needs to:

e Complete the review preparation tasks
e Complete the progress and project management checklists
e Run the pre-review text queries

e Send the output back to the FSEC helpdesk

Stage 2: F&RS Review qualification (Section 2)

The status of FSEC work will be checked to assess readiness for a review, such as
whether there is evidence that sufficient data has been loaded and sufficient progress
made in the FSEC analysis to justify a review.

Once the F&RS has been accepted for review, the ODPM will issue a confirmation
letter to the FSEC project manager and the CFO. In response the F&RS needs to
confirm that the FSEC team and project manager will be available at the agreed time

of the review for the Stage 5 work. At this point the F&RS should:

e Clone the dataset to be reviewed and name it (F&RS name) FSEC review dataset 1’

11
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Stage 3: Load and run text queries (Section 3)

Once the F&RS has been accepted for a review and has confirmed the availability of
its team, the text queries should be loaded and run on the F&RSs’ cloned dataset.

Stage 4: Reviewers desk top interrogation of FSEC text queries &
exports (Section 4)

The review team will complete a desk top check of F&RS data and prepare F&RS
specific review queries.

The review team will confirm at this stage whether the FSEC analysis has been

progressed to a stage that justifies an F&RS visit, and then confirm a site visit(s) with
the F&RS project/ team manager.

Stage 5: Review Team visits to F&RS for process and philosophy
checks and follow up to Stage 4 (Section 5)

During the visit the reviewer(s) will:
e Carry out process and philosophy checks
e Review the FSEC project management arrangements.

e Discuss any anomalies found in the FSEC text queries and exports, confirming or
eliminating them as appropriate

Stage 6: Review Team reporting and rating of modules (Section 6)

On completion of the review, a standardised review report will be copied to:
e The ODPM FSEC manager
e The F&RS CFO

e The F&RS FSEC team/project manager



Stage 1 - Pre Review Checks and Preparation

1.1 F&RS FSEC Toolkit Review Preparation

After the request for a review is confirmed the helpdesk will supply pre-review text
queries to run. At the time of requesting a review the F&RS should:

1. Identify the correct data set to be reviewed

2. Ensure all three stages of the travel time matrix have been run
3. Ensure all risk areas and risk groups have been linked

4. Run FSEC

The review is to be run on the ‘Base Case’ only. The Base Case is meant to have all
existing F&RS resources, planning scenarios based on current Pre-Determined
Attendances and census/ other building data representing the current position (rather
than projections of future population eto).

1.2 Self-reporting of Progress and Project Management

The F&RS should complete the progress checklist and the project management check
list (presented in Appendix C as Table 17 and Table 18 respectively). These will be
provided separately to the F&RS once the request for a review has been confirmed.

1.3 Pre-Review Text Queries

These text queries cover the summary statistics and performance predictors for
dwellings, other buildings, special services and major incidents. They include risk
assessment and resources definitions.

The pre-review text queries should be loaded, run and then the data produced saved
as detailed below:

1.3.1 Copying Pre Review files to the FSEC Machine

The file ‘FSEC Toolkit Review Stage 1 Installation.exe’ supplied by the FSEC Help
Desk should be run. This will copy a few files to the FSEC machine that are required
to run the pre review text queries.

13
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1.3.2 Exporting Summary Statistics and Performance Predictors

The summary statistics and performance predictors should be exported to a text file
using the Action » Text Query option from the menu at the top of the screen and
selecting the following criteria (the ‘all’ button should be highlighted for the date
range):

Feature Layout » Get Save as file name
Multiple Features Summary Statistics SummaryStatistics.txt
Multiple Features Performance Predictors PerformancePredictors.txt

1.3.3 Exporting Resource Definitions

The resource definitions should be exported to a text file using the Action » Text
Query option from the menu at the top of the screen and selecting the following
criteria (the ‘all’ button should be highlighted for the date range):

Feature Layout » Get Save as file name

Resource Definitions LOO3 Resource Definitions | TQO03 ResourceDefinitions.text

Note The Resource Definitions feature is available under the ‘FSEC features 1 to 499’
list. Click on the ‘+’ at the side of the feature to expand the list.

1.3.4 Exporting Risk Assessment Definitions

The Risk Assessment Definitions should also be exported. This can be done as
follows:

From within FSEC:

click on Overlay » Risk Assessment Definitions
e click on File » Export

e enter the file name RAD.imp

e ensure ‘whole record’ option is selected

e click on ok button



Stage 1 — Pre Review Checks and Preparation

1.4 Returning the Pre-Review Information to FSEC Help Desk
The following data should be returned to the FSEC Help Desk:

Data Required

Completed progress checklist

Completed project management checklist

SummaryStatistics.txt

PerformancePredictors.txt
RAD.imp
TQO03_ResourceDefinitions.txt

1.5 Returning the Data Set and Data Files

Once accepted for a review, and a date agreed, the F&RS should Clone the dataset to
be reviewed and call it “F&ERS name review data set 1”. This should be copied onto a
CD and returned to the FSEC help desk along with the files indicated below (which
can be found in the C:\FSEC\Brigade\Tables folder).

The following data should be returned at this stage:

F&RS name review data set 1 (the cloned dataset)

brosdb.txt ranks.TAB
BPS.TAB RISK.TAB
crewing. TAB VCOST.TAB

PSPEED.TAB VTYPE.TAB

15
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Stage 2 - F&RS review qualification

2.1 Qualification for a Review

Once the F&RS has completed the first part of Stage 1, Stage 2 will help to determine
whether the F&RS meets the minimum qualification criteria for a review. These criteria
are intended only to ensure that the F&RS can benefit from the review.

In order to qualify for a review the F&RS needs to have, as a minimum, completed:

e The preparation of the road network, creation of crews, vehicles, stations and
Costs

e At least one* of dwelling, special services or other buildings modules

e The running of the travel time matrix (all 3 stages), re-linked the areas and run
FSEC

It is possible to review one module at a time, such as reviewing dwelling first and
then special services. However, the F&RS should note that second or third reviews
will not be funded by the ODPM.

Before the dwelling module is reviewed the F&RS should have:

e Checked location of dwellings incidents that involve deaths, casualties of rescues
e Created risk areas and groups

e Defined and assigned planning scenarios

e Run FSEC and derived dwelling performance predictors.

Before the special service module is reviewed the F&RS should have:

e Identified and checked the location of all special service incidents involving one
or more ROF/ROC/ROR (Category A incidents)

e Created risk areas and groups for all at least RTAs and preferably also for
extrications and other special services and ideally for all types of special service
(and any re-linking)

e Defined special service planning scenarios for all special service risk areas
e Run FSEC to get special service performance predictors

It should be noted that if any module’s summary statistics output contains all zeroes
(0.0) but the F&RS indicate that they have completed work on at least one part of this
module on their returned progress checksheet then this may indicate that part of the
FSEC model has not been correctly re-run. The F&RS should be advised (through the
FSEC Helpdesk) to re-run FSEC and return a revised summary statistics file.
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In the summary statistics file for special services, if there are no entries in the ‘Cat A
incidents OAs classed as....” for RTAs it is unlikely that the F&RS qualify for a review
of special services. Also it is recommended that at least RTAs should have entries for
an FSEC review to be done. Preferably RTAs, Extrications and other special services
will have been completed before the special service module is reviewed. Ideally
water rescues, line rescues and HAZCHEM will have also been done before the
special services module is reviewed, although this guideline may be varied from if the
F&RS does no attend water or line rescues or can confirm they do not occur in their
F&RS. Ladder rescues, lock in and lift releases are not essential, and indeed some
F&RS may not attend or record these types of incidents.

Before the other building module is reviewed the F&RS should have:

e Identified and checked the location (for example ensuring that they on the correct
footprint) of all hospitals, hotels, care homes and hostels

e Identified and checked location of all other types of other buildings that are
certificated

e dentified the majority of HMOs and bed sits of three or more storeys and purpose
built flats of 4 or more storeys and located them

e Created risk areas, risk groups and TGOBRAs

e Defined planning scenarios for each risk area

e Run FSEC and derived performance predictors

Before reviewing the major incident module the F&RS should have:
e Created risk areas for all major incident types

e Defined planning scenarios for each major incident risk areas
The F&RS does not need to have completed:

e Modification of the road speeds

e Modification of the site assessments of other buildings

e Loading of additional years incident data

e Checking location of incidents other than dwelling and special service
ROF/ROC/ROR

e Comparisons with alternative resource strategies

e Recorded CFS (Community Fire Safety) activity in dwelling output areas

17
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It is recommended (but is not essential) that the F&RS undertake the:

e Modification of the ‘default’ site assessments for hospitals, hotels, care homes and
hostels and other very large other buildings (as appropriate) before reviewing

e Modification of the default road speeds using F&RS data

The state of progress can be checked using the progress checklist and the pre-review
text queries. The output of these queries is in the files returned by the F&RS called
SummaryStatistics.txt and PerformancePredictors.txt.

The text query provides two sets of data, namely summary statistics (these are a

summary of the ‘input’ data) and performance predictors (the ‘results’). The key
questions are shown in Table 1.

18



Table 1: Checks on pre-review text queries

Stage 2 — F&RS review qualification

No Yes Comment

Summary statistics

Is there an entry for dwelling fatalities?

Are there entries in the count of Other Buildings
where there is >20 people for:

Hospitals, care homes, hotels, hostels, HMOs,
houses converted to flats, schools, Other
sleeping accommodation, licensed
accommaodation

Shops, offices, factories, other places of work

Is the population count consistent with ODPM
records?’

Is the total count of actual dwelling casualties
and deaths consistent with ODPM records??

Are there entries in the ‘“Total actual incidents in
OAs classed as...." for:

RTAs

Extrications

Other Special services

Water rescues

Line Rescues

HAZCHEM

Lift releases

Ladder rescues

Lock in / out

Performance predictors

Are there predicted deaths for dwellings?

Are there predicted deaths in Other Buildings?

Are there predicted deaths for special services?

Are there big differences (e.g. +/- 50% error)
between the actual and predicted number of
dwelling deaths?

1 Comparison may be made with Table 20 but note that data is not from the same source as FSEC is based on so

there may be minor differences.

2 Comparison may be made with Table 21 but note data are for deaths only and is not from the same source as

FSEC is based on so there may be minor differences.

19
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Checking Defaults and Planning Scenarios

Additional checks can be done to review the default Risk Assessment Definitions,
Resource Definitions and the planning scenario details. This information can be
reviewed using the following input files and macros. For further details on how to
run these please refer to Appendix B.

Save as
Input File MS-Excel File Macro Filename
RAD.IMP FSEC GetColumndata.xls | RetreiveColumnData RAD.xls
TQO03_ResourceDefinitions. TXT | Macros.xls ImportData TQOO03_RD.xls
Brosdb. TXT Table_Comparison.xls Macros.xls PSResources.xls
UpdateTableComparison

Note: Please refer to Appendix B for detailed instructions on running the macros, in particular for the Update Table Comparison
macro.

The following checks should be made:

RAD.xls

The RAD.xls file highlights in red any information that has been changed by the
F&RS. Some of this information can be changed and some of it must not be. At this
stage a note should be made as to whether any of the data has been highlighted. Any
items highlighted yellow in column ‘C’ can be changed.

The RADs in the RAD xls spreadsheet should be unaltered in the following cases:

e Dwellings (risk category criteria, socio-demographic benchmarks, fatality rates per
dwelling fire casualty — see figure 5 in Background section of FSEC manual)

e Special services (attendance time fatality rate per category A incident, frequency
categories, predicted deaths per km? — see figure 6 in the background section of
the FSEC manual)

e Societal Fire frequencies, rates of societal risk per TGOBRA per year or societal
risk rate categories — (see figure 8 in the background section of the FSEC manual)

e Property fire frequencies (see figure 9 in the background section of the FSEC
manual

e Societal Maximum Probable Loss of life or % of potential deaths which may be
saved (see figure 7 in the background section of the FSEC manual)

e Other Risk Multipliers (see figure 10 in the background section of the FSEC
manual)



Stage 2 — F&RS review qualification

TQO003_RD.xls

The TQO003_RD.xls file highlights in red any fire fighter costs information that has
been changed by the F&RS. It also identifies the percentage change between the FSEC
defaults and the actual F&RS values. At this stage a note should be made if there are
any missing values, or if the values are more than +/-50% of the FSEC default (the
Lothian values are presented in the spreadsheet). It should be noted that anomalies
apparent from this query may not be significant unless the F&RS has used this data in
their calculation of costs.

There should be no blanks in the costs entered in the resource definitions sheet.

PSResources.xls

The PSResources.xls file cross checks the planning scenarios and vehicles defined by
the F&RS. At this stage checks are only required on the following:

e There should be entries in the BPS, Crewing, VCOST, VIYPE, and PSPEED sheets
of the PSResource sheet

e Have planning scenarios been defined and do they have unique names? The
scenarios are listed on the ‘BPS’ sheet. Column ‘C’ should not contain any blank
values (incomplete scenario definitions) or red highlights (duplicate scenario
names)

e Have vehicles been associated to planning scenarios? The scenario and vehicle
combinations are listed on the ‘brosdb’ sheet. Column ‘b’ shows the entry type, 0
is the scenario, 1 is the vehicle used in a scenario and 2 is the vehicle details.
There should be at least one type 1 entry after each type 0. If not then a scenario
does not have any vehicles associated with it

e Have the speeds been defined for the vehicles? The PSPEED sheet shows the
speed for each vehicle. Check that column ‘B’ shows values for most vehicles.
Note that this is a percentage speed and pumps are generally classed as 100%

e Have the vehicles been given a cost? The VCOST sheet shows the vehicle costs.
Check that column ‘B’ contains values for most vehicles

2.2 Possible Project Management Issues

The entries in the project management checklist do not necessarily impact the
decision on whether to complete a review. They are required at this stage to provide
background for the reviewers and to flag up possible issues for further scrutiny. In
the event that:

(D) there is little progress in completing FSEC and

(2) evidence of little project management

then the entries in the project management checklist may be used to reinforce the

decision on whether or not to proceed with a review.
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2.3 Output of Stage 2

The output of this stage of the review process is a decision regarding whether it is
appropriate to proceed with the review given the progress made by the F&RS and the
outcome of the checks outlined in this section. This decision is to be made in
consultation with the FEU.

If the review is to proceed, the F&RS should complete the second part of Stage 1,
namely returning a dataset and some associated files to the FSEC Helpdesk
(see Section 1.5).



Stage 3 — Review team load and run text queries and
save exports

3.1 Introduction

Once the decision has been taken to proceed with the review, the review team will
load and run text queries to generate exports on the cloned dataset provided by the
F&RS. The text queries and exports required are designed to interrogate all the key

aspects FSEC and how it is set up at the F&RS review candidate.

The following sections outline how to load the review files and run the text queries
along how the results of the text queries should be saved. For detailed guidance on
running the text queries please refer to Appendix A.

Section 7.1 (in Appendix A) presents instructions about how to load the candidate
review F&RS data onto the FSEC review PC.

3.2 Copying Review files to the FSEC Machine

The ‘FSEC Toolkit Review Stage 3 Installation.exe’ should be run. This will copy a few
files to the FSEC machine that are required to run the review text queries. Note that if
the machine has been previously used for reviewing a FSEC dataset, these files should
already be present and this stage may be ignored.

3.3 Stage 1 Results Review

The queries returned as part of Stage 1 and those run in Stage 2 should be re-run
once the F&RS dataset is loaded onto the review machine and the results briefly
compared with those obtained during the analysis of Stage 2 to ensure that there are
no significant differences between the dataset on which the Stage 1 and 2 queries
were run, and the one returned for review purposes. It should be noted that the
F&RS may have made some changes to their data in the interim period. However, if
any changes in results are noted at this stage which are of such a magnitude that they
would have jeopardised the decision to proceed with the review at Stage 2 the review
should be halted and the suitability of the data questioned with the FSEC Helpdesk
and/or the F&RS.

The queries which should be re-run at this stage are therefore:
e Summary Statistics

e Performance Predictors

e TQO003

e RADXIs

e PSResources

23



FSEC Toolkit Review Manual

3.4 Road Network

The following queries should be run to evaluate the road network (remember to
ensure that the ‘all’ button is clicked for the date range before executing the query):

Feature

Criteria Name

Layout Name

Save as file name

Road Junction

Q011 Missing Road Info —
Map

L.011 Road Junction Info

TQO11_MissingRoadInfo.txt

Road Junction

Q012 Dead Ends

L.011 Road Junction Info

TQO12_DeadEnds.txt

Road Junction

Q018 First Junction Arrivals
120 min Plus

LL0O11 Road Junction Info

TQO18_FirstArrivalRJ120.txt

Road Junction

Q019 First Junction Arrivals
60 min Plus

L.011 Road Junction Info

TQO19_FirstArrivalRJ60. txt

Road Junction

Q020 First Junction Arrivals
30 min Plus

LL.011 Road Junction Info

TQO20_FirstArrivalRJ30.txt

Info

Road Link Q013 Missing Road Link Info | LO13 Road Link Info TQO13_MissingRoadLinkInfo.txt
Road Link Q027 Road Speeds Changed | LO13 Road Link Info TQO027_RoadSpeeds50.txt
by more than 50%
Road Link Q026 Road Speeds Changed | L026 Road Link Speeds | TQ026_RoadSpeedsi0.txt
by more than 10%Note 1
Output Area Q017 Missing Output Area Output Areas TQO17_MissingOutputArealnfo.txt

Risk Assessment
Definitions

Q024 Road Speed Defaults

024 Risk Assessment
Definitions Other

TQO024_RoadSpeedDefaults.txt

Vehicle

Q025 Vehicle Speeds not
100%

104 Vehicle Details

TQO025_VehicleSpeeds.txt

Note(s) 1. The output for Q026 will only produce a single line saying how many records have been changed.
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3.5 Stations, Crews, Vehicles and Planning Scenarios

The following queries should be run to evaluate how stations, crews, vehicles and
planning scenarios have been set up.

Feature

Criteria Name

Layout Name

Save as file name

Vehicles

Vehicle None required L104 Vehicle Details TQ104_VehicleDetails.txt

Vehicle Q108 Vehicles Away from | L104 Vehicle Details TQ108_VehiclesNotInStations.txt
Stations

Vehicle Q109 Vehicles East/North | L104 Vehicles Details TQ109_VehiclesNotMatched.txt
don’t match station

Vehicle Q108 Vehicle Not in PS’s 103 Vehicles Not in PS’s | TQ103_VehicleNotInPS.txt

Vehicle Q105 Vehicle Crews and 105 Vehicles Crew and TQ105_VehicleTT.txt
Turnout Time Turnout Times

Vehicle Q106 Vehicles Turnout Time| L105 Vehicles Crew and TQ106_VehicleTTReasonable.txt
Reasonable Turnout Times

Fire Station None required 100 Fire Station and TQ100_FireStationCosts.txt

Vehicles

Fire Station Stationdunction Stationdunction (Report) Stationdunction.txt

Fire Station Q101 Missing Station Info | L107 Fire Stations Details | TQ101_FireStationDetails.txt

Fire Station Q107 Stations Without 107 Fire Stations Details | TQ107_FireStationWithoutVehicles.txt

Output Area N4

None required

L1127 OA PS Vehicles —
Exclude OB

TQ127_AlIOAPSNotBuilding

Output Area N4

None required

L117 OA PS Vehicles OB

TQ130_AlIOAPSBuilding

Output Area Q115 OA Vehicles Not L115 OA PS Vehicles TQ115_0OAVehiclesDwellings.txt
Satisfied — Dwellings Dwellings

Output Area Q116 OA Vehicles Not L116 OA PS Vehicles Ml TQ116_OAVehiclesMI.txt
Satisfied — For Major
Incident Mot

Output Area Q117 OA Vehicles Not Q117 OA Vehicles Not TQ117_OAVehiclesOB.txt
Satisfied — Other Buildings | Satisfied — Other Buildings
Note 2 Note 2

Output Area Q118 OA Vehicles Not L118 OA PS Vehicles SS TQ118_OAVehiclesSS.txt

Note 4 Satisfied — Special Services
Note 3

Dwelling Risk Q120 Risk Area Missing PS | L120 Dwelling Risk Area TQ120_DRA_PS.txt

Area — Dwellings

Major Incident

Q121 Risk Area Missing PS

L121 Major Incidents Risk

TQ121_MIRA_PS.txt

Risk Area — Major Incidents M’ Area — PS
Other Buildings | Q122 Risk Area Missing PS | L122 OB Planning TQ122_OBRA_PS.txt
Risk Area — OBg Mete2 Scenarios for RA

Special Services
Risk Area

Q123 Risk Area Missing PS
— Special Services M¢3

123 Special Service Risk
Areas

TQ123_SSRAPIlanning.txt

Note(s)

1. This query can be omitted if the F&RS has not completed major incidents
2. This query can be omitted if the F&RS has not completed Other Buildings
3. This query can be omitted if the F&RS has not completed special services
4. These queries can take a long time to run
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3.6 Dwellings

The following queries should be run to evaluate how dwellings, including dwelling
incidents have been set up.

Feature Criteria Name Layout Name Save as file name
Incident Q150 Incidents in Dwellings | L150 Incidents — With IPCL | TQ150_IncidentsDwellings.txt
Reason
Incident Q152 Incidents Fireghoe! 150 Incidents — With IPCL | TQ152_IncidentsFires.txt
Reason

Incident Q160 Incidents Not 150 Incidents — With IPCL | TQ160_AllincidentsNotChecked.txt
Checked - Casualties Reason

Incident Q162 Dwelling Fires L150 Incidents — With IPCL | TQ162_DwellingFireCasualties.txt
Casualties Note 2 Reason

Incident Q163 Dwelling Fires L150 Incidents — With IPCL | TQ163_DwellingFiresNotChecked. txt
Casualties — Not Checked | Reason

Risk None required 024 Risk Assessment TQ153_RADOther.txt

Assessment Definitions Other

Definitions

Output Area None required R164 OA Census Data TQ164_CensusData.txt

OQutput Area Q165 Output Area Missing | Output Areas TQ165_0OAMissingDRA.txt
DRA

Dwelling Risk Q166 DRA Missing DRG L120 Dwelling Risk Area TQ166_DRAMissingDRG.txt

Area

Dwelling Risk Q170 DRA Fire Safety L 120 Dwelling Risk Area TQ170 DRAFireSafety

Area

Dwelling Risk None required 167 Dwelling Risks TQ167_DRG.txt

Group Groups

Note(s)

1. This query can be omitted if don’t want to look at all fire incidents.
2. This query can be omitted if using the pivot table with Q150 to check on dwelling fires.




3.7 Special Services

Stage 3 — Review team load and run text queries and save exports

The following queries should be run to evaluate how special services, including
incidents have been set up. This section can be omitted if the F&RS has not
completed the special services module.

Feature

Criteria Name

Layout Name

Save as file name

Incident Q200 Incidents — Special L150 Incidents - With IPCL | TQ200_IncidentsSS.txt
Services Reason

Incident Q202 Incidents — Special 150 Incidents — With IPCL | TQ202_IncidentsSS_LR.txt
Services Life Risk Reason

Incident Q206 Incidents — Special L150 Incidents — With IPCL | TQ206_IncidentsSS_CAS.txt
Service Casualties Reason

Output Area Q203 OAs without Special | Output Areas TQ203_OAsWithoutSSRA.txt
Services Risk Area

Special Services | Q205 SS Risk Area notin | L1283 Special Services Risk | TQ205_SSRAMissingSSRG.txt

Risk Area SS Risk Group Areas
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3.8 Other Buildings

The following queries should be run to evaluate how other buildings (including
assessments and incidents) have been set up. This section can be
omitted if the F&RS has not completed the other buildings module.

locations, site

Feature

Other Building
Site Assessment

Criteria Name

None required

Layout Name

L255 OB Site Assessment
People

Save as file name

TQ255_0OBSAPeople.txt

Other Building
Site Assessment

Q250 OB Site
Assessments with no
Valuation Reference

250 OB Site Asst
Valuation Check

TQ250_0OBSiteAssessment.txt

Other Building
Site Assessment

Q251 OB Without Footprint

250 OB Site Asst
Valuation Check

TQ251_OBWithoutFootprint.txt

Other Building
Site Assessment

Q252 OB Site Assessment
Moved

L252 OBSite Ass Location

TQ252_ObsMoved.txt

Other Building
Site Assessment

Q254 OB Sites Not
Changed

L254 OB Site Defaults
Changed

TQ254_0OBDefaultsNotChanged.txt

Other Building
Site Assessment

Q256 OBSite Visits

L.256 OBSites Visit Dates

TQ256_0OBSiteVisits.txt

Other Building
Site Assessment

Q257 — OB Less than 20
People at all times

255 OB Site Assessment
People

TQ257_OBSALess20.txt

Other Building
Site Assessment

Q258 OB More than 20
People between 08:00 and
20:00

255 OB Site Assessment
People

TQ258_0B>20

Other Building
Site Assessment

Q259 OB at least 20
people in one time

255 OB Site Assessment
People

TQ259_0B>200netimeperiod

Other Building
Site Assessment

Q275 OB 20 to 50 people
from 08:00 to 20:00

255 OB Site Assessment
People

TQ275_0B20to50

Other Building
Site Assessment

Q276 OB 50 to 100 people
from 08:00 to 20:00

255 OB Site Assessment
People

TQ276_0B50to100

Other Building
Site Assessment

Q277 OB 20 to 50 People
from 12:00 to 24:00

255 OB Site Assessment
People

TQ277_0B20to50_12t024

Other Building
Site Assessment

Q260 OA Missing OBRA

Output Areas

TQ260_OANOotinOBRA. txt

Qutput Area

Q263 TGOBRA Missing
H/VH Risk

L263 TGOBRA Missing
H/VH Risk

TQ263_TGOBRAMissingH_VHRisk.txt

Other Buildings
Risk Area

Q261 OB Risk Area not in
Risk Group

261 Other Building Risk
Area Details

TQ261_OBRANOotINOBRG. txt

Other Building
Site Assessment

Q273 HMO or Flats with
Wrong Storeys

273 OBSA Storeys

TQ273 HMO or Flats with Wrong
Storeys

Other Building
Site Assessment

Q274 Environment and
Heritage Risk

274 Environment and
Heritage Risk

TQ274 EnvironmentandHeritageRisk




Stage 3 — Review team load and run text queries and save exports

3.9 Major Incidents

The following queries should be run to evaluate how major incidents have been set
up. This section may be omitted if the F&RS has not completed the major incidents
module.

Feature Criteria Name Layout Name Save as file name

Incident Q300 Incidents — Major 150 Incidents - With IPCL | TQ300_IncidentsMI.txt
Incidents Reason

Output Area Q302 OAs with Major Output Areas TQB02_0OAsWithMIRA.txt
Incident Risk Area
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Stage 4 - Review team desk top interrogation of
FSEC text queries and exports

4.1 Introduction

Once the Stage 3 queries have been run, the review team should complete Stage 4, a
desk top review of the data they generated during Stage 3. The purpose here is both
to identify any apparent issues with the F&RSs FSEC configuration and also to make a
detailed plan of what should be explored during the site visit (Stage 5).

The review team should assess the data against criteria given in this section. This will
determine where there are possible errors and where the reasons for changes made
by the F&RS should be explored further during the site visit. Section 5 can be used to
plan the site visit and investigate apparent issues further using overlays and further
queries if necessary.

4.2 Checking Read Only Risk Assessment Definitions

4.2.1 Introduction

FSEC contains Risk Assessment Definitions (RADS). These can be split into ‘Read
Only’ RADS and those that can legitimately be revised by the users.

The ‘Read Only’ RADS should be checked to see if the read only protection has been
intentionally or unintentionally circumvented.

4.2.2 Macro for checking read only RADS

The aim here is to check whether the read only protection has been defeated for the
‘tixed defaults’, specifically the Risk Assessment Definitions (figures 5 to 10 in FSEC
Background User Guide), by checking the values used by the F&RS with the default
values.

The default Risk Assessment Definitions are checked using the following input files
and macro to pull the information into MS-Excel. For further details on how to run
these please refer to Appendix A.

Input File MS-Excel File Macro Save as Filename
RAD.IMP FSEC GetColumndata.xls | RetreiveColumnData | TQO3_RD.xIs
TQO03_ResourceDefinitions. TXT | Macros.xls ImportData TQOO03_RD.xls
RAD.xlIs

The macro highlights in red the values in column E that have been changed from the
defaults (values in column D). Column B shows the field descriptions, which are
highlighted in yellow if the value can be changed by the F&RS.



Stage 4 — Review team desk top interrogation of FSEC text queries and exports

The following Risk Assessment Definitions in FSEC should be compared with the ‘pre-
loaded’ values:

e Dwellings

e Special services

e Societal fire frequencies

e Property fire frequencies

e Societal MPL

e Other risk multipliers

These defaults should be unaltered, i.e. value in column E should not be highlighted
in red after running the RetreiveColumnData macro. Refer to FSEC Background User
Guide (Part 1 of the FSEC Manual) pages 5 to 9 for further details on the read only
values.

The remaining Risk Assessment Definitions are not fixed and may be altered by the
F&RS. It should be noted whether the F&RS has changed the vehicle speeds for

different times of day (rows 147 to 152) as this can be used to inform the Stage 5
discussions regarding vehicle speed calibration.

4.3 Checking the Road Network

4.3.1 Introduction

FSEC uses a road network comprising road junctions and road links. Road links are
designated by type (motorway, A road etc) and each type has a default road speed.
Every output area requires a road junction in order for an appliance to attend it. The
default road speeds may, or indeed, should be altered by use of local data. A number
of errors are possible:

e Output areas may not have a road junction, and hence can never be attended
e Road links may be lost, such as a gap in an A road, increasing the time taken to
reach an output area — as the vehicle would need to take an indirect route around

the missing road link

e The F&RS may have incorrectly changed the default road speeds, or failed to
modify the defaults to match local data

e Junctions and parts of road network can be lost if the road network has been re-

loaded and this would require manual correction which might have been over
looked

The text queries for checking the road network are summarised in Table 2.
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In the case of TQO11, TQ013, TQO12 and TQO017, there should be no records. If there
are any records, there is an error that needs to be corrected.

In the case of TQO018, TQO19, TQO20, TQ024, TQO025, Q026 and TQO027, it is necessary
to scrutinise the output as per the guidance laid out below.

In addition the reviewer should undertake spot checks on the road network including
the following checks (as outlined in Section 5.4.2):

e A check for spurious junctions (especially on motorways and dual carriageways,
particularly for flyovers)

e A check that one way streets have been appropriately defined
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Table 2: Summary guidance on road network text queries

File name

TQO11_MissingRoadInfo.txt

Purpose

This query checks whether there are
any roads that do not have a first
arrival time, and hence are not linked
to the road network.

Guidance

There should be no records reported.
Refer to Section 4.3.2

TQO13_MissingRoadLinkInfo.txt

This query identifies road links without
a road type (e.g. motorway, A Road
etc) identified.

There should be no records reported.
Refer to Section 4.3.2

TQO12_DeadEnds.txt

This query is only useful if the F&RS
has checked their dead ends or
followed earlier FSEC guidance and
added a loop back at dead ends. If
they have, this query checks whether
there are any remaining, false, dead
ends.

If dead ends have been identified or
loop backs added, there should be no
records. Refer to Section 4.3.2

TQO17_MissingOutputArealnfo.txt

This query checks whether there are
any output areas without a road
junction, which means it cannot be
attended by the FS

There should be no records reported.
Refer to Section 4.3.2

TQO18_FirstArrivalRJ120.txt

This is a ‘catch all’ test of the road
network that spots output areas which
have, for an unknown reason, an
extremely protracted response time of
>120 minutes

.In general there should be no records,
however it is possible, but very
unlikely, that there will be some. Refer
to Section 4.3.3

TQO19_FirstArrivalRJ60.txt

As above but looks for junctions
where the first arrival time is between
60 and 119 minutes.

It is possible but unlikely that there will
be some records. Refer to Section
4.3.3

TQO20_FirstArrivalRJ30.txt

As above but looks for junctions
where the first arrival time is between
30 and 59 minutes.

It is possible that there will be some
records. Refer to Section 4.3.3

TQO024_RoadSpeedDefaults.txt

The F&RS may legitimately change the
default road speeds. This query
checks if they have.

There will be no records if the defaults
have not been changed, and a single
record if the defaults have. Refer to
Section 4.3.4

TQO025_VehicleSpeeds.txt

The F&RS should change vehicle
speeds, especially for any that is not a
pump, from 100%. The file lists any
vehicles whose percentage speed has
been changed.

The file should contain records. Refer
to Section 4.3.5

TQ026_RoadSpeeds10.txt

The F&RS may legitimately change the
default road speeds for individual road
links. This query checks if they have
been changed by more than 10%.

The file reports the total number of
road links that have been changed. If
zero records then no road links
speeds have been changed by more
than 10%. Refer to Section 4.3.6

TQO027_RoadLinkSpeeds50.txt

The F&RS may legitimately change the
default road speeds for individual road
links. This query checks if they have
been changed by more than 50%.

If zero records then no road links
speeds have been changed by more
than 50%. If records are reported
these should be queried with the
F&RS in Stage 5. Refer to Section 4.3.
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4.3.2 TQO11, TQO13, TQO12 & TQO17 — road links and dead ends

In the case of TQO11, TQ013, TQO12 and TQO017, there should be no records. If there
are any records, there is an error that needs to be corrected.

Any errors can be explored at Stage 5 as follows:

e If records are reported in TQO11 these can be reviewed using the ‘Linked to
Network Check’ overlay

e If records are reported in TQO012 (and the F&RS has defined dead ends or used
loop backs) these can be reviewed using the ‘O012 Dead Ends’ overlay. If the
F&RS has not defined dead ends or loop backs then this report may contain a
large number of records

e If records are reported in TQO13 these can be reviewed in MS-Excel. The report
includes all road links that do not have a road type. The report can be examined in
MS-Excel (refer to Appendix B on opening a query file in excel) and the Road Type
column (Column 5(E)) examined. Any blank road types are errors that should be
corrected by the F&RS. Note that blank road types default to 30 mph in FSEC

e If records are reported in TQO017 these must be corrected by the F&RS for the
system to function properly. A vehicle will not be able to get into the output area
unless it has a junction on the road network

4.3.3 TQO18, TQO19 and TQO20 - General tests of arrival times

These three queries provide a ‘general’ test of the response times as follows:

e TQO018_.txtIndicates any junctions with a first arrival over 120 minutes

e TQO019_.txtIndicates any junctions with a first arrival between 60 and 120 minutes
e TQO020_.txtIndicates any junctions with a first arrival between 30 and 60 minutes.

It is expected that arrival times will be less than 60 minutes with the exception of
islands lacking fire stations, mountain ranges and moorland/ heathland/ forestry. Thus,
in the vast majority of F&RS, there should not be any records for TQ018 or TQO019.

Arrivals times in Cities, Towns and Villages that have fire stations are expected to be
less than 30 minutes, i.e. no output areas in Cities, Towns or Villages with a fire
station should be listed for TQO020 for Cities, Towns and Villages that have fire
stations. If they are, it is likely that there is an error in one of: the road network,
location of the fire station, omitted vehicles, no vehicle mobilisation times or failure to
connect the vehicle to the station.

It is possible, although still infrequent, for output areas outside of Cities, Towns or
Villages to take over 30 minutes to reach. These are exceptional. If TQ020 cites some
output areas, these should be noted and checked using an overlay at Stage 5, to
check the validity of their arrival time.

Any junctions reported should be reviewed and discussed in Stage 5.



Stage 4 — Review team desk top interrogation of FSEC text queries and exports

4.3.4 TQO24 - Risk Assessment Definitions; Road speeds

FSEC provides a set of ‘suggested’ default road speeds in the Risk Assessment
Definitions: Road Speeds. These may be altered by the F&RS. Indeed, if the F&RS has
not changed them this can be challenged on the basis that the default road speeds
may not be valid for that F&RS.

The settings used by the F&RS should be checked and compared with the default
settings to identify changes for further scrutiny. If the output from TQO024_.txt cites a

record the defaults have been changed.

The output file for TQ024 shows the speeds in the following order:

e Motorway column 16 (or P when imported into Excel)
e B Roads column 18 (s)
e C Roads column 19 (T)

e Unclassified column 20 (U)
The following should be explored, and any issues raised in Stage 5:

e Are the RADS: road speeds significantly different from the defaults shown in
Table 3

e Are the F&RS specific changes (1) intentional and (2) based on F&RS specific
evidence/calibrated?

e If the defaults have not been changed, why not?

Table 3: Defaults provided in Risk Assessment definitions

Road Type Default speeds (mph)

Motorway 60
A roads 40
B roads 30
C roads 25
Unclassified 20
All vehicle speeds are set at 100% for each time period

It is also possible to check the defaults using the Risk Assessment Definition Data
returned previously by the F&RS. Either by viewing the RAD.xls file created in Stage 2
or re-running the macro using the RAD.imp file from Stage 1.

Input File MS-Excel File Y E=Te o) Save as Filename

RAD.IMP FSEC GetColumndata.xls | RetreiveColumnData | RAD.xIs
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The spreadsheet includes the default road speeds in rows 90 to 97. The values in
column D will be highlighted in Red if the default values have been changed.

The values can be checked using the FSEC Overlay for Risk Assessment Definitions.

4.3.5 TQO25 - Vehicle speeds

Vehicle speeds are expressed (as a %) relative to the speed of a standard (old)
pumping appliance. It is expected that speeds for other types of appliance will be
different. TQ025_.txt shows vehicles where the speed has been changed from 100%.
The vehicle speed is shown in the PSP column (D) and is specified as a percentage
of the pump speed. It is expected that the following types of vehicles will have
speeds less than 100%:

e Command units

e [HHeavy rescue units

e Acrials and other height appliances

e Foam tankers

It is possible that an F&RS will have both old standard and new types of pumps. The
newer pump may be faster than the older pump with which the appliance speed is
compared (therefore the speed may be over 100%).

If the query cites all vehicles as 100% this should be queried, as it may mean that
speeds for some types of vehicles are unaltered and hence could be too fast. Where

vehicle speeds are changed from 100%, the logic for this should also be checked at
Stage 5.

It is also possible to check this using the macro, as below, to process the PS
Resources.

Input File MS-Excel File Macro Save Output
BROSD.TXT MS-Excel File Macro.xls PSResources.xls
UpdateTableComparisons

The PSPEED sheet shows the percentage speed for each vehicle type.
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4.3.6 TQ026 & TQO027 — Road link specific road speeds

F&RS may legitimately alter road speeds on specific road links through use of local
data such as timed runs and response time data drawn from command and control
records. The road link has a road type associated with it. Therefore, it is possible to
check if the road speed used is reasonable for the road type, such as by comparison
with Table 4.

Table 4: Road speeds given in Appendix A of FSEC manual

Road Type Default speeds (mph)

Cities
A roads 27
B roads 23
C roads 20
Unclassified 20
Towns and villages — all road classifications 20
Dual carriage ways:
Carriageways 55
Slip roads on/off 40
Roundabouts 25

The check is run in two steps:

e TQO026.txt file reports the total number of road links where the road speed has
been changed by more than 10%. It is expected that a significant number of road
link speeds will have been changed by more than 10%, especially if TCheck has
been used. Indeed, the F&RS should be challenged if they have not calibrated
their specific road link speeds

e The output file TQO27_.txt reports the number of road links with the speed
changed by more than 50%. It is possible that road speeds have legitimately been
changed by more than 50%. However, this is a significant change that should be
noted for scrutiny at Stage 5

In all cases, it is necessary to note the result and explore the process of calibration
applied by the F&RS or its justification for not calibrating road link speeds.
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4.4 Creating Stations, Crews, Vehicles and Planning Scenarios

4.4.1 Introduction

The F&RS needs a complete and accurate set of entries for their stations, vehicles,
crews, costs and planning scenarios. This includes:

e Locating each station and noting its cost
e The type of each vehicle is defined and its cost is entered

e The crewing system (e.g. whole time, retained or day/night crewed) is defined
along with the crew cost — made up of the cost of each crewmember

As part of this it is necessary for F&RSs to include those stations and vehicles in
neighbouring F&RSs, which attend incidents within the F&RS area.

Each risk area requires a planning scenario, where the planning scenario entails
specifying the type and number of vehicles required for incidents in that area. This
planning scenario is then applied to all output areas within that risk area.

The types of errors that can occur include:

e Omitting stations and vehicles, especially stations and vehicles in neighbouring
F&RSs

e Entering the wrong costs, either due to data entry errors such as entering 22
instead of 22000, or due to an invalid process being used for estimating costs

e Assigning wrong costs to vehicles or crews, such as costing a whole time crew as
if it were a retained crew

e Specifying vehicles within planning scenarios that do not exist —which means the
planning scenario cannot be satisfied

e Using different terms to define vehicles than the terms within planning scenarios —
which means the vehicles are not used

e Vehicles or crews are added that do not exist, such as by mixing up datasets.

e The wrong turn out time is assigned to a vehicle, such as treating a whole time
appliance as if it were a retained appliance

e Fail to specify a planning scenario for a risk area, which means it will never be
attended

The pertinent text queries are summarised in Table 5.
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Table 5: Summary guidance on station/vehicle text queries

File Name
TQ100_FireStationCosts.txt

Purpose

It is necessary to check that all
stations, vehicles and crews have a
cost and that these costs are
reasonable by comparison with
‘guideline’ costs.

Guidance

All stations, vehicles and crews
should have a cost. The costs
should be compared with guidelines
to ensure (1) no data entry errors,
such as entered 22 instead of
22000, and (2) costs are credible
when compared with guidelines.
Refer to Section 4.4.3

This query also identifies stations
where there is no junction within
50m, or where the junction is not the
nearest one.

TQ101_FireStationDetails

Used to list all fire stations which are
missing station cost information

All stations within the F&RS area
require a cost to be entered.
Stations outside of the F&RS area
do not require a cost.

TQ103_Vehicle NotInPS

Used to list all vehicles that are not
used in any of the planning
scenarios

The vehicles listed are not used by
any of the planning scenarios, this
may be because the vehicle details
are incomplete, or because the
vehicle type has not been specified
as part of a planning scenario. This
list should contain very few if not
zero records.

TQ104_VehicleDetails.txt

It is necessary to check that each
crew and vehicle has the correct
cost and that these costs are
reasonable by comparison with
‘guideline’ costs.

Does each vehicle have a cost?

Has the correct cost for the type of
vehicle / crew been applied? Refer
to Section 4.4.4.

TQ105_VehicleTT.txt

All vehicles and crews require a
turnout time, otherwise it cannot be
mobilised. Also the turnout time
should be valid.

The file lists any vehicles that don’t
have a turnout time. There should be
no records in the file. Refer to
Section 4.4.5

TQ106_VehicleTTReasonable.txt

All vehicles and crews require a
turnout time, otherwise it cannot be
mobilised. Also the turnout time
should be valid.

The file lists all vehicles where the
turnout time for the crew is outside
the guidelines in Table 7.Refer to
Section 4.4.6

StationJunction.txt

Lists stations where the nearest road
junction is more than 50m from the
station. This means that the station
is not connected properly to the
road network, and will not be able to
turn out.

There should be zero records. Refer
to Section 4.4.7

TQ107_FireStationWithoutVehicles.txt

This query identifies fire stations
which do not have any vehicles
attached to them.

There should be zero records. Refer
to Section 4.4.8

TQ108_VehiclesNotInStations.txt

This query identifies vehicles not
attached to a fire station.

There should be zero records. Refer
to Section 4.4.8

TQ109_VehiclesNotMatched.txt

This query identifies vehicles whose
co-ordinates do not match those of
the fire station.

There should be zero records. Refer
to Section 4.4.8
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Table 5: Summary guidance on station/vehicle text queries (continued)

File Name

TQ115_OAVehiclesDwellings.txt

Purpose

This checks if the vehicles defined in
dwelling planning scenarios match
those that exist.

Check looks at only those output
areas which are part of a dwelling
risk area

Guiance

There should be zero records. Refer
to Section 4.4.9

TQ116_OAVehiclesMI.txt

This checks if the vehicles defined in
major incident planning scenarios
match those that exist.

Check looks at only those output
areas which are part of a major
incident risk area

There should be zero records. Refer
to Section 4.4.9

TQ117_OAVehiclesOB.txt

This checks if the vehicles defined in
other building planning scenarios
match those that exist.

Check looks at only those output
areas which are part of an other
buildings risk area

There should be zero records. Refer
to Section 4.4.9

TQ118_0OAVehiclesSS.txt

This checks if the vehicles defined in
special service planning scenarios
match those that exist.

Check looks at only those output
areas which are part of a special
services risk area

There should be zero records. Refer
to Section 4.4.9

TQ120_DRA_PS.txt

All risk areas require a planning
scenario in order for a response to
be made.

There should be zero records. Refer
to Section 4.4.10

TQ121_MIRA_PS.txt

All risk areas require a planning
scenario in order for a response to
be made.

There should be zero records. Refer
to Section 4.4.10

TQ122_OBRA_PS.txt

All risk areas require a planning
scenario in order for a response to
be made.

There should be zero records. Refer
to Section 4.4.10

TQ123_SSRAPIlanning.txt

All risk areas require a planning
scenario in order for a response to
be made.

There should be zero records. Refer
to Section 4.4.10

TQ127_AlIOAPSNotBuilding

Used to list ALL planning scenarios,
excluding other buildings, for use
with the pivot tables to show how
the different scenarios are used in
the different areas.

Used to see how many times
scenarios are used and whether the
same scenarios are used across
different modules. It would be
expected to see some scenarios
listed under the major incident and
special services modules that are
not part of the dwellings module.

TQ130_AlIOAPSBuilding

Used to list ALL planning scenarios
used within other buildings for use
with the pivot tables to show how
the different scenarios are used
across the different types of other
buildings

Used to see how many times
scenarios are used and whether the
same scenarios are used across
different modules. Would expect to
see different scenarios listed for
particular other building types e.g.
hospitals or high occupancy
buildings than those used for
factories, or different scenarios for
different time periods.
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4.4.2 Resource definitions

The Resource Definition includes the F&RS entries on pay costs and overall F&RS
costs. These need to be checked in the following terms:

e The Pay Cost per Year can be (1) compared with ‘typical’ values applied
elsewhere (as per Table 6) and (2) the approach taken to derive these costs can
be discussed at Stage 5

e All fields in the ‘Brigade Costs’ of the ‘Resource Definition” should be populated
and the approach taken to derive these costs discussed in Stage 5

The defaults can be checked using the ResourceDefinitions.xls macro or review the
saved file.

Input File MS-Excel File Macro Save as Filename

TQO03_ResourceDefinitions. TXT | Macros.xls ImportData TQO3_RD.xls

TQO003_RD.xls

This query presents the default values for fire-fighter costs used in the FSEC model by
the F&RS. This macro highlights in red any values in row 5 that have been changed
from the defaults. Row 3 also shows the percentage difference between the defaults
and those in the F&RS.

It should be noted, however, that blanks and/or changes in this data may not be
significant because the F&RS may not have used these fire fighter individual costs to
calculate their crew costs. The approach the F&RS has taken to the calculation of their

crew costs should be queried at Stage 5.

It should be remembered that the important value is the ‘Crewing Cost & per year’
value which may be derived using:

e the individual fire-fighter costs presented on TQO03_RD.xls or
e costs entered on an individual basis or

e an overall cost entered in the ‘crewing costs & per year’ (which over-rides any
calculation in the costs spreadsheet

The results of this query should therefore be borne in mind when checking the crew
costs for their ‘reasonableness’ in Section 4.4.3 below.
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4.4.3 TQ100: Fire station, vehicles, crews and costs

The output file TQ100_.txt reports the cost of stations, vehicles and crews. The text
query provides:

e List of stations along with their vehicle types, crew types and stated cost
e Whether the station is within (P) or outside the F&RS (O)

It is important to note that:

e The file contains stations that are inside and outside of the F&RS

e The file only contains those vehicles that are assigned to a station. If the vehicle
numbers don’t match up it may be because the vehicles are not attached to a
station, or because they have not been entered

Before examining the output, a list of stations, vehicles and crew type (wholetime,
retained, day crewed, variable) and crew composition and their costs should ideally
be obtained to compare with data in FSEC. This should be requested at the time of
the decision to proceed with the full review. If these are not available, comparison
can be made with expected costs as discussed below.

It should be noted that there are no firm rules about which stations outside of the
F&RS area should be included. However, as a guide the F&RS should include the first
nearest station at each point around the F&RS area.
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Then the following questions should be addressed. Reference can be made to the
‘typical’ costs in Table 6.

Reviewer observations Reviewer comments

Are all in F&RS and neighbouring F&RS Yes No Uncertainty
stations present? M’

Is the Location status shown in column Yes No Uncertainty
W of the station (inside P or outside O
the F&RS) correct?

Are the stations costs values in column G | Yes No Uncertainty
(Stn Cost) present and reasonable? M2

Do the stations still have the correct Yes No Uncertainty
vehicles attached to them?

Do all stations have at least one vehicle Yes No Uncertainty
(vehicle number is in column H (V_VNO)?

Do all stations have an Easting in column | Yes No Uncertainty
D (EAST) and a Northing in column E?

Do all stations have at least one crew? Yes No Uncertainty
Do the stations have the correct crew Yes No Uncertainty
types? Note 3

Do all stations have a nearest junction Yes No Uncertainty
shown by a value in column F

(NEARJINCT)?

Are the vehicle costs values in column K Yes No Uncertainty

(Veh cost) present and reasonable?

Is the vehicle type in column | (Vehicle Yes No Uncertainty
Type) correct?

How do the crew costs cost value in Yes No Uncertainty
column L (Crew cost) compare against
typical values? Noe*

Are the crewing types in column J Yes No Uncertainty
(Crewing) correct?

Does the nearest junction to each station | Yes No Uncertainty
match that defined by FSEC (columns
headed NEARJNCT and Nearest Jn)?

Note(s)

1. Data for stations within the F&RS area may need to be requested from ODPM. However, Table 19 in Appendix E presents the
number of stations for the F&RS and can be used as a quick comparison to ensure that the total number of stations appears
accurate

2. Stations, crews and vehicles in neighbouring F&RS have a zero cost.

3. If a crew is shared between stations this is achieved by having the same crew entered into two stations, but the mobilisation
times is ‘None’ for those periods when the crew is not present.

4. Crews with zero costs for vehicles within the F&RS area should be reviewed to see if they are ‘alternate crewed’. TQ100
identifies whether a vehicle is alternate crewed (a Y’ in column N (Alt Crew)). If a vehicle is marked as alternate crewed then
there should be no crew cost (or crew) assigned (as this has been taken account of elsewhere in FSEC). Conversely, a vehicle
with a crew and crew cost entered should not be marked as alternate crewed and such results should also be queried in
Stage 5.
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4.4.4 TQ104 - Vehicle and crewing cost

Output file TQ104_.txt reports the cost of vehicles and crews. It is possible to check
the following points:

Issue Reviewer observations Reviewer comments
Do all vehicles have an annual Vehicle Yes No

Cost?

Are the vehicle costs reasonable? Yes No Uncertainty

How do the crew costs compare against Yes No Uncertainty

typical values?

When reviewing this output, an entry in the spreadsheet of <???> may suggest that a
vehicle has not had a ‘type’ associated with it (this may be an issue where
neighbouring F&RS vehicle types do not closely match those defined for the F&RS
under consideration. This should be noted and raised at Stage 5 if present as these
vehicles will not be used by FSEC unless they have a ‘type’ allocated.

It should be noted that:

e Stations, crews and vehicles in neighbouring F&RS areas do not require a
cost and so could have a zero for this value

e All stations, crews and vehicles within the F&RS area should have a cost

e Alternate crewed vehicles should not have a crewing cost as this cost is
already accounted for elsewhere in the FSEC model

The F&RS’s approach to identifying those stations in neighbouring areas which should
be included in their model, and the approach taken to determine the type and
number of appliances available should be investigated in Stage 5.

Some typical station, vehicle and crew costs are summarised in Table 6 below. Note
that these values have been obtained from FSEC data entered by F&RS’s in their
models and should be used only as guidance of the range of values which may be
expected, and their relative values. In all cases, the Stage 5 of the review process
should explore how the F&RS derived their costs. Note that the output of TQ104
should present cost data in full (i.e. 22000’ and not 22°).
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Table 6: ‘“Typical’ costs

Typical costs

Item (£ thousands) (£ thousands)
Station
Whole time 65 - 150 Maximum and minimum data from Lothian
and Cambridgeshire datasets
Day crewed 25-73 Maximum and minimum data from Lothian
and Cambridgeshire datasets
Retained 5-35 Maximum and minimum data from Lothian
and Cambridgeshire datasetsVehicle
Vehicle
Pump 18 - 22 Maximum and minimum data from Lothian
and Cambridgeshire datasets
Aerial 21 -38 Maximum and minimum data from Lothian
and Cambridgeshire datasets
Command unit 14 -19 Maximum and minimum data from Lothian
and Cambridgeshire datasets
Chemical Incident 22 Cambridgeshire data
Emergency Tender 22 Cambridgeshire data
Incident Support 18 - 25 Maximum and minimum data from Lothian
Unit and Cambridgeshire datasets
Water Ladder 18 - 22 Maximum and minimum data from Lothian
Rescue and Cambridgeshire datasets
Water Carrier 10 Cambridgeshire data
Major Incident 16 Lothian data
Support Unit
Boat - No guidance at present
Ambulance - No guidance at present
Whole time crew
Sub officer 30 Lothian data
LFF 29 Lothian data
FF 25 Lothian data
Day crewed
Sub officer 37 Lothian data
LFF 36 Lothian data
FF 31 Lothian data
Retained crew
Sub officer 7 Lothian data
LFF 6.7 Lothian data
FF 5.7 Lothian data
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4.4.5. TQ105: Vehicles without crews

Check the output file TQ105_.txt this reports any vehicles that do not have a crew.
There should not be any records in this file. If there are records returned by this
query then these vehicles will not be used within the system.

4.4.6. TQ106: Turn out times

The output file TQ106_.txt reports the turnout times where the times are outside the
typical times shown in Table 7 expected for the specified crewing level. The vehicles
reported here should be reviewed with the F&RS. There are at least two aspects to
consider:

e Do all vehicles have a turn out time? If it is ‘none’ the vehicle will not be used
by FSEC

e Are the turn out times reasonable? Whilst they are F&RS specific they can be
compared with the following generic ‘typical’ values in Table 7. Any variations
from the ‘typical’ values should be checked against the F&RS evidence base

Note that it is common for day crewed appliances to have retained crews at night. In
this case, the TOT will be approx 1-2 mins during the day and approx 5 mins at
night. TQ106 will identify records of this type as it expects a zero mobilisation time at
night for day crewed appliances. Any records of this type should be confirmed as
appropriate with the F&RS in Stage 5.

Table 7: Typical turn out times

Crew Type Typical mobilisation times

Whole Time 1 1o 2 minutes

1 to 2 minutes when present.

Day or night crewed None at other times.

Variable crewing 1 to 2 minutes

Retained 5 to 6 minutes

4.4.7 Stationdunction.txt: Station not connected to road network

The StationJunction.txt cites any station that is not connected to a junction. No
stations should be reported by this query; any that are is an error which should be
investigated at Stage 5.

4.4.8 TQ107 to TQ109: Stations connected to vehicles

A vehicle must be attached to a station to be mobilised and costed. This is checked in
three different ways as follows:

e TQI107_.txt which identifies stations without any vehicles
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e TQ108_.txt which identifies vehicles away from stations
e TQ109_.txt which identifies vehicles and stations without matching co ordinates.

The output of all three should be zero records; any records returned should be
investigated at Stage 5.

4.4.9 TQ115 to TQ118: Alignment of planning scenarios and
vehicle types

A planning scenario must be defined for each risk area, citing the number and type of
vehicles needed for that risk area. This is done for each type of risk, as follows:

e TQI15 Dwellings

e TQ116  Major incidents
o TQ117 Other Buildings
e TQI18 Special services

The text queries TQ115 to TQ118 ask “Are there any output areas where the ‘OA
Vehicle PS Requirements’ in the output area results dialogue boxes are not satisfied?”

Any such records (provided the module has been completed) are an error that
requires correction by either correcting the vehicles defined in the planning scenario

or adding the vehicle type to the resources.

Further guidance on this is presented in Section 5.6.2.

It would also be possible to review the output from the UpdateScenarios macro in
PSResources.xls or re-run the macro.

Input File MS-Excel File Macro Save Output
BROSD.TXT Table_Comparison.xls | Macros.xls PSResources.xls
UpdateTableComparisons

Sheet BPS lists all of the defined planning scenarios.

e Column ‘C’ shows the name of the planning scenario used in the scenario/vehicle
list (Sheet brosdb)

e If the name is ‘#N/A’ then a vehicle combination has not been defined for the
plan

e Names highlighted in Red are duplicated in the system. This will cause problems
as only the one scenario can be changed. Duplicate scenario names will need to

be rectified for the F&RS by FSEC

Sheet brosdb lists the vehicle type combinations for each planning scenario.
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e Column I (Scenario Defined) shows the scenario name cross referenced against
the scenario list (sheet BPS)

e If the name is ‘#N/A’ then the scenario is not in the list

e Column J (Vehicle Defined) shows the vehicle type cross referenced against the
vehicles list (sheet VIYPE)

e If the name is ‘#N/A’ then the scenario is not in the list

e The last section on the sheet lists the vehicle types and their associated costs. This
list is cross referenced against the appropriate sheets

e Column J shows the vehicle type (sheet VIYPE) this should not be blank
or ‘#N/A’

e Column K shows the vehicle percentage speed (sheet PSPEED) this should not be
blank or ‘#N/A’

e Column L shows the vehicle cost (sheet VCOST) this should not be blank
or ‘#N/A’

In addition the UpdateBuildingScenarios macro using the following files:

Input File MS-Excel File Macro Save Output

TQ127_AIIOAPSNotBuilding.txt | Risk Area Planning Macros.xls TQ127_AIIOAPSNotBuilding x|
Scenarios Not OB.xIs | UpdateBuildingScenarios | s

TQ130_AIIOAPSBuUIilding.txt Risk Area Planning Macros.xls TQ130_AIIOAPSBuUIlding.xIs
Scenarios OB.xls UpdateBuildingScenarios

These two files allow the split of planning scenarios to be looked at across the
modules, i.e. how many times is a 2 pump’ planning scenario used in other buildings
or special services etc. Is it the only scenario used in other buildings?

These files can be referenced to see how many of the output areas have no planning
scenario defined in each of the modules. If the pivot table for major incidents shows a
single count of ‘blank’ scenarios in an incident type, then this incident type does not
have any risk areas. Similarly if with the other buildings if there is a single count of
‘Blank’ scenarios against hospitals then there is not a planning scenario defined for
hospitals.

4.4.10 TQ120 to TQ123: Are planning scenarios selected for each
risk area?

In order for a response to be made to an output area, a planning scenario must be
specified for every risk area. TQ120 to TQ123 identifies any risk areas, taking each
FSEC module in turn, where this is not the case. Any such records are an error that
requires correction by specification of a planning scenario.

There should be no records in any of the above files (i.e. TQ120 to TQ123).
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4.5 Processing Dwellings

4.5.1 Introduction

FSEC comes loaded with census data for each output area and dwelling fire incident
data. It is possible for F&RSs to load more population data onto FSEC, or accidentally
delete data.

Due to the small size of output areas, adjacent output areas with a similar socio-
demographic profile (as indicated by four socio-demographic factors) are merged into
larger ‘risk areas’. These risk areas are then merged into groups, termed ‘risk groups’.
The robustness of these groups is tested and, if need be, they are merged into larger
or different risk groups until they are “Robust”.

The calculated casualty rate is used in robust risk groups for the prediction of
fatalities. If robustness cannot be achieved, it is possible to apply an assigned risk
category that applies an assumed casualty rate.

However, as the incident data may not be properly geo-coded, there is a process of
checking the location of incidents. Also the data may have been of poor quality, such
as lacking details on whether there were casualties. This may also require manual
checking.

The errors that can occur include:

e Losing census or incident data or deleting output areas

e Using the wrong dataset

e Entering the wrong number of years, which would divide the incidents by the
wrong period to get an incorrect casualty rate per year

e Miss out dwelling incidents coded under other building categories, especially
dwelling incidents in HMOs and purpose built flats

e Coding other building incidents as dwellings

e Failing to correct data supplied to F&RS which does not include information on
fatalities, casualties and rescues

e F&RS reporting practices differ from standard practice leading to skewed ratio of
fires, deaths, casualties and rescues

e Overlooking ‘dumps’ of incidents that need to be manually re-located

e Failing to include all output areas in dwelling risk areas, or missing some risk
areas out of dwelling risk groups

e Creating risk areas or risk groups according to inappropriate criteria

e Failing to re-link dwelling risk areas after edits or failing to run ‘Update areas
and groups’
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e Dwelling risk groups too small and not robust

e Wrongly over-riding the actual casualty rate where data is robust

It is also necessary to assign a planning scenario to each risk area. The text queries
TQ120 to TQ124 will have checked if a planning scenario has been assigned. It is
also necessary to check if the intended, and reasonable, planning scenario has been

assigned in Stage 5.

The dwelling text queries are summarised in Table 8.

Table 8: Summary of dwelling text queries

File Name

TQ150_IncidentsDwellings. txt

Purpose

The location of dwelling casualty
incidents needs to be checked. This
query extracts all dwelling fires
incidents.

Guiance

The file should contain records. It is
used with the incidents pivot table.
Refer to Section 4.5.2

TQ152_IncidentsFires.txt

Extracts all Fire incidents (ROITYPE
1 to 5), so that they can be
examined using the macros.

Refer to Section 4.5.2

TQ153_RADOther.txt

This checks if the population level
multiplier given by the census data
has been modified.

Any change from 1 needs
justification. Refer to Section 4.5.3.

TQ160_AllincidentsNotChecked.txt

The location of incidents can be
checked. This query identifies any
type of incident that should have
been checked but has not.

The output should be zero if all
modules have been completed.
Refer to Section 4.5.2

TQ162_DwellingFiresCasualties.txt

The location of dwelling fire incidents
with casualties must be checked.
This query lists all dwelling fire
incidents with casualties. It | used
with the pivot tables to give a
comparison of the number checked
against those not checked etc.

Refer to Section 4.5.2

TQ163_DwellingFiresNotChecked.txt

As above but only includes those
incidents that have not been
checked.

Should be zero, refer to Section
4.5.2.

TQ164_CensusData.txt

This reports the total population and
number of output areas in the F&RS
area.

This should match the information
from FSEC. Refer to Section 4.5.4

TQ165_OAMissingDRA.txt

This checks for Output areas that
have not been assigned to a risk
area.

Should be zero Refer to Section
455

TQ166_DRAMissingDRG.txt

This checks for risk areas that have
not been assigned to a risk a group.

Should be zero. Refer to Section
45,6

TQ167_DRG.txt

This provides information for
checking robustness of risk groups.

This provides a set of information to
be scrutinised. Refer to Section
4.5.7

TQ170 DRAFireSafety

This query checks to see if the
community fire safety field has been
completed for dwelling risk areas by
the F&RS

This field is present for information
only, records will be returned where
they have been completed.
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4.5.2 TQ150, TQ152, TQ160, TQ162, TQ163: Dwelling incidents

The following output files can be used with the MS-Excel macros to generate pivot
tables to view the incident data.

Save as MS-Excel File Macro Save Output

TQ150_IncidentsDwellings.txt Incidents.xls Macros.xls TQ150IncidentsD.xls
Updatelncidents

TQ152_IncidentsFires.txt Incidents.xls Macros.xls TQ152IncidentsFires.xls
Updatelncidents

TQ160_AllincidentsNotChecked.txt Incidents.xls Macros.xls TQ160AllincidentsNotChecked.xls
Updatelncidents

TQ162_DwellingFiresCasualties.txt Incidents.xls Macros.xls TQ162IncidentsDFires.xls
Updatelncidents

TQ163_DwellingFiresNotChecked. txt Incidents.xls Macros.xls TQ168IncidentsDFiresNotChecked.xls
Updatelncidents

All of the above input files can be processed with the Updatelncidents macro to show
a number of pivot tables based on the selected incident data. The type of information
shown in the tables is common to all input files. The changing factor is the amount of
incidents that are reviewed. In summary:

e TQ150 includes all incidents related to dwelling fires

e TQI152 includes all incidents related to fires, this includes dwellings, other
buildings, chimneys etc

e TQ160 includes all incidents (fires, special services and major incidents) that have
not been checked

e TQI162 includes all dwelling fires incidents that have a recorded casualty, rescue
or fatality

e TQI163 includes only those dwelling fire incidents that should have been checked
and have not

To examine details of all fire incidents review the output of TQ152. To just look at
dwelling fires review the output from TQ150.

Location check

The Check Flag sheet shows a pivot table detailing the incident type (ROITYPE) and
the location status (ipcl value) against the check flag. Incidents with a location status
above 250, should always be checked if they involve casualties.

Number of years data

The number of years covered by the data should be defined in the ‘Risk Assessment
Definitions; Background dataset’. Commonly F&RSs use three whole years of data
(1/10/99 to 30/9/02) that can be checked by examining the ‘Incident Data’ entries and
comparing it with the declared period of data used.

51



FSEC Toolkit Review Manual

If the F&RS has added extra years, it is necessary to check:
e Have they entered whole years of data?
e Have they updated the ‘No of years of incident data’ entry?

The ‘Month and Year Chart’ sheet shows the spread of incidents over the years. This
sheet can be used to check for gaps in the data and also the start and end of the
data. There should be whole years of data. The dates should match those reported in
the risk assessment definitions. The output file, RAD.xls (created previously), can be
reviewed to check. Row 11 shows the start year for incident data and row 15
identifies the number of years of data.

Care should be taken when looking at the ‘Month and Year chart’ as gaps may be
present when looking at a subset of the incidents e.g. TQ160 or TQ163.

TQ150: Comparison of incident data

The output file TQ150_IncidentDwellings has a dwellings summary sheet which
shows a comparison table with the FSEC values against the F&RS values.

As part of this it is necessary to check:

e Have fatalities, casualties and rescues been added (where absent from pre-loaded
data)?

e Is the ratio of incidents to ROF/ROC/ROR reasonable?

e Is the ratio of ROF/ROC/ROR reasonable, when compared with the values in
Table 9?

TQ152 provides a series of pivot tables. These are checked by comparison with the
values in Table 9.
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Table 9: Summary of dwelling fire data used in FSEC

Data used for FSEC

Incident type 1 without ROF/ ROC/ ROF 196,308
Incident type 1 with 1+ ROF/ ROC/ ROF 36,624
Incident type 1 232,932
ROF 1,600
ROC 48,636
ROR 6,258
Total ROF/ROC/ROR 54,494
Ratio of ROC/ ROR/ ROF to ROF 35.31
Ratio of total ROF/ ROC/ ROR to ROC 1.16
Incident Type 2 11,111
Ratio of all Incident type 2 to total ROF/ ROC/ ROR 20.96

4.5.3 TQ153: population multipliers

TQ153_.txt which shows the multiplier values for population counts, which are
normally left at 1. The default dwelling multiplier is shown in the last but one column
followed by the default residential multiplier. These values can also be checked in the
RAD xls output file rows 11 and 12.

4.5.4 TQ164: Population count

The F&RS should contain the same census data as supplied with the original system.
The output file TQ164_.txt details the number of output areas, and total population
for the F&RS. These figures can be checked with paper records of population level.
Table 20 in Appendix E presents census data from population levels for English F&RS
areas. It should be noted that the comparison should be for guidance purposes only
as this data is from a different source than the FSEC data.

4.5.5 TQ165: Missing output areas

All output areas must belong to a dwelling risk area. The output file TQ165_.txt
shows any output areas that does not belong to a dwelling risk area. Any such
records are an error.

If all output areas have been allocated to a dwelling risk area this file should not
contain any records. If the file contains records, these should be noted for follow up
in Stage 5, and can be checked using the review overlay O165_DPS_OA to identify
the appropriate output areas.
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4.5.6 TQ166: Dwelling risk areas missing from a dwelling risk group

The output file TQ166_.txt shows any dwelling risk area that does not belong to a
dwelling risk group. There should be no records. Any records are an error. If the file
contains records then the review overlay O166_DRG_DRA can be used to identify
which dwelling risk areas have not been assigned to a group. These should be noted
for follow up in Stage 5.

4.5.7 TQ167: Dwelling risk group robustness
TQ167 lists:

e Robustness
e Actual & predicted casualty rate
e Total number of dwelling residencies, fires & casualties

e comments

TQ167 lists all dwelling risk groups and can be used to check:
e Are the dwelling risk groups ‘robust™

e What casualty rate is being used?

e What is the calculated casualty rate level?

e Entry of comments where calculated casualty rate is not used

The text query should used to spot where calculated/assigned casualty rate is not
used (due to use of override), with comments reported.

The following guidance is given:

e Where the casualty rate is ‘robust’, this should normally be used. If it is the query
can be closed

e If the casualty rate is ‘robust’ but a different casualty rate has been assigned
manually, the logic for this must be stated

e If the casualty rate is not robust then:

— The F&RS should be asked whether they have attempted to re-group risk areas
to form robust groups

— The F&RS may use an assigned (self-selected casualty rate category). If so the
logic for the selection should be stated in comments

If the dwelling risk group is not robust or is robust but has been over-ridden, this
should be noted for follow up in Stage 5. However, it should be noted that one or
two groups being ‘not robust’ is not an unexpected result given the amount of data
within the model. Where a very high risk group is not robust it should be noted that
this can cause the predicted fatalities to be higher than expected.
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4.6 Processing Special Services

4.6.1 Introduction

The special services FSEC module uses F&RS incident data that must first be geo
coded by the F&RS. Then the output areas are grouped into risk areas and then risk
groups, as per dwelling risks, with areas and groups displaying similar rates of
incidents.

It is more common than with dwellings that the data supplied by F&RS is of a poor
quality for special services, (aside from geocoding and risk grouping errors).

Also in the case of special service incidents, in some cases the incidents follow a
linear feature such as an A road in a rural area rather than being dispersed across an
area such as a town. In the former case a special ‘linear feature’ within FSEC must
be used.

Errors can include:

e F&RS incident data lacks data on deaths, casualties or rescues, requiring manual
entry of data and the risk of omission of data

e F&RS reporting practice is skewed leading to inappropriate ratio of incidents,
deaths, casualties or rescues

e F&RS fail to distinguish between categories of special services and so incidents are
recorded under wrong categories

e Incident location not checked/ corrected

e Creation of risk areas and risk groups is achieved using inappropriate criteria

e Failure to use linear risk feature

e Failure to re-link risk areas after edits

e Demarcation of risk areas is too approximate or too granular

It is also necessary to assign a planning scenario to each risk area. The text queries
TQ120 to TQ124 will have checked if a planning scenario has been assigned. It is
also necessary to check if the intended, and reasonable, planning scenario has been
assigned. For example, RTA scenarios usually distinguish between motorway and low

speed roads.

The special service text queries are summarised in Table 10.

55



FSEC Toolkit Review Manual

Table 10: Summary of special service text queries

Save as Purpose Guiance
TQ200_IncidentsSS.txt This allows examination of the The data needs to be assessed as
quality of the incident data. per guidance in Section 4.6.2 below
with issues noted for Stage 5
discussions.
TQ202_IncidentsSS_LR.txt This summarises all special services | The data needs to be assessed as
incident data where there is a life risk | per guidance in Section 4.6.2 below
(rosub = 1) with issues noted for Stage 5
discussions.
TQ203_OAsWithoutSSRA.txt This checks for output areas omitted | There should be no records. Refer to
from the creation of risk areas.. Section 4.6.3
TQ205_SSRAMissingSSRG. txt This checks for risk areas missed There should be no records. Refer to
from creation of risk groups. Section 4.6.4
TQ206_IncidentsSS_CAS.txt Lists all special service incidents The data needs to be assessed as
where there are any casualties (i.e. per guidance in Section 4.6.2 below
ROF+ROC+ROR>0) with issues noted for Stage 5
discussions.

4.6.2 TQ200, TQ202 & TQ206: Data inputs

The following output files and pivot tables created by the MS-Excel macros can be
used. The ‘special services summary sheet’ shows a comparison of the FSEC values
against the F&RS’s values.

Input File MS-Excel File Macro Save Output

TQ200_IncidentsSS.txt Incidents.xls Macros.xls TQ200IncidentsSS.xlIs
Updatelncidents

TQ202_IncidentsSS_LR.txt Incidents.xls Macros.xls TQ202IncidentsSS_LR.xls
Updatelncidents

TQ206_IncidentsSS_CAS.txt Incidents.xls Macros.xls TQ206IncidentsSS_CAS .xlIs
Updatelncidents

It was apparent from the Pathfinder brigade data that there were sets of very
anomalous special service data. As the number of special service deaths is based on
the recorded number of incidents with one or more death, casualty or rescue, the
results will be highly influenced by differences in reporting practices.

Table 11 presents the ratio of deaths, casualties and rescues per n casualty incidents
used for producing the response time fatality rate relationship for special services.
Any data supplied for (say) a F&RS that reports very different ratios, such as 50%
greater or less than those noted here, should be checked. For example, does the
F&RS adopt a significantly different reporting practice or are there substantive
differences between the specific F&RS and others, such as it being entirely rural?

TQ200 presents results for all incident data, whereas TQ202 presents results where
ROSUB = 1 (i.e. the incident is marked as a “life risk” incident). TQ206 presents data
for ‘casualty incidents’ — i.e. where the record of fatalities, casualties or rescues for an
incident is greater than or equal to one. The Pivot table created for TQ202 above
should be used in conjunction with Table 11 below for comparison of expected and
actual ratios.
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FSEC calculates special service fatality rates using the number of incidents that are
marked by the F&RS within FSEC as a “life risk incident”. These are incidents which
would be expected to be recorded as having involved one or more death, casualty or
rescue. However, this may not always be the case — for example the F&RS may have
recorded rescues in the case of lift rescue or lock-ins which were not life threatening
incidents and it would be appropriate for these not to be marked as life risk
incidents. Additionally, in some cases, the F&RS reporting practice may record
‘casualties’ for incidents which did not require F&RS attendance (e.g. where casualties
were removed prior to F&RS arrival at the scene of the incident). In these cases,
marking these incidents as ‘life risk’” within FSEC could skew the results and the F&RS
may need to review incident reports to ensure that only genuine life risk incidents are
recorded as such within FSEC.

A useful check is to look at the ‘Incident Data’ tab on TQ202 and review the
allocation of life risk incidents (ROSUB = 1) to the ROF/ROC/ROR values. Where
there are records of fatality, casualty or rescues, it would generally be expected to be
recorded as ROSUB = 1, although as mentioned above this might not always be the
case and should be discussed at Stage 5. Conversely, where ROSUB = 1 and there are
no fatalities, casualties or rescues recorded for that incident the reasons for this
should be discussed in Stage 5.

In theory, any incident involving one or more death, casualty or rescue should be
cited as a Category A (life risk) incident. However, it is not so simple for a number of
reasons:

1) In some cases a ‘rescue’ is not really a rescue. In particular, ‘releasing’ people
from lifts or a house has in the past been recorded as a rescue — as this was
the only term used. Such releases are now reported separately from rescues
but this was not always previously the case. So the F&RS must go through the
old data and manually identify ‘real’ rescues from releases. This is particularly
true for lift releases and lock in/lock out.

2) In some F&RSs the occurrence of deaths, casualty or rescue is not recorded for
special services incidents. The F&RS did record the occurrence of the incidents
so the F&RS should use alternative sources to identify which involve a risk to
life, and then denote it as category A regardless of whether the data in FSEC
declares a death, casualty or rescue. In some cases the F&RS use police data
on RTAs to spot incidents attended by the F&RS that involved a casualty.

Unfortunately this manual reconciliation process is prone to error and there is little
(if any) guidance on how to do it. So different F&RS must be expected to have done
very different things to reconcile their data.

It may be correct to mark incidents as Category A even if FSEC does not cite any
deaths/ casualties/ rescues, if data from elsewhere shows there was a death/ casualty/
rescue. On the other hand, if there are (say) RTA incidents with a death that is
entered as Category 0, this should be questioned.

There are cases where a death may be marked as ‘no life risk’, namely where the call

was to retrieve a dead body, where the death occurred well before the 999 call, e.g. a
corpse found in the woods or a house.
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The idea of the ratios in Table 11 is to help spot anomalies in the way the F&RS has
coded its data. The anomalies need to be explored and investigations undertaken to
see if the F&RS has followed the principle of identifying all special service incidents
involving one or more death/casualty/rescue, what data source was used etc; did they

exclude releases etc?

Unfortunately, some F&RS record casualties who have left scene of a RTA before
F&RS arrival, other F&RS only record casualties there on their arrival — so even when
‘good’ data is used it may be developed on different rules.

FSEC does not really use data on special service incidents without deaths/ casualties/
rescues. Such data can be used as a secondary way of gauging risk in an area but is
not used in the fatality rate predictions.

It is also possible that some incident types are not recorded by F&RS and have zero

entries.

Table 11: Ratio of deaths, rescues and casualty per “life risk” special service
incidents in FSEC, for comparison with TQ202

Incident type

Deaths per Life Risk
casualty incidents

Casualties per
Life Risk casualty
incidents

Rescues per
Life Risk casualty
incidents

RTAs 1in10 2 per incident 1in2
Extrications 1in 43 1in15 1in1.3

Other special services |1in 13 1in1 1in6

Lift rescues* Less than 1 in 600 1in 10 3 per incident
Lock in / out* 1in7.5 1in4.5 1in1
HAZCHEM 1in24 1in1.4 1in1.5

Line rescues* Lessthan 1in 2 1in14 1 per incident
Ladder rescues” Less than 1in 40 1inb.5 1.2 per incident
Water rescues 1in6 1in9 2 per incident

*There are so few line/lift/ladder rescues that the ratios are extremely uncertain.

4.6.3 TQ203: Missing output areas

The output file TQ203_.txt shows any output areas without special services risk areas.
This file should contain no records if all output areas have been allocated to a risk area.

4.6.4 TQ205: Missing risk areas

The output file TQ205_.txt shows any special services risk areas not assigned to
special services risk groups. This file should contain no records if all risk areas have
been allocated to risk groups.



Stage 4 — Review team desk top interrogation of FSEC text queries and exports

4.7 Processing Other Buildings Data

4.7.1 Introduction

The other buildings module uses the following inputs:

Valuation Office data — showing buildings, plotted on the GIS, each with an
occupancy type, and

A mastermap — with building footprints that the building must be placed on to
pick up the floor size

F&RSs must ‘cleanse’ this data by:

Checking the position of buildings

Adding in HMOs and purpose built flats that are not included in the Valuation
Office data

Reconciling the count of buildings with other sources, particular Fire Safety files
and information on care homes and hospitals

Areas of homogenous risk are identified and arranged into risk areas and thence into
groups as per dwellings and special services. However, in the case of other buildings
it is then necessary to create Time Generated Other Building Risk Areas (TGOBRASs)
upon which the risk of death is assessed.

Also, each building has a site assessment, covering issues such as quality of fire
detection and number occupants. The F&RS is expected to progressively edit the site
assessments, starting with the higher risk and larger buildings, over a matter of years.

The F&RS may delete the Valuation Office data and replace it with another set of data.

The errors that can occur include:

Failure to replace a deleted Valuation Office dataset by another dataset, and/or
only partially replace the dataset

Failure to add in HMOs and purpose built flats

Inadequate reconciliation of Valuation Office data with other counts/records of
buildings, causing omission of large or high risk types of buildings

Failure to correct geocoding of other buildings, leading to buildings to be either
on the wrong footprint and in wrong location, or not on a footprint and hence
lacks a size

Method of identifying HMOs and purpose built flats is inaccurate

Failure to progressively modify the pre-set ‘average’ site assessments

59



FSEC Toolkit Review Manual

60

e Default site assessments are lost or wrongly over written whilst loading Valuation
Office data or operating FSEC

e Inappropriate approach to site assessments
e Omit some output areas, risk areas or risk groups in the grouping process

e Link together output areas that are not comparable in terms of risk (profile and
mix of buildings)

e Risk groups are too small or too large
e Failure to re-link risk areas after edits
e Process of creating TGOBRA too coarse — omitting key areas of risk

The other building text queries are summarised in Table 12.
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Table 12: Summary of other building text queries

File Name

TQ250_0OBSiteAssessment.txt

Purpose

Checks if the Valuation Office data
has been augmented. If the F&RS
has added in HMOs, care homes,
purpose built flats, hospitals and
other buildings as they are expected
to, then there should be records.

Guiance

If records are reported the
completeness of these added
records can then be explored. If no
records are reported then the F&RS
may have failed to correctly augment
the Valuation Office data set. Refer
to Section 4.7.2

TQ251_OBWithoutFootprint

Checks for buildings without a
footprint

This file should contain no records.
Refer to Section 4.7.2

TQ252_ObsMoved.txt

Checks for buildings where the
location has not been checked.

This file should contain no records.
Refer to Section 4.7.2

TQ254_0OBDefaultsNotChanged

Checks if defaults fire safety features
have been changed.

The file reports records where the
defaults have not been changed.
Ideally this file should contain no, or
very few, records. Refer to Section
4.7.3

TQ255_0OBSAPeople

This gives the occupancy level per
type of other building. The default
occupancy levels for FSEC need to
be edited.

The file is used with the macro to
show the occupancy levels for
different buildings across the six time
periods. Refer to Section 4.7.3

This query also shows the move flag
for each other building site
assessment.

TQ257_0OBSAless20

This query shows buildings with
‘Category A" occupation from 08:00
to 20:00 for buildings N/R/S
(Shops/Factories/Offices)

This query shows the number of
shops, factories and offices for
which the default values have not
been changed (the F&RS should
legitimately change the values for
such premises which are certificated)

TQ258_0B>20

This query shows buildings with
‘Category B’ occupation at all times
for C/D/E/F/G/H (HMSO’s/Flats/
Hotels/Hostels/Houses/Other Sleep)

This query shows the occupancy
levels for types C, D, E, F, G and H
properties and therefore can be
used to identify where defaults have
been changed.

TQ259_0B>200netimeperiod

This query shows buildings with
‘Category C’ occupation at all times
for A/B (Hospital/Care Homes)

This query shows the occupancy
levels which are unchanged from the
default values for hospitals and care
homes

TQ275_0B20to50

This query shows buildings with
‘Category B’ occupation for J/M/T
(Education/Schools/Other work)

This query shows the occupancy
levels which are unchanged from the
default values for education, schools
and other work places.

TQ276_0B50to100

This query shows buildings with
‘Category C’ occupation for K
(Public buildings)

This query shows the occupancy
levels which are unchanged from the
default values for public buildings

TQ277_0B20to50_12to24

This query shows buildings with
‘Category B’ occupation for
Licensed premises

This query shows the occupancy
levels which are unchanged from the
default values for licensed premises.

TQ256_0OBSiteVisits.txt

This gives records of where site
visits have been made by the F&RS.

There should be some records in
this file to indicate that the F&RS site
visit details are being updated. Refer
to Section 4.7.3
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Table 12: Summary of other building text queries (continued)

File Name Purpose Guiance

TQ260_OANotinOBRA.txt Identifies any output areas not Should be no records. Refer to
assigned to a risk group. Section 4.7.4

TQ261_OBRANotInOBRG.txt Identifies any risk area not in a risk | Should be no records. Refer to
group Section 4.7.5

TQ263_TGOBRAMIissingH_VHRIsk.txt | Identifies any high or very high risk | If records are reported this may
areas not allocated to a TGOBRA. | mean the TGOBRAs are poorly
placed and have missed some areas
of high risk. Refer to Section 4.7.6

TQ273 HMO or Flats with Wrong Reports any other buildings that are | This file should contain no records.
Storeys.txt classed as HMQ's but have less All HMO’s should have at least three
than three storeys or any that are storeys and all flats should have
classed as flats with less than four | more than four storeys. If they have
storeys. less then the category may be
wrong, or the details have not been
revised. The entries reported should
be checked and either correctly
classified or the storeys changed. If
the number of storeys is wrong then
the floor area is not correctly
calculated and consequently the
impact of a fire is not correct. See

Section 4.7.7.

TQ274 EnvironmentandHeritageRisk | This query identifies other buildings | This file will contain records if the
site assessments where at least F&RS has identified other buildings
one of the ‘other risk’ fields have which are a heritage, fire fighter,
been completed environmental, sole supplier or

exceptional value risk.

4.7.2 Data inputs, TQ250-252
TQ250: Valuation Office data check

This text query checks if the Valuation Office data has been augmented. If the F&RS
has added in HMOs, care homes, purpose built flats, hospitals and other buildings (as
they are expected to) then there should be records.

TQ251 and 252 - Status of building locations

The output file TQ251_.txt lists all buildings without a footprint. This file should
contain no records. If it does contain records then correcting these issues should be
done based on the building type, with the higher occupancy buildings being
corrected first.

The output file TQ252_.txt lists all buildings where the building location has not been
checked. Ideally this file should not contain any records. If it does contain records
then correcting these issues should be done based on the building type, with the
higher occupancy buildings being corrected first.
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4.7.3 Site assessments

TQ254, TQ255, TQ256, TQ257, TQ258, TQ259, TQ275, TQ276 & TQ277: Check
on modification of defaults

The output file TQ254_.txt, shows sites where none of the general default values G.e.
smoke alarm etc as shown in Table 13) have been changed. Ideally this file should
contain very few records. Priority on correcting these issues should be based on the
building type with highest occupancy building being resolved first. It is advised that
the very large buildings and possibly higher risk occupancies (HMO's, hospitals, care
homes, hotel and hostels are assessed as a first priority.)

For TQ255 the UpdateAssessments macro also creates a pivot table showing the count
of different occupancy types against the move flag. This can be used to identify how
many buildings of each category have been checked. For example if there were ten
hospitals then how many of those ten had been checked, moved etc. If very few have
been checked then priority should be given on ensuring that the location is correct
for the most highly occupied, (in general this is the ones starting with ‘h’, hospitals,
hotels, HMOs etc)

The output file TQ256, shows sites that have been visited by the F&RS and the
assessments have been checked.

The output files TQ257, 258, 259, 275, 276 and 277, show sites where none of the
default occupancy levels (as shown in Table 14) have been changed. Priority on
correcting these issues should be based on the building type with highest occupancy
building being resolved first. It is expected that:

e All HMOs (of three storeys or more), houses converted to flats, purpose built flats,
other sleeping accommodation, public buildings, buildings open to the public,
hospitals, care homes, hotel, licensed premises, schools, further education and
hostels should have >20 people?

e A minority of shops, offices, factories, and other work places should have >20
people, i.e. those that are certificated

The following output files and the pivot tables created by the MS-Excel macros can
also be used. Each sheet shows the split of occupancy and building type for a
specific time period.

Input File MS-Excel File Macro Save Output
TQ255_OBSAPeople.txt OB Assessments.xls | Macros.xIs TQ255_0OBSAPeople.xls
UpdateAssesments

3 Note that an update to the FSEC software is planned which will ensure that all hospitals, care homes, hotels, hostels, HMOs
(> 3 storeys) are identified as being of ‘social risk’, regardless of the occupancy levels allocated within FSEC.
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However:

e The ‘persons at risk’ should not be less than 20 to 50 in all time periods for HMOs
of three or more storeys, houses converted to flats of three or more storeys, care
homes, hotels, hostels, purpose built flats, and other sleeping accommodation

e The ‘persons at risk’ should not be less than 20 to 50 for hospitals, schools,
further education colleges and licensed premises — in at least one time period

e The ‘persons at risk’ should not be less than 20 to 50 people for certificated
premises in at least one time period for shops, public buildings, factories, offices
and other workplaces

If this is not the case, then the rationale for the deviation should be discussed. It
should be noted that the generic fire frequencies for HMOs of three or more storeys,
houses converted to flats of three or more storeys, hotels, care homes and hostels are
based on the assumption that they all present a societal risk — even if they have less
than 20 persons at risk. This was done to help simplify the site assessment process
and hence users should not state <20 persons in these properties. Note that an update
to the FSEC software is planned which will ensure that all hospitals, care homes,
hotels, hostels, HMOs (> 3 storeys), purpose built flats and houses converted to flats
are identified as being of ‘societal risk’, regardless of the occupancy levels allocated
within FSEC.

It should be noted that FSEC requires that HMOs entered by the F&RS should have
three storeys or more. Some F&RSs may have data for HMOs of less than three
storeys. In this case, the F&RS should ensure that these buildings are entered as ‘other
sleeping accommodation’, especially where there are > 20 people at risk.

The default ‘number of people in the most highly occupied compartment’ is ‘Less
than 20 people’ for all other occupancies. F&RS are meant to change the ‘number of
people in the most highly occupied compartment’ by identifying which shops, offices,
factories, and other workplaces properties have a fire certificate, if they have a
certificate they should be assumed to have 20 to 50 persons at risk as a minimum.
Therefore, there should be some entries for these types of properties. If not they are
likely to have overlooked a minority of their societal risk.

In the case of very large properties, such as shopping malls and football stadiums, the
persons at risk could be >100. Therefore, there should be some entries for >100
persons. If not, the F&RS may not have site assessed some of their larger societal risk
properties and hence be understating the risk.

Table 13: Site assessment defaults (user modified)

Number of 1

storeys

Alarm Standard Management of fire safety |Average

Type of people |Normal mix |Sprinklers No sprinklers fitted
Smoke control |None Afa present Left blank




Table 14: Maximum loss (societal risk defaults)

Occupancy
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Societal risk status

Default set
on import to
FSEC

F&RS action
when using
FSEC

Number of people in the
most highly occupied
compartment

Default set
on import to
FSEC for
specified
time periods

F&RS action
when using
FSEC

Time period for which
‘number of people ...’ is
applied

Default set
on import to
FSEC

F&RS action
when using
FSEC

minimum of 20
to 50

Hospital (A) Imported as a | Do not change |50 to 100 Check & All time Check if (e.g.)
“societal risk” | regardless of change as periods day care only,
number of appropriate and change as
patients but apply a appropriate
minimum of 20
to 50
Care homes |Imported as a | Do not change |50 to 100 Check & All time Do not change
B) “societal risk” | for certificated change as periods
care homes appropriate
regardless of but apply a
number of minimum of 20
residents to 50
Houses in Imported as a | Do not change | 20 to 50 Check & All time Do not change
multiple “societal risk” | regardless of change as periods
occupation 3 number of appropriate
or more residents but apply a
storeys (Bed minimum of 20
sits, HMOs, & to 50
tenements)
©)
Purpose built | Imported as a | Do not change |20 to 50 Check & All time Do not change
flats 4 storeys | “societal risk” | regardless of change as periods
and above (D) number of appropriate
residents but apply a
minimum of 20
to 50
Hotels (E) Imported as a | Do not change |20 to 50 Check & All time Do not change
“societal risk” | regardless of change as periods
number of appropriate
residents but apply a
minimum of 20
to 50
Hostels (F) Imported as a | Do not change | 20 to 50 Check & All time Do not change
“societal risk” | regardless of change as periods
number of appropriate
residents but apply a
minimum of 20
to 50
Houses Imported as a | Do not change | 20 to 50 Check & All time Do not change
converted to | “societal risk” | regardless of change as periods
flats of 3 or number of appropriate
more storeys residents but apply a
(©) minimum of 20
to 50
Other Imported as a |Add in HMOs |20 to 50 Check & All time Do not change
sleeping “societal risk” | of <3 storeys change as periods
accommoda- that have 20+ appropriate
tion (H) persons at risk but apply a
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Table 14: Maximum loss (societal risk defaults) (continued)

Occupancy

Societal risk status

Default set
on import to
FSEC

F&RS action
when using
FSEC

Number of people in the
most highly occupied
compartment

Default set
on import to
FSEC for
specified
time periods

F&RS action
when using
FSEC

Time period for which
‘number of people ...’ is
applied

Default set
on import to
FSEC

F&RS action
when using
FSEC

Further mported as a | Do not change | 20 to 50 Check & 08.00 to 20.00 | Check to see if
education “societal risk” change as 7 days per hours of
colleges (J) appropriate week occupation
but apply a differ, e.g. late
minimum of 20 opening and
to 50 change as
appropriate
Licensed Imported as a | Do not change | 20 to 50 Check & 12.00 to 24.00 | Check to see if
premises (L) | “societal risk” | regardless of change as 7 days per hours of
number of appropriate week occupation
customers but apply a differ and
minimum of 20 change as
to 50 appropriate
Schools (M) Imported as a | Do not change | 20 to 50 Check & 08.00 to 20.00 | Check to see if
“societal risk” change as 7 days per hours of
appropriate week occupation
but apply a differ, e.g. late
minimum of 20 opening and
to 50 change as
appropriate
Shops (N) Imported as Need to 20 to 50 Check and 08.00 to 20.00 | Check to see if
non-societal identify and change 7 days per hours of
risk include all fire certificated week occupation
certificated (but apply differ, e.g. 24
minimum of 20 hr shopping
to 50 for and change as
certificated) appropriate
Buildings Imported as Need to 50 to 100 Check and 08.00 to 20.00 | Check to see if
open to the non-societal identify and change 7 days per hours of
public (P) risk include all fire certificated week occupation
certificated (but apply differ, e.g.
minimum of 20 night time
to 50 for opening and
certificated) change as
appropriate
Factories (R) | Imported as Need to 50 to 100 Check and 08.00 to 20.00 | Check to see if
non-societal identify and change 7 days per hours of
risk include all fire certificated week occupation
certificated (but apply differ, e.g. 24
minimum of 20 hr shift and
to 50 for change as
certificated) appropriate
Offices (S) Imported as Need to 20 to 50 Check and 08.00 to 20.00 | Check to see if
non-societal identify and change 7 days per hours of
risk include all fire certificated week occupation
certificated (but apply differ, e.g. 24
minimum of 20 hr shift and
to 50 for change as
certificated) appropriate
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Table 14: Maximum loss (societal risk defaults) (continued)

Occupancy

Societal risk status

Default set
on import to
FSEC

F&RS action
when using
FSEC

Number of people in the
most highly occupied
compartment

Default set
on import to
FSEC for
specified
time periods

F&RS action
when using
FSEC

Time period for which
‘number of people ...’ is
applied

Default set
on import to
FSEC

F&RS action
when using
FSEC

Other Imported as Need to 50 to 100 Check and 08.00 to 20.00 | Check to see if
workplaces non-societal identify and change 7 days per hours of
M risk include all fire certificated week occupation
certificated (but apply differ, e.g. 24
minimum of 20 hr shift and
to 50 for change as
certificated) appropriate

4.7.4 TQ260 - Output areas overlooked

TQ260 identifies any output areas not assigned to a risk group. There should be no
records.

4.7.5 TQ261 — Risk areas overlooked

This checks if any risk areas have been omitted from risk groups. There should be no
records.

4.7.6 TQ263 — TGOBRA for all high and very high risk areas

If records are reported this may mean the TGOBRAs are poorly placed and have
missed some areas of high risk.

4.7.7 TQ273 — HMOs or flats with ‘wrong’ number of storeys

This file should contain no records. All HMO’s should have at least three storeys and
all flats should have more than four storeys. If they have less then the category may
be wrong, or the details have not been revised. The entries reported should be
checked and either correctly classified or the storeys changed.

It should be noted that some F&RSs may have entered HMOs with fewer than three
storeys, and any records returned should be checked at Stage 5. ‘HMOs’ of less than
three storeys should be entered as ‘other sleeping accommodation” and their
occupancy levels set to reflect their actual occupancy levels.

4.8 Major Incidents

4.8.1 Possible errors

The major incident module relies on the user to define risk areas for each type of
major incident and to select a risk level for each risk area.
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Risk areas do not have to cover all output areas. The F&RS may choose to only
identify areas of medium or high risk, and may choose to only map out those types of
major incidents that pose a significant risk (and hence not denote areas of low risk).
Possible errors include:

e Fail to demarcate risk areas for each category of major incident

e Assign an inappropriate risk category

4.8.2 TQ300: Major incidents data

The incident pivot table identified below can be used to review the outputs, in similar
way that done for dwellings and Special services. If there are major incidents reported
then the F&RS should have defined some major incident risk areas.

Input File MS-Excel File Macro Save Output
TQ300_IncidentsMI.txt Incidents.xls Macros.xls TQB00IncidentsMI.xls
Updatelncidents

4.8.3 TQ302: Output areas linked to major incident risk areas

TQ302 notes output areas that are part of a risk area. There should preferably be
some records.

4.9 FSEC Outputs (performance predictors)

4.9.1 Introduction

FSEC produces a set of predictions for:

e Fatalities in dwellings

e Fatalities in other buildings

e Fatalities in each type of special service and all special services
e Loss in & of property in other building fires

It is possible, using data in FSEC, to compare the reported number of (actual)
dwelling and special service deaths with those predicted by FSEC.

4.9.2 TQ152 & TQ200 - Dwellings and special services predicted deaths

The ‘All’ sheet in the output files TQ152IncidentsD.xls (dwelling incidents) and
TQ200IncidentsSS.xls (special services incidents) shows the reported ‘actual’ numbers
of incidents. The ‘Dwelling Summary’ sheet in TQ152 shows summary values for
ROITYPE 1 (Dwelling Fires) and 2 (Fires in other buildings). The ‘special services
summary’ sheet in TQ200, shows summary values for each special services. These
values can be compared the values reported in the ‘PerformancePredictors.txt’ file.
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The following guidance is offered.

The predicted number of dwelling fatalities should preferably be within 10% of the
reported number. However, this may (legitimately) not be the case where:

e The F&RS has a relatively small number of dwelling fire deaths each year (such as
less than 10 to 20), and hence their ‘actual’ number of deaths for any 3 year
period may be subject to spikes and dips, such as if a fire with (say) 5 deaths
occurs

It is also possible for the predicted and actual number of deaths to differ due to:

e The F&RS has implemented a successful community fire safety scheme that has
reduced the number of deaths per fire

e The F&RS has a skewed reporting practice that leads to an over or under
reporting of casualties

If the predicted and actual deaths differ greatly, such as by more than 20%, then (1)
review the results of the earlier text queries and if they are satisfactory (2) explore
other explanations for the divergence in results.

In the case of special services it is possible that the predicted deaths differ,
‘legitimately’, from the predicted deaths by far more than 20%. The following
guidance is offered.

In the case of lift releases, HAZCHEM, ladder rescues, lockin/lock out — the number
of actual deaths can be a fraction per year or even zero. Therefore, FSEC may give a
prediction of (say) 0.01 deaths per year against zero reported. Alternatively, FSEC may
predict 0.001 deaths per year against a reported 0.3 per year arising from 1 death in

3 years.

In the case of RTAs, extrications and other special services, there tends to be a larger
number of actual and predicted deaths. However, as reporting practices vary greatly
between F&RS (such as what is counted as a casualty) this introduces a relatively
wide margin of error. Therefore, it is reasonable to expect the prediction to be within
a reasonable margin of the actual deaths, such as within 50%. It is useful to scrutinise
these results in parallel with the results of TQ200 which helps to identity differences
in reporting practices.

In the case of water and line rescues, the number of deaths and hence the robustness
of the actual number of deaths varies between F&RS according to (1) if these incidents
are attended by the F&RS and (2) if local features are present that contribute to such
incidents. Therefore, the possibility of checking the robustness of the predicted
number of water and line rescues needs to be considered on a case by case basis.

Finally, as some F&RS may not report all categories of special services, there may be
gaps in the results. Whilst it is reasonable to omit the lesser categories of special
service (lift releases, HAZCHEM, ladder rescues, lockin/ lock out), the other categories
(RTAs, extrications and other special services, and possibly water and line rescues)
tend to pose a significant risk and are less reasonable to omit.
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4.9.3. Other buildings performance predictors

PerformancePredictors.txt — Societal risk

It is difficult to assess the validity of the predicted number of societal risk deaths due
to the lack of an independent measure of actual deaths. The societal risk prediction
includes rare events that may have large numbers of deaths, and may not have
occurred in recent years. In anything other than metropolitan F&RSs, there may be no
such events reported for the past 10 or 20 years.

It is possible to make a simple and somewhat coarse comparison against the expected
number of deaths. FSEC is based on a set of societal risk fire frequencies and fatality
rates per response time. The dataset for the UK indicates about 110 societal risk fires
per annum. If a three appliance attendance is made in <10 minutes FSEC would
predict 1.6 deaths per fire, also assuming 8 persons at risk per fire. Thus, for the UK
as a whole FSEC would ‘expect’ about 170 deaths per annum. If such fires occurred
in areas where 4 appliances can attend in <10 minutes, the predicted total for the UK
would fall to about 53 deaths per year. Thus, the ‘expected’ total number of deaths is
very sensitive to the assumptions made. Therefore, a range of expected number of
deaths is shown in Table 15 for English F&RS.

As societal risk is approximately proportionate to the number of other buildings, the
predicted number of deaths should be a similar proportion of 53 to 170.

In the case of English F&RS, the expected deaths are shown in Table 15, based on
the count of Valuation Office data. Care must be taken here as the expected deaths
are based on the proportion of Valuation Office buildings in each F&RS. Societal risk
is significantly influenced by HMOs which are not noted in Valuation Office counts.
Therefore, it is possible that the distribution of HMOs between F&RSs may not the
same as the distribution of the types of buildings counted by the Valuation Office.

In the case of Scotland and Wales, reliance must be placed on comparing the
predicted number of deaths

There are about 170,000 HMOs and tenements in the UK, plus about 1.9m other
buildings, i.e. a total of about 2.1m. Thus, if the F&RS has (say) 15% of 2.1m other
buildings (including HMOs and purpose built flats), the predicted number of societal
risk deaths should be within a reasonable distance of this value.

If there is a great difference, such as double or half the expected value, this should
be explored further.

PerformancePredictors.txt — Property loss

In the case of English F&RS it is possible to compare the predicted property loss with
the ‘expected values’ shown in Table 15. These expected values are based on the
Valuation Office data on the number of other buildings, multiplied by respective
generic fire frequencies and average loss per fire. Thus, these are approximate values
of the expected loss per year.
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In the case of Wales and Scotland it is possible to compare the predicted loss with the
loss expected for the UK, as a test of whether it is in proportion. That is, property risk
is determined mainly by the number of other buildings (excluding HMOs and
purpose built flats). Therefore, the predicted loss as a proportion of UK loss should
be approximate to the proportion of other buildings in the F&RS area.

The ‘expected’ loss for the UK is about £2.4billion per year. There are, as per the
Valuation Office data, 1.5million buildings with known categories and about 150,000
with unknown categories in England. If this is scaled up for Scotland and Wales in
proportion to the population level you arrive at ~1.9m other buildings (excluding
HMOs and purpose built flats).

Thus, if the F&RS account for (say) 10% of the 1.9m other buildings (excluding HMOs
and purpose built flats), it should also predict about 10% of £2.4billion loss per year.

These are clearly simple comparisons and it should be noted that the F&RS prediction
may have legitimately changed due to:

e Corrections to the Valuation Office data
e Amendment of site assessments
e A significant difference in response times to the ‘average’ for the UK

However, if the prediction is (say) double or half the expected, this should be
reviewed.
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Table 15: Expected property loss and societal risk deaths per annum in English

F&RS

Expected Expected range of
F&RS property loss societal risk deaths
Avon Fire Authority £38,599,277 0.9 2.83
Bedfordshire Fire Authority £19,455,341 0.4 1.29
Berkshire Fire Authority £26,087,270 0.5 1.79
Buckinghamshire Fire Authority £24,000,134 0.5 1.55
Cambridgeshire Fire Authority £28,468,742 0.5 1.73
Cheshire Fire Authority £36,312,710 0.8 2.65
Cleveland Fire Authority £16,614,336 0.4 1.40
Cornwall £54,531,283 1.1 3.50
Cumbria £43,630,810 0.9 2.86
Derbyshire Fire Authority £42,224,563 0.9 2.82
Devon Fire Authority £68,743,008 1.4 4.64
Dorset Fire Authority £33,929,126 0.8 2.66
Durham Fire Authority £23,383,949 0.5 1.60
East Sussex Fire Authority £32,177,069 0.8 2.64
Essex Fire Authority £56,763,072 1.2 3.96
Gloucestershire £28,278,605 0.6 1.87
Hampshire Fire Authority £56,439,418 1.2 3.94
Hereford and Worcester £34,495,200 0.7 2.15
Hertfordshire £35,450,938 0.7 2.41
Humberside Fire Authority £34,617,504 0.8 2.64
Isle of Wight Council £9,387,398 0.2 0.72
Kent Fire Authority £61,927,392 1.3 4.24
Lancashire Fire Authority £63,832,570 1.6 5.40
Leicestershire Fire Authority £36,160,858 0.8 2.56
Lincolnshire £29,864,256 0.6 2.06
Norfolk 247,724,211 0.9 3.01
North Yorkshire Fire Authority £50,029,882 1.0 3.35
Northamptonshire £283,407,488 0.5 1.49
Northumberland £17,574,374 0.3 1.11
Nottinghamshire Fire Authority £35,804,525 0.8 2.64
Oxfordshire £26,225,395 0.5 1.63
Shropshire Fire Authority £21,059,347 0.4 1.41
Somerset £29,184,710 0.5 1.76
Staffordshire Fire Authority £39,109,536 0.9 2.82
Suffolk £33,033,792 0.6 2.10
Surrey £38,329,517 0.8 2.62
Warwickshire £21,774,566 0.4 1.47
West Sussex £26,757,965 0.6 2.00
Wiltshire Fire Authority £25,161,446 0.5 1.56
ISLES OF SCILLY £1,252,512 0.0 0.08
Greater Manchester Fire £94,233,178 2.2 7.30
Merseyside Fire Authority £44,958,259 1.2 3.89
South Yorkshire Fire Authority £43,247,770 1.0 3.28
Tyne and Wear Fire Authority £34,124,717 0.9 2.84
West Midlands Fire Authority £983,264,307 2.1 7.05
West Yorkshire Fire Authority £82,345,824 1.9 6.24
GLA £283,5692,755 7.0 23.10
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Stage 5 - Reviewer visit to F&RS for philosophy
checks and follow up to Stage 4

5.1 Introduction
Stage 5 involves:

e Scrutinising the F&RS project management arrangements

e Structured discussion of the F&RS’s approach to FSEC, and how they have
completed the various modules of FSEC

e Following up on any errors or queries arising from the Stage 4 desk top
examination

5.2 Possible Project Management Issues

The entries in the project management checklist can be used to help guide the
examination of FSEC project management.

The issues that should be checked and discussed are summarised below:

Resourcing

e Are there an adequate number of properly trained and experienced personnel?
e I[s the resourcing of FSEC consistent or is the team frequently changed or rarely

working together (e.g. due to shift systems or multiple jobs) such that continuity
of work is lost?

Management

e Is the level (authority and effort) of project management adequate?
e [s the regularity of project management adequate?

e [s there evidence of clear project planning?

Quality control

e [s there evidence of version control?

e Is there evidence of data set control?

Prioritisation of FSEC analysis

e Has priority been awarded to cleansing the priority data only?

e Prioritisation of modules
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5.3 Dataset

On the day of the review the dataset which is in use and how management of
version control is achieved can be questioned by the reviewer.

5.4 Road Network and Vehicle Speeds

5.4.1 Review discussions

The reviewer should discuss the F&RS approach to the road network checking and
calibration.

This could include discussion around the following topics, also included are
references to the text queries run in Stage 4, the output of which could be used to
inform more detailed follow-up questions at this stage or later in the discussions as
required:
e What checks have been made on the road network?

® Guidance Section 5.4.2

m TQO11

m TQO13

m TQO17

m Overlays in Sections 5.4.4, 5.4.6, 5.4.7, 5.4.8, 5.4.9

e How have road speeds been calibrated? How many road speeds have been

calibrated?
® Guidance Section 5.4.3
B TQO024 — checks to see if default (i.e. ‘global’) road speeds have been changed

m TQO026 — checks to see if individual road link speeds have been changed
(by > 10%)

B TQO027 — checks to see if individual road link speeds have been changed
(by > 50%)

e Are there plans to undertake further calibration of road speeds?

e What is the F&RS’s approach to the definition of dead ends?

B TQO12 — looks for false dead ends (but is only relevant if the F&RS has checked

their dead ends or added loop backs)
® Overlay Section 5.4.5

e How have vehicle speeds been calibrated?

B TQO025 — checks for vehicles where speed is changed from 100%

The output of the queries associated with each of these topics can be used to inform

the discussion and be used as a prompt for more detailed questioning where necessary.
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Arrival times can be checked using the output of the following queries:
— TQO18
— TQO19
— TQ020

This can be used as a further check on the road network to highlight any junctions
which have a protracted arrival time which could indicate an error in the road
network. In general it would not be expected (but still possible in, say, very rural
areas) to receive an output for TQ018 and 019. TQ020 may well identify junctions
with an arrival time of between 30 and 59 minutes but it would be expected that
these would be on the edge/beyond the F&RS area. Overlays in Section 5.4.10 are
available to provide further information on this result and can be used to highlight
junctions for discussion with the F&RS. It should be noted that these overlays may
highlight ‘false junctions’ on motorways which have been added (sometimes at the
point where minor roads pass beneath the motorway) but this may be done by the
F&RS to break the motorway up into road links. This can be checked with an overlay
to confirm that they are false junctions and do not allow access to or from the
motorway itself.

5.4.2 Guidance on road network changes

The following are checks which would be expected to have been made by the F&RS
on the road network. The reviewer should ensure that these checks have been
undertaken through the output of text queries and/ or spot checks on the dataset
using overlays:

1. A check for road links not connected to the main road network

An overlay is provided on the FSEC system to make this check (path is Overlay,
Road Overlay, Linked to Network Check).

2. A check for breaks in the road network

An overlay is provided Overlay, Road Overlay, Road link Check though this is
more difficult as it displays all road links connected to the network at one end
only and includes all genuine dead ends. Some F&RSs may have edited all
genuine dead ends and have systematically checked the network. Often it is only
found by finding some erroneous results.

3. A check for ‘spurious junctions’, this is a junction say on a motorway flyover but
connected to the road above or below which would allow a vehicle to drive
along an A, B or C road and turn onto the motorway

Where F&RSs have the ITN layer supplied by ODPM as their road network this
should not occur as the ITN layer recognises grade separation. What may be
found are two junctions stacked on top of each other but only connected to one
road either the motorway or to the other road but not joining all four roads
together. Where F&RSs have changed their road network to say Oscar
Routemanager this can occur. There is one situation where it can occur in the ITN
layer and that is if the F&RS has exported and re-imported their road network.
When the ITN layer is re-imported it loses grade separation and, in theory, can
allow connection between the different roads.
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4. Adding one way streets and checking and correcting, if necessary, the direction
of travel

Where the F&RS has chosen to make motorway slip roads one way and not the
carriageway they need also to make the link between the on and the off slip
roads one way or in theory you could double back up the motorway and exit at
the off slip road.

5.4.3 Guidance on road speed changes

The F&RS should also have done some customisation to their road speeds. All F&RSs
were supplied with the same defaults, based mainly on the Lothian & Borders road
network, so the F&RS at least need to modify the speeds in urban areas. The effect of
not changing road speeds is that it would impact on the predicted fatalities; if the
network is too fast they will under predict, too slow and they will over predict the
number of fatalities. The best way to do this is to check the predicted times at road
junctions and compare it against actual incident data for their F&RS. Some F&RSs
have software from ODPM called T-check which allows them to compare actual and
predicted speeds but it was not sent out as part of the standard build. The same thing
can be checked in other ways.

5.4.4 Overlays: Road network

If the output from TQO11.txt reported any results then some of the road junctions did
not have a ‘first arrival time’. These junctions can be viewed and spot checked to
ensure that they have been defined correctly using either the standard ‘Overlay»Road
Overlays»Link to Network Check’ overlay or the ‘O011 Missing Road Junction and
Road Link Info’ Review overlay.

Review Overlay
e Choose any map scale other than 1:1250
e Remove background map

e Overlay»Define O011_MissingRoadJunctionandRoadLinkInfo

This overlay shows the following

e Pink lines for road links that don’t have a type and unclassified
roads (roads without a type ONLY can be shown by
deleting “or RTYPE="U" ” from the where clause for the
pink lines and deselecting all other features on the

overlay)
e Blue lines for Motorway road links
e Red lines for A road links
e Yellow lines for B road links
e Green lines for C road links

e Red circles with labels for stations showing the station id and name

e Black cross for junctions with no first arrival time.
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Checks should be made on any Black Crosses and appropriate amendments made,
e.g. adding a road link to the junction, or if the junction looks ok checking the
direction of the road links.

The following additional review text query is available to check for road links that
are missing

Feature Criteria Name Layout Name Description
Road Links Q014 Changed Road Link | L013 Road Link Info Reports Road links where the road
Info details have been changed from the
defaults

5.4.5 Overlays: Dead ends

Genuine dead ends are defined by setting the road link property ‘Genuine Dead End’
to true. If this has been done and the output from TQO012_.txt reported some records
then a review overlay can be used to view these junctions.

Review Overlay
e Choose a any map scale other than 1:1250

e Overlay»Define 0012_DeadEnds
e Hide black crosses for road junctions

e This overlay shows the following:

e Green line all road links

e Large Red Cross all junctions with less than one road link, where the
junction is not defined as a genuine dead end.

e Large black cross all junctions connected to more than one road link, or
junctions with only one road link that are defined as
genuine dead ends. This item is not initially hidden
(to avoid cluttering the screen). For instructions on
making the item visible please refer to Appendix B.

Checks should be made on any Red Crosses and appropriate amendments made, e.g.
setting the genuine dead end property.

Note: Whilst it is useful to identify genuine dead ends it is not a high priority. If there
are a small number of dead ends these should be corrected (to complete the
process). If there are a large number then the F&RS should tidy these up after any
other items have been resolved.
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5.4.6 Overlays: Road continuity check

Review Overlay

e Choose a any map scale other than 1:1250
e Remove the background map

e Overlay»Define O013_RoadContinuityCheck
Note that the overlay prompts for a station number. This can be found in the ID’
column of the output of TQ100 or can be seen on any overlay within FSEC which

highlights fire station location.

This overlay shows the following:

e Black line all road links

e Large Green Cross all junctions where the first arrival is from the specified
station

e Large Red Cross all junctions where the first arrival is not from the

specified station

e Small Blue Circle all fire stations
and label

Checks should be made where there are green crosses within the area of red crosses.
These show areas where the local station is the first to arrive at the junction.
Generally red crosses would only appear at junctions around the station boundary.

If they appear within the middle of the station area this indicates a problem with the
network, either the junctions are not linked correctly or the roads are defined as one
way in the wrong direction.

5.4.7 Overlays: False junctions

Review Overlay

e Remove the background map

e Overlay»Define O014_FalseJunctions_Motorways
e Overlay»Define O015_FalseJunctions_Aroads

e Hide the small black crosses for the road junctions

This overlay shows the following:

e Pink lines for road links that don’t have a type
e Blue lines for Motorway road links

e Red lines for A road links

e Yellow lines for B road links

e Green lines for C road links

e Small black cross all road junctions
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e Blue cross & label all fires stations

e Large Black Cross any junction that is only attached at one end to a
Motorway (for O014)

e TLarge Black Cross any junction that is only attached at one end to an

A Road (for O015)

Checks should be made where there are Black Crosses in areas that are not real
motorway junctions (O014) or not real A Road junctions (O015). For A roads
particular attention should be paid to dual carriageways.

5.4.8 Overlays: One way
Review Overlay
e Remove the background map

e Overlay»Define 0016_OneWayRoads

This overlay shows the following:

e Blue lines roads not defined as either one-way or two way,
defaults to two way

e Green lines roads defined as two way

e Red lines roads defined as one way
(These lines show an arrow to indicate the direction
of travel.)

The overlay prompts for the type of road to be displayed. To show all motorways
enter ‘M’, ‘A’ for A roads etc.

The following spot checks can be made for a sample of motorways:

e that all slip roads are defined as one way,

e the direction is correct (if not use the ‘Overlay»Road Overlays»Change road link
direction’ to correct the direction)

The following spot checks can be made for a sample of A Roads:

e that the slip roads for dual carriageways are one way,

e the direction is correct

The following spot checks should be made for a sample of roundabouts:

e entry and exits defined correctly as either two or one way.
e direction of travel for the entry and exits is correct,
e roundabout is defined as one way,

e direction of travel on the round about is correct.
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5.4.9 Overlays: Check for output areas with no junction

If TQO17_.txt reported any records then some of the output areas do not have a road
junction associated to them. The following overlay can be used to identify these
output areas, in order to correct the problem.

Review Overlay

e Remove the background map
e Overlay»Define 0O017_OA_WithoutJunction

e Initially hide the road junction and road link.

This overlay shows the following:

e Black crosses any road junction

e Pink lines any road links

e Green areas any output area that does not have a road junction
defined

Any green areas should be checked and an appropriate road junction defined.
Alternatively use the FSEC Overlay, ‘Overlay_Road Overlays_Check for Road Junction
in OA’

5.4.10 Overlays: General test of arrival times

The output files TQO18_.txt to TQ20_.txt report any road junctions where the first
arrival time is not within 120, 60 or 30 minutes. The following review overlay can be
used to identify these road junctions.

e Remove the background map
e Overlay»Define 0O018_0020_FirstJunction

e Initially hide blue line for output area boundary.

This overlay shows the following:

e Blue line Boundary outline for each output area.

e Small blue cross Fire stations labelled with id and name

e Large Green Cross Road junction where first arrival is between 30 and
60 minutes

e Large Yellow Cross Road junction where first arrival is between 60 and

120 minutes

e Large Red Cross Road junction where first arrival over120 or not defined

All Red and Yellow crosses should be checked and discussed as appropriate. Green
crosses may appear at the edges of the F&RS boundary, these should be spot checked
to ensure that they are as expected and not caused as a result of an error with the
road network.
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A similar review overlay can be used to view the first arrival time for each output area.

e Remove the background map
e Overlay»Define 0018_0020_OAFirstArrival

e [Initially hide blue line for output area boundary.

This overlay shows the following:

e Blue line Boundary outline or each output area.
e Small blue cross Fire stations labelled with id and name
e Green area Output Area where there is a first arrival is between

30 and 60 minutes

e Yellow area Output Area where there is a first arrival is between
60 and 120 minutes

e Red area Output Area where there is a first arrival over120 or the
area does not have a road junction defined

All Red and Yellow areas should be discussed as appropriate. Green areas may
appear at the edges of the F&RS boundary, these should be spot checked to ensure
that they are as expected and not caused as a result of an error with the road
network.

If the arrival time queries (TQO18 to TQ020) showed a large number of road
junctions, then the following additional queries can be used to highlight output areas
that have junctions where there are arrival times in excess of 30, 60 or 120 minutes.

Feature Criteria Name Layout Name Description
Output Area Q021 OA First Junction Output Areas Reports output areas where at
Arrivals 120 min Plus least one junction has an arrival

time over 120 minutes or the
output area does not have a road
junction associated to it.

Output Area Q022 OA First Junction Output Areas Reports output areas where at
Arrivals 60 min Plus least one junction has an arrival
Output Areas time over 60 minutes.

Output Area Q023 OA First Junction Output Areas Reports output areas where at
Arrivals 30 min Plus least one junction has an arrival

time over 30 minutes.
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5.4.11 Overlays: Road link specific road speeds

The output from Q026_.txt (just a number) indicates those roads where the speed has
been amended by more than 10% from the F&RS defaults. The output from
TQO027_.txt lists all roads where the speed has been amended by more than 50% from
the F&RS defaults. If TQ027 contained any records these can be reviewed using the
following overlay.

Review Overlay

e Remove the background map

e Overlay»Define O027_RL_Speeds

This overlay shows the following:

e Green line All road links

e Yellow line Road links where the speed has been changed to more
than +/-10% of the F&RS default.

e Red line Road links where the speed has been changed to more
than +/-50% of the F&RS default.

5.5 Stations, Crews and Vehicles

5.5.1 Review discussions

The reviewer should discuss the F&RSs approach to identifying the stations, crews
and vehicles within FSEC and their associated costs. The following points may be
useful to discuss (even where the queries run in Stage 4 do not appear to highlight
any issues):

e How were station costs calculated?

® TQ100 — lists all fire stations, the vehicles at the station including the vehicle
crewing details and costs

m TQ104
® Overlay Section 5.5.3

e How were crew costs calculated?
m TQ100
m TQ104

B TQO03 (where the F&RS has used the spreadsheet within FSEC to determine
crew cost)

m Overlay Section 5.5.4, 5.5.5

e How were the vehicle costs calculated?
m TQ100
m TQ104
m Overlay Section 5.5.6
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e How are records of calculations maintained — e.g. data, evidence or
justifications for calculations?

e How have stations outside of the F&RS area been included? How was it
decided which stations from neighbouring F&RS areas should be included?
Have all ‘mutual assistance’ stations been included? How were the vehicle
types and crews at these stations confirmed?

m TQ100
m TQ104

e How were vehicle turn out times calculated?
B TQ105 — vehicles without TOTSs
m Overlay Section 5.5.6
m TQ106 — vehicles with TOTs outside guidance values
m Overlay Section 5.5.6

The outcomes of the detailed checks undertaken on TQ100 and 104 in Section 4.4.3
may be used to highlight specific areas for more detailed discussion. It should be
noted that vehicles, crews and stations outside the F&RS area do not need to have a
cost associated with them.

In terms of the inclusion of stations beyond the F&RS area, a pertinent question may
be to ask whether the F&RS has checked with their command which over the border
stations are called to incidents in the F&RS area, and confirmed that these are
included in the FSEC model.

It is important to remember that for crewing cost the most important part of the
review is to confirm that the ‘Crewing Cost & per year’ value is reasonable. Costs for
individual crew members do not need to be completed for this to be calculated as the
F&RS can enter their own calculated crew cost values without using the FSEC facility
to calculate this value for them using the crew member costs defined within FSEC. If
the crew member costs have been used to calculate the total crewing cost for a
vehicle in FSEC then TQO003 can be used to see if the defaults costs have been
changed and can highlight large differences between the default and changed value.
It should be noted, however, that the F&RS may have changed the default values but
overwritten them in the actual cost spreadsheets so it is important to discuss the
rationale behind their approach to crewing costs calculation.

The output of the following queries can be used to highlight particular issues within
FSEC which can be explored with the F&RS. It may be useful to have the outcome of
the queries available for these questions as they relate to specific anomalies in the
F&RS modification of FSEC and could be spot-checked as necessary:

e Stationjunction.txt — highlights stations which may not be correctly connected to
the road network

®m Overlay Section 5.5.7
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e TQ107 — identifies stations without vehicles

® Overlay Section 5.5.2

e TQ108 — identifies vehicles not within stations

® Overlay Section 5.5.2

e TQ109 — identifies vehicles not matched to a station co-ordinates

® Overlay Section 5.5.2

5.5.2. Overlays: Fire station and vehicles
FSEC Overlay

e Overlay_Fire Station and Vehicles_Fire Station and Vehicles

This overlay shows the following:
e Big pink cross Each vehicle

e Yellow label Each fire station

When looking at vehicle locations it may be useful to use the zoom function to see
whether vehicles are, in fact, at the station as they may appear to be when they are
not when on a larger scale map.

5.5.3 Overlay: Stations

The overlay can be used to spot check on any anomalies identified in Stage 4
(TQO11.txt). For stations this includes checks that:

e All F&RS and neighbouring stations are included
e Each station has an annual cost
e Station has the correct vehicles (i.e. at least one pink cross)

e Station location is correctly identified as inside/outside the F&RS

5.5.4 Overlay: Correct crew

The same overlay can be used to check that stations have
e At least one crew

e The correct crew types

5.5.5 Overlay: Vehicle crewing cost/vehicle speeds

The same overlay can be used to spot check on any anomalies identified in Stage 4
(TQ100_.txt and TQ104_.txt) that:

e All crews have a cost

e All vehicles have a speed
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5.5.6 Overlay: Vehicle type/vehicle cost/turn out times

Review Overlay
e Overlay_Define 0105_VehiclesWithoutCrewTT

This overlay shows the following:

e Yellow label Each fire station
e Green small Cross Each vehicle.
e Big Pink Cross Vehicle without a turn out time, cost, or vehicle type.

The same overlay can be used to spot check on any anomalies identified in Stage 4
(TQ100_.txt and TQ104_.txt) that:

e Big All vehicles have a type
e Big All vehicles have a cost

e Big All vehicles have a turn out time

5.5.7 Overlay: Stations not connected to road network

If the StationJunction.txt output file reported any stations, these can be spot checked
using the following overlay.

FSEC Overlay
e Big Overlay»Fire Station and Vehicles»Fire Station Location Check

or

e Big Overlay»Fire Station and Vehicles»Fire Station Road Junction Check

This overlay shows the following:

e Big Yellow Cross Each fire station not connected to the road network.
e Green line Each road link
e Black cross Each road junction

The following additional query can be used to interrogate anomalies with the fire
station and vehicle information.

Feature Criteria Name Layout Name Description

Vehicle Q102 Missing Vehicle L104 Vehicle Details Reports Vehicles that have no
type, cost, crewing, ranks or
officers.
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5.6 Planning Scenarios

5.6.1 Review discussions

Planning scenarios are defined in the Response Database. These are then applied to
dwellings, special services, other buildings and major incidents. The F&RS may make
these specific to their circumstances. There is no standard for what each planning
scenario should be.

The F&RS may have defined planning scenarios on the basis of incident type and/ or
building attributes, and used scenario descriptions accordingly. These can be viewed
on PSResources.xls

TQ117.xls and TQ119.xls provide information regarding the planning scenarios
allocated to each FSEC module (the reference numbers need to be cross referenced
with those on PSResources.xls). It is suggested that the approach taken to allocating
these planning scenarios is investigated with the F&RS and any obvious anomalies
raised.

It is suggested that it is possible to:

e Check the philosophy and evidence used by F&RS in defining
Vehicle Combinations

® Compare the ‘Vehicle Combinations’ for each scenario description against
‘typical’ vehicle combinations, as shown below in Table 16

m Check if the Vehicle Combinations specified in the scenario list allows for use
of neighbouring F&RS vehicle types

B Review TQ103 which identifies vehicles not used in planning scenarios

®m Review TQ117.xls and TQ119.xls for the allocation of planning scenarios to
FSEC modules

m Section 5.6.3

e Check the completeness of the scenario list - does it cover the full range of
incident types as listed below in Table 16

e Has phasing been used?

m Section 5.6.4

It should be noted that FSEC only gives credit to the first four vehicles to arrive at an
incident and it treats all vehicles equally. Thus, a command unit (or incident support
unit) is treated as the same as a pumping appliance. This has the effect that, if the
planning scenario is based on two pumping appliances and a command unit, FSEC
will model (if the command unit arrives first) the fire-fighting etc to be commenced
when the command unit arrives. Therefore, it is reasonable for F&RS to ‘ignore’ in
FSEC units that do not have a material role, or to phase these units by (say)

40 minutes to ensure their arrival time does not adversely impact the modelling.
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A vehicle may not be used because it may not have a vehicle type, i.e. Vtype column
is blank (or column 4 (D) in spreadsheet). In this case the vehicle can’t be used so
simply needs a ‘type’ defining. It may be that the vehicle is part of a neighbouring
F&RS and only entered so that the details for the neighbouring station are complete.
In this case it may be correct if it is not used (this should be raised at the review).

Where vehicles which are part of the F&RS and have a type but are not used this
should be investigated further (although this may be correct if the vehicle is a special
service one and the special service module has not been completed). Vehicles may be
included in the output file if they have not been included in the vehicle combinations
allowed for a planning scenario. This can be checked using the Response database,
and reviewing the planning scenario combinations, or looking at the output from the
table_comparison spreadsheet.

5.6.2 Do planning scenarios cover all risks?

As a first step, the scenario list can be compared with the guidance on ‘typical’
Pre-Determined Attendances in Table 16.

The F&RS scenario list should at least cover the four incident types, namely dwellings,
special services, other buildings and major incidents. These risks are typically be
sub-divided, typically into sub-types (e.g. RTA vs. water rescues) and commonly
accordingly to incident scale (e.g. motorway RTA vs. B road RTA).

As the scenario list may not be self-explanatory, for example a code may be used, it
might be necessary to print the scenario list and talk it through with the F&RS team.

The following text query results might be useful to inform this discussion:

e TQ115 — checks that vehicles defined in dwelling planning scenarios exist

e TQ116 — checks that vehicles defined in major incident planning scenarios exist

e TQ117 — checks that vehicles defined in other buildings planning scenarios exist

e TQ118 — checks that vehicles defined in special services planning scenarios exist

e TQ120 — checks that all dwelling risk areas have a planning scenario defined

e TQI121 — checks that all major incident risk areas have a planning scenario defined
e TQ122 — checks that all other buildings risk areas have a planning scenario defined
e TQ123 — checks that all special services risk areas have a planning scenario defined

e TQI127, TQ130 checks how many of the output areas have no planning scenario
defined in each of the modules

The output files for TQ115 to 118 provide additional details on what aspects of the
scenario are not met, i.e. planning scenario itself, Vehicles, Time or Phase. This is
particularly relevant for TQ116 which includes all the major incident types only one
of which may have Vehicles not met. It is also relevant for TQ118 which includes all
special services, again only one may have vehicles requirements not met.
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The heading lines at the top of the output files for TQ116 and TQ118 detail the order
of the major incidents/special services and the order of the fields with each group.
For each module of major incidents or special services there are two fields reported,
the planning scenario number and the Vehicle Met criteria. Only those with a ‘Vehicle
Met Criteria’ of N need to be checked, e.g. if for an output area only one of the
special services (Lock) has a vehicle met of ‘N’ then this should be checked. A similar
approach may be taken for major incidents.

5.6.3 Are the vehicle combinations specified for each scenario
reasonable and evidence based?

The ‘as-is’ FSEC assessment is intended to replicate the current disposition of
resources. Therefore, it has been advised that the planning scenarios should match, or
be similar, to resources noted in current Pre-Determined Attendances.

As the list of FSEC scenarios may not precisely match those in current PDAs, it is
pertinent to check the basis on which the scenario list and vehicle combinations have

been developed.

When checking scenario lists and vehicle combinations it is common for F&RS to:

Vary the resources according to the height and size of buildings, in the case of
building fires

e Vary the resources according to other operational factors, such as poor water
supplies, limited access, long delay in ‘make up’ (i.e. other vehicles would take
long time to arrive) and so on — typically increasing resources in areas/building

types with operational difficulties

e Vary the resources according to other site specific factors, such as historic site
needs rapid salvaging, special fire fighter or environmental risks etc

e Vary resources according to likely incident severity, such as RTAs on M-Ways vs.
B roads

The following types of analysis might be used in support of vehicle combinations:
e Task and time line analysis

e Analysis of safe systems of work
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Table 16: Incident types and typical vehicle combinations (Pre-determined
attendances)

Incident type

Dwelling fires

Vehicles (PDA)

Comment

Dwelling fire (1 to 2 storeys)

2 pumps

Dwelling fire (3 to 5 storeys)

2 to 4 pumps (incl. ladder)

Combinations may vary if (say) need extra vehicles due
to poor access (e.g. terraced housing), poor water
supply, history of multiple rescues etc.

Dwelling fire (>5 storeys)

2 to 4 pumps plus aerial

May increase pumps to allow for additional resource
needed for high rise incidents

Other buildings

Other buildings fires (1 or 2
storeys)

2 or 3 pumps (incl. Ladder)

Combinations may vary according to building size,
complexity (need for multi entry points), specific risks
such as historic site, fire loading etc.

Other buildings fires (3 or
more storeys)

2 to 4 pumps plus aerial

Combinations may vary according to building size,
complexity, specific risks such as historic site etc.

Special services

RTA (A roads or less)

2 pumps with special
service equipment.
Or:

1 or 2 pumps plus ET.

Some F&RS equip all pumps with rescue gear whilst
others may not and instead use special emergency
tenders.

Some F&RS also specify an ISU or command unit.

RTA on motorway/dual
carriage way

3 pumps or 2 pumps and
an ET

Typically send at least one vehicle up each carriageway
and plan for larger vehicles/high speed crashes.

Extrications and Other
Special Services

2 pumps with special
service equipment.
Or:

1 or 2 pumps plus ET.

Line rescue

1 or 2 pumps plus line
rescue unit (e.g. ISU)

Line rescue equipment may be described as part of an
Incident support unit, or an Emergency Tender or a
Major Incident Support Unit.

Water rescue

1 or 2 pumps plus line
rescue unit (e.g. ISU)

Water rescue equipment (for open water, mud banks
etc) may be described as part of an Incident support
unit, or an Emergency Tender or a Major Incident
Support Unit or special boat unit.

HAZCHEM

1 or 2 pumps plus foam
tender/chemical response
unit

Special unit could be defined as a Foam Tender,
Chemical response unit, incident support unit,
Emergency Tender or a Major Incident Support Unit.
The number of pumps may vary depending on typical
incident scale, such as areas with history of ‘small’
leaks and spills (e.g. conventional factories) versus
areas of special chemical risk such as refineries and
plastics plants etc.

Lift release, lock in, ladder
rescue

1 pump (ladder)

Major incidents

Rail, vehicle, bomb

3 or 4 pumps plus MISU

Support unit may be described as major incident
support unit, heavy lifting unit etc

Chemical/airport

2 or 3 pumps plus foam
tender/chemical response
unit

Shipping

Specialist units
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5.6.4 Phasing

It is not necessary for vehicles to be phased.

If the phasing facility has been used, it is pertinent to ask:
e What is the aim in using phasing?

e On what basis have vehicles been phased?

Where F&RSs are phasing, the reviewer should record the responses to these questions.

5.6.5 Overlay: Spot checks on assignment of planning scenarios to
dwelling risk areas

Having checked that the planning scenarios are reasonable, spot checks can be made
on the application of the planning scenarios to risk areas using a separate overlay for
each risk area. For example, an F&RS may have declared a three pump plus aerial
planning scenarios for inner city areas that have (say) terraced five storey tenements
or town houses, versus a two pump planning scenario for suburban semi-detached
two-storey areas. The application of the scenario to an area can be spot checked by
use of overlays.

The planning scenario related to the risk area is labelled in the overlay.

Review Overlay

e Turn off background map
e Select map scale 1:50,000
e Overlay»Define 0O168_DRA_DPS_OA

Alternative use the FSEC Overlay

e Turn off background map
e Select map scale 1:50,000
e Overlay»Create Area and Groups»Output Area to Dwelling Risk Area Check

e Overlay»Create Area and Groups»Dwelling Risk Area to Dwelling Risk
Group Check

This overlay shows the following:

e Colour coded areas for each output area, the colour defines the risk level
from dark red (very high) to pale green (very low)

e Black hash lines for output areas covered by a risk area. This includes
the planning scenario label for the risk area.

e Black cross Output areas without a risk area

e Black circle Risk areas without a planning scenario

Note The FSEC overlays do not show the planning scenario name for the risk area or
a black circle for areas without planning scenarios.
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The following additional queries can be used to interrogate anomalies with the
fire station and vehicle information.

Feature

Vehicle

Criteria Name

Q125 Vehicles Not Used

Layout Name

LL104 Vehicle Details

Description

Lists vehicles that are not in the
part of the results for dwellings,

special services, major incidents
or other buildings.

Vehicle

Q126 Vehicles Not Used in
OA

LL104 Vehicle Details

Lists vehicles that do not have an
output area list for dwellings or
other buildings.

Output Area

Q110 OA PS Not Satisfied

Output Areas

Lists all of the output areas where
all of the planning scenarios are
not satisfied. This can only be
used if vehicles are not phased.

Output Area

Q111 OA PS Not Satisfied —
Dwellings

Output Areas

Lists all of the output areas where
the dwelling planning scenarios
are not satisfied. This can only be
used if vehicles are not phased.

Output Area

Q112 OA PS Not Satisfied —
For Major Incidents

Output Areas

Lists all of the output areas where
the major incident planning
scenarios are not satisfied. This
can only be used if vehicles are
not phased.

Output Area

Q113 OA PS Not Satisfied —
Other Buildings

Output Areas

Lists all of the output areas where
the other building planning
scenarios are not satisfied. This
can only be used if vehicles are
not phased.

Output Area

Q114 OA PS Not Satisfied —
Special Services

Output Areas

Lists all of the output areas where
the special services planning
scenarios are not satisfied. This
can only be used if vehicles are
not phased.

Output Area

Q115 OA Vehicles Not
Satisfied — Dwellings

128 OA PS Names
Vehicles Exclude OB

Lists the output areas with all
scenario names (excluding other
buildings) where the dwelling
planning scenarios are not
satisfied for vehicles

Output Area

Q116 OA Vehicles Not
Satisfied — For Major
Incidents

128 OA PS Names
Vehicles Exclude OB

Lists the output areas with
scenario names (excluding other
buildings) where the major
incident planning scenarios are
not satisfied for vehicles.

Output Area

Q118 OA Vehicles Not
Satisfied — Special Services

128 OA PS Names
Vehicles Exclude OB

Lists the output areas with
scenario names (excluding other
buildings) where the special
services planning scenarios are
not satisfied for vehicles.
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Feature Criteria Name Layout Name Description
Output Area Q117 OA Vehicles Not L129 OA PS Names for | Lists the output areas with other
Satisfied — Other Buildings OB building scenario names where

the other building planning
scenarios are not satisfied for
vehicles.

Other Buildings Q122 Risk Area Missing PS — | L124 OB PS Names for | Lists any risk areas where the risk
Risk Area OBs RA area contains types of other
building but does not have a
corresponding planning scenario,
i.e. has care homes but not care
home scenarios.

5.7 Dwellings

5.7.1 Review discussions

The following questions should be explored with the F&RS:

e What approach has been taken to check the location of the dwelling
casualty incidents?

B TQ150.xls
®m Overlay Section 5.7.2
B TQ160
B TQ162
m TQ163
e Have extra year’s data been added?
B RAD.xls — row 11 and row 15
B TQ150.xls
e How were dwelling risk areas generated?
m TQ165 — identifies output areas not in dwelling risk areas
m Overlay Sections 5.7.3, 5.7.4
e How were dwelling risk groups generated?
B TQ166 — identifies dwelling risk areas not in dwelling risk groups
® Overlay Section 5.7.5
e How has dwelling risk group robustness been achieved?
m TQ167 — lists robustness and whether values have been overridden

e Have the community fire safety fields been completed?

m TQ170
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The following queries may yield more detailed questions:

o TQI150, TQ152 ratios

e TQI150 location check (code > 250 expected to be checked if involves casualties)
e TQI153 population multipliers

e TQ164 population count

5.7.2 Overlay: Location status of incidents

Spot checks on the incidents location checks can be done using a separate overlay
for each incident type.

FSEC Overlay
e Overlay»Incidents»Incident Location Check

Enter the ROITYPE number for the incidents to be checked. ROITYPES for dwellings
are 1 to 5, particularly need to check ROITYPE 1

This overlay shows the following:

e Red cross Incidents not checked

e Blue circles Incidents checked.

The following additional queries can be used to investigate anomalies in the dwelling
incident data.

Feature Criteria Name Layout Name Description
Incident Q151 Incidents Not Checked |L150 Incidents — With Lists all incidents that have not
IPCL Reason been checked (i.e. ipclcheck <2)
Incident Q161 Incidents Not Checked |L150 Incidents — With Lists incidents with casualties for
Casualties IPCL Reason a specified ROITYPE that have

not been checked. Use
ROITYPES 1 to 5.

Incident Q168 All Incidents Checked | L150 Incidents — With Lists all incidents that have been
But not moved IPCL Reason checked but not yet moved.
These incidents have still to be
correctly located.
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5.7.3. Overlay: Risk areas and groups- implementation of
potential risk factor (PRF) in creating dwelling risk
areas

FSEC advises that adjacent output areas are made into dwelling risk areas by
identifying output areas that have common levels of (for example) lone pensioners.
Where an F&RS has adopted this approach, it can be checked using the FSEC overlay:

e Overlay»Dwelling Risk»Create Areas and Groups»Create Dwelling Risk Areas

Having created risk areas, the next objective is to group together those risk areas that
have similar rates of incidents. This is achieved in two steps. First those with similar
risk factors and are judged to have similar rates of incidents can be made into an
initial set of (smaller) risk groups, perhaps each with fewer than 100,000 people.
FSEC then presents the calculated casualty rate for these initial risk groups. The
calculated rate may then be used to guide the merger of the initial set of risk groups
into fewer but larger (of 100,000 or more people) risk groups. During this process,
the analyst is meant to check the robustness of the risk group, as reported by FSEC,
and attempt to merge risk areas and groups (with similar rates of incidents) until they
are robust.

This process can be checked by discussion with the analyst and checking of any
earlier datasets that show the initial risk groups. The following points may need to be
explored:

Are the risk groups robust?

e Are the final risk groups a reasonable size, such as at least 100,000 people or are
they small (such as under 50,000 people)?

If this approach has been adopted no further scrutiny is needed.

Some F&RS may, legitimately, create risk areas using other socio-demographic
indicators, such as deprivation data. In these cases it is necessary to enquire:

e Has a defined and logical process been adopted?

e Did the process aim to create areas and risk groups of homogenous risk (similar
rates of incidents)?

If areas with significantly different rates of incidents have been merged, this has the
effect of ‘averaging’ the rate of incidents between a high and low risk area, and is
therefore considered inappropriate.
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5.7.4 Overlay: Risk areas — missing output areas and planning scenarios

Where the work in Stage 4 shows that there are output areas missing from risk areas
the following overlay will show which output areas are missing. This overlay also
shows which output areas do not have a planning scenario defined.

Review Overlay

e Turn off background map

e Select map scale 1:50,000

e Overlay»Define 0165_DPS_OA

e Hide the black boundary for output areas

This overlay shows the following:

e Green hash All output areas.

e Black boundary Each output area

e Orange wash Each dwelling risk area labelled with the planning
scenario.

e Red wash Each dwelling risk area without a planning scenario.

Check on those areas that are red. These require a planning scenario.

Alternatively use the FSEC Overlay
e Overlay»Create Area and Groups»Output Area to Dwelling Risk Area Check

5.7.5 Overlay: Risk groups — missing dwelling risk areas & planning
scenarios

Where the work in Stage 4 shows that not all risk areas belong to a risk group the
following overlay will show which are missing. This overlay also shows whether the
dwelling risk areas have a planning scenario

Review Overlay

e Turn off background map

e Select map scale 1:50,000

e Overlay_Define 0166_DRG_DRA
e Hide the DRA label
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This overlay shows the following:

e Green hash All output areas.

e Orange wash Each dwelling risk area labelled with the planning
scenario.

e Blue boundary Each dwelling risk group with a dwelling risk area.

e Red boundary Each dwelling risk group without a dwelling risk area.

Check for any red boundaries, as these must be associated to dwelling risk areas.

Alternatively use the FSEC Overlay

e Turn off background map
e Select map scale 1:50,000

e Overlay_Dwellings_Create Area and Groups_Dwelling Risk Area to Dwelling Risk
Group Check

The following additional queries can be used to investigate anomalies in the dwelling
risk groups.

Feature Criteria Name Layout Name Description
Dwelling Risk Group | Q167 DRG Not Robust L167 Dwelling Risks Lists dwelling risk groups that are
Groups not robust.
Dwelling Risk Group | Q169 Risk Group Missing PS | L167 Dwelling Risks Lists dwelling risk groups that do
— Dwellings Groups not have a dwelling planning
scenario.

5.8 Special Services

5.8.1 Review discussions
The following areas may be explored with the F&RS:

e Has the F&RS added additional data or taken steps to improve the data
present?

e What approach has the F&RS taken to checking/ correcting incident
location?

®m Overlay Section 5.8.2

e What approach was taken to identify incidents as ‘life risk’ incidents?
m TQ202

e What approach has been taken for the creation of risk groups and
risk areas?

m Overlay Sections 5.8.3, 5.8.4, 5.8.8



Stage 5 — Reviewer visit to F&RS for philosophy checks and follow up to Stage 4

e Has the linear feature been used for RTAs?

B Section 5.8.5

e How have City, Town or Village risk areas and background risk areas been
created?

m Section 5.8.65.8.7
The following queries may yield more detailed information for discussion:

e TQ202 — anomalous ratios may indicate skewed reporting practices and allows
quality of the incident data to be viewed (TQ200 & 206 may be used for further
investigation of the data, but not ratio comparison)

e TQ203 — shows output areas without special services risk areas

e TQ205 — Risk areas not in risk groups

5.8.2 Overlay: Incident location

Spot checks on the incidents location checks can be done using a separate overlay
for each incident type.

FSEC Overlay
e Overlay»Incidents»Incident Location Check

Enter the ROITYPE number for the incidents to be checked. ROITYPES for special
services are 0 to 14.

This overlay shows the following:

e Red cross Incidents not checked

e Blue circles Incidents checked.

The following additional queries can be used to investigate anomalies in the special
services incident data.

Feature Criteria Name Layout Name Description
Incident Q201 Incidents — Special L150 Incidents — With List all special service incidents
Services Not Checked IPCL Reason (ROITYPE 6 to 14) that have not
been checked.
Incident Q161 Incidents Not Checked |LL150 Incidents — With Lists incidents with casualties for
Casualties IPCL Reason a specified ROITYPE that have

not been checked. Use
ROITYPES 6 to 14.
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5.8.3 Overlay: Risk areas — missing output areas and check on
planning scenarios

This overlay can be used to check for output areas omitted from risk areas, and for
checking the assignment of special service planning scenarios to risk areas.

Review Overlay

e Turn off background map

e Select map scale 1:50,000

e Overlay»Define 0206_SSRA_PS_OA

e Hide the black boundary for output areas

This overlay shows the following:

e Green hash All output areas.

e Black boundary Each output area

e Orange wash Each risk area labelled with the planning scenario.
e Red wash Each risk area without a planning scenario.

Check on those areas that are red. These require a planning scenario.

Alternatively use the FSEC Overlay
e Overlay»Special Services_Create Area and Groups»Road Traffic Accidents

e Overlay»Special Services_Create Area and Groups»Lift Rescue

e Overlay»Special Services_Create Area and Groups»Lockouts/lockins

e Overlay»Special Services_Create Area and Groups»Hazardous Materials
e Overlay»Special Services_Create Area and Groups»Line Rescue

e Overlay»Special Services_Create Area and Groups»Rescues from height
e Overlay»Special Services_Create Area and Groups» Water rescues

e Overlay»Special Services_Create Area and Groups»Other special services call
risk areas

The following additional queries can be used to investigate anomalies in the special
services incident data.

Feature Criteria Name Layout Name Description

Special Services Q207 Risk Area Missing PS — | L150 Incidents — With Lists special services risk area

Risk Area SS IPCL Reason that do not have a planning
scenario

Special Services Q208 SSRG Missing PS L150 Incidents — With Lists special services risk groups

Risk Group IPCL Reason which do not have a planning
scenario
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5.8.4. General process check

Special service risk areas and groups are meant to be demarcated in such a way that
areas of homogenous risk are created. It is necessary to first identify areas (risk areas)
where the risk is different to the next area, and to then group risk areas into groups
that have common or similar rates of incidents. The following guidance is noted for
using in scrutinising the process applied by F&RS.

Risk areas and groups may be created, for each type of special service incident in
turn, by:

e Creating an overlay plotting incidents, in order to discern how incidents are
distributed and how they are related to features such as road, natural features
(e.g. rivers) and areas of population

e Identifying areas by scrutiny of the overlay (to be merged) with either common
levels of incidents, or common potential for incidents, and

e Identifying areas that need common type of response, e.g. motorways needing
larger response than A road RTAs.

Taking some examples:

e All A roads in a F&RS may be made into areas and grouped on the basis they
have a common rate of incidents along them

® A city tourist attraction with a history of line rescues (where visitors become
trapped on slopes etc) may made into a risk area separate from the rest of the city

e A natural feature, such as a reservoir or rock climbing area, may be made into a
risk area separate from surrounding countryside.

Where, for example, it is judged that extrications follow populated areas, it may be
reasonable to make all populated areas (i.e. towns) into a single risk group, after
having made each town into a risk area, even if some towns lack any incidents. This
could be judged as reasonable where the features in each town area similar and hence
the potential for incidents is the same. It should be noted that with most categories of
incidents, there will be few (if any) actual incidents in any one town or village.

Some further guidance is laid out below on specific issues to be checked.

5.8.5 Linear features

Where incidents occur along a linear feature, the linear feature facility should be
used, and the risk area should therefore follow the linear feature. This serves the
purpose of prompting FSEC to calculate the rate of incidents as a rate per linear
kilometre rather than as a rate per square kilometre. This is likely to be important in
the following types of situations:

e Where road traffic accidents occur along a road, such as an A road, in rural or
suburban areas
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e Where other types of incidents are related to and hence follow other types of
linear features, such as water rescues occurring along a river, or HAZCHEM
incidents occurring along a chemical tanker transport route.

The linear feature is less likely to be applicable where incidents occur on a more
scattered basis across an area, such as RTAs occurring across urban areas.

5.8.6 City, town and village risk areas

In the case of extrications, other special services, lock-ins, lift release, HAZCHEM,
RTAs (not those on arterial routes) and ladder rescues, it is common that they are
concentrated in populated areas such as cities, towns and villages. Therefore, it is
typical that an F&RS may create risk areas around populated areas. In these cases it is
important to check:

e Has FSEC ‘extended’ the risk area into the countryside by catching an out of town
output area?

e I[s the distribution of incidents within a (for example) urban risk areas even, or
should a city be split into inner and outer risk areas, for example?

e If towns have been made into a ‘towns’ risk group, is the rate of incidents the
same in each town or do the towns differ in terms of either the rate of incidents
or (say) one is more industrial than others?

5.8.7 Background risk areas

The countryside is commonly made into a background risk area. Care must be taken
in whether a single background risk area is enough, or whether the number of
incidents varies between one part of the countryside and another. For example:

e Does (say) the eastern countryside of an F&RS have more (say) extrications due
to a higher level of agricultural activity than the western side that has (say) heath
land? If so the two areas should be split.

In order to test the demarcation of risk areas, it is useful to (1) display the risk areas
and (2) show the incidents on the same overlay, whilst also enquiring after the logic
applied by the F&RS when creating the risk areas.

Review Overlay

e Turn off background map
e Select map scale 1:50,000
e Overlay»Define 0204_RA_SS6to14

e Hide the black boundary for output areas
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This overlay shows the following:

e Colour coded Each risk area from dark red (very high) to pale green
(very low)

e Blue boundary Each output area

e Red cross Each incident of the selected type

This overlay prompts for risk type, which is 6 to 14 (see Table 23).

5.8.8 Overlay: Risk groups — missing risk areas

Review Overlay

e Turn off background map
e Select map scale 1:50,000
e Overlay»Define 0O207_SSRG_MissingSSRA

This overlay shows the following:

e Colour coded Each risk area from dark red (very high) to pale green
(very low)

e Blue boundary Each output area

e Black cross Each risk group without a risk area

5.9 Other Buildings

5.9.1 Review discussions
The following should form the basis of the discussions:
e What is the F&RS approach to other building site assessments?
B Guidance Section 5.9.2, 5.9.5
B TQ254 — notes where default fire safety features have been changed

B TQ255, TQ256, TQ257, TQ258, TQ259, TQ275, TQ276 & TQ277

e What approach has been taken to checking and editing occupancy levels?
m TQ255
m TQ257

e Have site visits been undertaken and used to update FSEC?
m TQ256
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How have HMOs and purpose built flats been added to the model? How
was the data obtained?

® Guidance Section 5.9.3
m TQ250
B TQ273 — checks for the number of storeys for HMOs and purpose built flats

How has data reconciliation been achieved (i.e. augmenting Valuation
Office data, particularly for care homes and hospitals)?

B Guidance Section 5.9.4

m TQ250

How have building positions been checked?
m TQ251
B TQ252

Have ‘other risks’ been defined — i.e. heritage, environmental, fire fighter,
sole supplier or exceptional value been identified?

m TQ274

How have risk areas and risk groups been created?
m TQ260

B TQ261

m Guidance Section 5.9.6

®m Overlays Section 5.9.7, 5.9.8

How were planning scenarios matched to each other building and have
they been varied by the time of day?

m TQ119

What approach was taken in the creation of TGOBRAs?
m TQ2063
m Guidance Section 5.9.6

® Overlay Section 5.9.9

The following sections provide further guidance and additional queries and overlays
which may be useful to highlight areas for discussion:

5.9.2 Overlay: Missing site assessments

Spot checks can be made on Site Assessments that are missing details using the
following review overlay.

Overlay»Define 0253_MissingOBSiteAssessmentDetails
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This overlay shows the following:

e Black boundary Each building

Big red cross Buildings with no floor area, site assessment, address
point or no valuation data.

e Big red circle Building with no address point
e Big blue circle Other building outline

e Yellow cross Address points

e Green Cross Other building site assessments
e Black cross Valuation Data

Check on those areas that have a red cross.

The following additional queries can be used to investigate anomalies in the other
building site assessment data.

Feature Criteria Name Layout Name Description

Other Building Site | Q258 — OB More than 20 L255 OB Site Lists all assessments where there

Assessments People at all times Assessment People are less than 20 people in all
period. (Building types
B,FE,C,D,G)

Other Building Site | Q259 — OB At least 20 L255 OB Site Lists all assessments where there

Assessments People in one time Assessment People are more than 20 people in any
period. (Building types A,M,J,L)

5.9.3 Adding in HMOs and purpose built flats

As HMOs with three or more storeys account for a large, if not the majority, of societal
risk it is important that they are added into FSEC. Tenements are counted as HMOs.

There is no single ‘best’ way as yet defined for how to identify HMOs of three or
more storeys or purpose built flats of four or more storeys. The F&RS should be
asked how they approached this task and to justify their method and evidence base.
Some reasonable sources of information include:

e Local authority records of licensed HMOs

e Site visits, touring areas to spot purpose built flats and houses (of three or more
storeys) converted into flats

e GIS of multiple address points in areas of housing identified by tours as being
three or more storeys

The following are not HMOs of three or more storeys:

e 3+ storey buildings with multiple occupancies, such as shops with a flat above it —
unless the upper floors have more than one flat and the building used to be a
house, or the upper floors comprises bed sits
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e Buildings purpose made for multiple flats (except Scottish tenements)
It is considered unsafe to identify HMOs or tenements by simply:
e Applying a ‘year of build’ criteria

e Spotting multiple address points on a building without first checking the number
of storeys and if they are purpose built flats

5.9.4 Philosophy checks of data reconciliation

The Valuation Office data is known to have omissions and errors in the categorisation
of buildings. The Valuation Office do not list care homes, which are a key occupancy.
The F&RS should review this data comparing with other sources of data that buildings
are correctly identified in FSEC. It is advised that this process of reconciliation is
prioritised with the highest priority awarded the higher risk occupancies (hospitals,
care homes, hotels and hostels) and other very large buildings.

The reconciliation can use the F&RS fire safety files as a main input, to both spot
omissions and to reconcile the building occupancies. Otherwise, miscellaneous
sources may be used including local knowledge and Scottish care home commission
data.

The F&RS should be asked how they have approached this task and to justify the
information sources.

The F&RS may have opted to delete the Valuation Office data entirely and, typically,
rely on fire safety files. In this case it should be checked how the F&RS is:

e Ensuring the property risk assessment to which non-certificated buildings
contribute is being achieved

e Ensuring that non-certificated buildings that contribute to societal risk, especially
hospitals, are included

5.9.5 Amending site assessments

It is advised that:

e The site assessments are amended progressively over a number of years

e [t is not necessary to amend all site assessments before FSEC is run

e The occupancy level (MPL) for those types of other buildings with a default of
<20 (shops, offices, factories, other buildings open to the public) are amended as

a first priority based on fire safety files (i.e. noting those that have a fire
certificate)
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Other than amending MPL for certificated buildings it is advised that further site
assessment work is:

e Prioritised for very large buildings, the higher risk occupancies (hospitals, care
homes, HMOs, hotels and hostels), and/or areas of high risk

e Based on information from fire safety files for certificated buildings and by use of
‘generic’ risk assessments for HMOs and purpose built flats

e Further prioritised to identifying both large and very large buildings which have
sprinklers

In addition, it is reasonable to use the ‘elastic’ feature to increase the number of
storeys from the default of 1, as follows:

e Increase HMO storeys to 3
e Increase purpose built flats storeys to 4

e Increase hospitals, care homes, hotels, hostels, further education, schools and
other sleeping accommodation storeys to 2

e Increase offices and other building open to the public storeys to 2

F&RS may judge it is necessary to visit buildings to achieve a more up to date
assessment. However, FSEC has been designed such that site assessments can be
completed using information in fire safety files. As HMOs, purpose built flats and
hospitals may not be certificated, these may necessitate site visits.

Where a generic site assessment is applied, it is pertinent to check the following:

e Has a single generic assessment, such as rating all HMOs as higher risk, been
applied where in fact the standard of fire safety varies from good to poor? In this
case, it would be more appropriate to make a proportion of HMOs high risk and
a proportion low risk based on the results of a sample of site assessments.

5.9.6 Creating risk areas, groups and TGOBRAs

The objective for the F&RS is to:

e First demarcate areas with a similar profile and mix of other buildings, such as
demarcating business parks, industrial estates, multi-storey retail areas, areas of
high rise flats, areas of 3+ storey HMOs/ tenements

e Make individual large buildings, especially high risk types such as hospitals, into
risk areas of their own

e Group risk areas (non-adjacent) that have similar risk profile, such as grouping
two non-adjacent business parks, into risk groups

The FSEC user may choose to apply a generic site assessment to all instances of a

type of other building within a risk group. For example, all inner city ‘HMO groups’
may be assigned five storey, whilst outer city ‘HMO groups’ have a three storey value.
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These two steps will ‘sum’ the risk in each risk group and read it back down to each
output area. Next TGOBRAs are created by a semi-manual process. The objective is to
minimise the gaps between TGOBRAs and ensure the majority of ‘high’ and ‘very
high’ risk areas are covered by TGOBRAs. The TGOBRAs provide a measure of the
risk of death that is used in judging the tolerability of the risk and hence the
adequacy of the F&RS resourcing.

The following additional queries can be used to investigate anomalies in the other

building data.

Feature

OA OBRA Results

Criteria Name

Q272 OA Missing TGOBRA

Layout Name

L263 TGOBRA Missing
H/VH Risk

Description

Lists all output areas that don't
have a TGOBRA defined.

5.9.7 Overlay: Missing output areas

FSEC Overlay

e Turn off background map

e Overlay_Other Buildings_Create Areas

This overlay shows the following:

e Red crosses

Other building site assessments

e Blue boundary Each output area

e Grey hatch Building footprints

e Black grid Other building risk area

e Yellow wash Other building risk group

The following additional queries can be used to investigate anomalies in the other
building data.

Feature Criteria Name Layout Name Description
Output Area Q270 Output Areas — PS for | L117 OA PS Vehicles OB | Lists all output areas that don’t
OBs have any other building planning
scenarios.
Output Area Q270 Output Areas — PS for | L129 OA — PS Names for | As above but layout shows
OBs OB planning scenario names instead
of numbers.
Output Area Q271 Output Areas — PS for | L117 OA PS Vehicles OB | Lists all output areas that don’t
OBs have any other building planning
scenarios but should have. (i.e.
have a number of care homes
but not care home planning
scenarios)
Output Area Q271 Output Areas — PS for | L129 OA — PS Names for | As above but layout shows
OBs OB planning scenario names instead
of numbers.
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5.9.8 Overlay: Missing risk areas
FSEC Overlay

e Turn off background map

e Overlay_Other Buildings_Create Groups

This overlay shows the following:

e Black hatch Other building risk area

e Yellow wash Other building risk group

Has a single generic assessment, such as rating all HMOs as higher risk, been applied
where in fact the standard of fire safety varies from good to poor? In this case, it
would be more appropriate to make a proportion of HMOs high risk and a
proportion low risk based on the results of a sample of site assessments.

5.9.9 Overlay to spot gaps in TGOBRAs
FSEC Overlay to view TGOBRAs:

e Overlay»Other Buildings» Other Buildings Output Overlay»TGOBRA Societal
Risk Fires»TGOBRA Societal Risk Fire Rate for 24 Hours

e Overlay»Other Buildings» Other Buildings Output Overlay»TGOBRA Fatality
Rates»TGOBRA Fatality Rate for 24 Hours

Additional overlays are available showing the Societal and Fatality rates for each of
the individual time slots, rather than a summary for the 24 Hours.

This overlay shows the following:

e Red wash Very high or Well above average
e Orange wash High or Above average

e Yellow wash Medium or Average

e Turquoise wash Low or Below average

e Pale Green wash Very Low or Well below average

TGOBRAs will tend to have gaps between them. Whilst this is reasonable, it should
be checked whether areas that are likely to have significant levels of societal or
property risk have been poorly mapped, such as omitting large parts of city centres or
industrial parks.

107



FSEC Toolkit Review Manual

108

5.9.10 Check on other building planning scenarios
A pivot table (TQ119.xls) can be used to check which planning scenarios have been

assigned to each type of other building in each time period. It should be noted that:

e The planning scenario may change between day and night, such as if the building
is unoccupied at night

e The planning scenarios may differ between types of occupancies.

The F&RS should be asked how they decided on how to match planning scenarios to
each occupancy and if/how they varied them by time of day.

5.10 Major Incidents

5.10.1 Review discussions

The following issues could be raised:

e How were risk areas for each type of major incident defined?

® See guidance in Section 5.10.2

e How were the risk levels for these areas allocated?
m See guidance in Section 5.10.3

m TQ302

5.10.2 Creation of risk areas

The FSEC manual provides guidelines on how to rate the risk of major incidents in an
area. There are two main checks:

e Has an important feature/risk been overlooked?
e Has a risk area been assigned an appropriate risk category?

Where a major incident risk area has been created and assigned a risk category, the
area can be selected (using the overlay) and the F&RS asked to cite the evidence
used to assign its risk category. Their evidence can be compared with the risk
categorisation guidance in the FSEC manual. Clearly each risk area should have a
planning scenario that matches the nature of the risk, such as boats for flood rescues,
and heavy lifting units for railway incidents.

Also, where an area has been created, the precision/coarseness of its boundaries can
be checked. Point features such as airports and chemical plants can be precisely
mapped, linear features such as motorways can be traced, whilst more diffuse features
such as the London Underground may be mapped by ‘circling’ the parts of London
with underground routes rather than tracing each line.
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Otherwise, it is useful to select an area and scrutinise it for features that commonly
present major incidents risk, including:
e Any main line (intercity) railway terminals or intercity through routes?
e Any motorways?
e Any regional or international airports?
e Any petro-chemical plants, refineries or gas terminals?
e Any underground railway systems?

e Any major rivers or estuaries (prone to flooding) adjacent to low-rise housing or
caravans?

e Any capitals or major cities that may be a terrorist target, especially those with key
political sites such as parliaments and assemblies?

e Any ports or inshore shipping channels frequented by passenger ferries?

It would be pertinent to check if there has been correspondence with the
Environment Agency regarding flood zones.

The following overlays can be used to display the risk areas and hence facilitate
spot checks.

FSEC Overlay
e Overlay»Major Incidents»38 Major Incident Risk Areas (All categories)

This overlay shows the following:

e Light purple Major vehicle risk area

e Deep orange Railway risk area

e Light steel blue Aircraft risk area

e Green Shipping risk area

e Mustard Yellow Hazardous materials risk area
e Brown Bombing risk area

e Light brown Flooding risk area

Alternatively use the following FSEC Overlay to view individual major incidents.

e Overlay_Major Incidents_Major Incident Risk levels (Individual Categories)_Major
Vehicle Risk Level

e Overlay»Major Incidents»Major Incident Risk levels (Individual
Categories)»Railway Risk Level
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e Overlay»Major Incidents»Major Incident Risk levels (Individual
Categories)» Aircraft Risk Level

e Overlay»Major Incidents®»Major Incident Risk levels (Individual
Categories)» Shipping Risk Level

e Overlay»Major Incidents®»Major Incident Risk levels (Individual
Categories)»Hazardous Material Risk Level

e Overlay»Major Incidents»Major Incident Risk levels (Individual
Categories)»Bombing Risk Level

e Overlay»Major Incidents»Major Incident Risk levels (Individual
Categories)»Flooding Risk Level

This overlay shows the following:

e Orange High special services Risk Area
e Yellow Medium special services Risk Area
e Pale blue Special services Risk Area

5.10.3 Major incident planning scenarios and risk areas

This overlay can be used to check for output areas omitted from risk areas, and for
checking the assignment of major incident planning scenarios to risk areas.

Review Overlay

e Turn off background map

e Select map scale 1:50,000

e Overlay»Define 0306_MIRA_PS_OA

e Hide the black boundary for output areas

This overlay shows the following:

e Green hash All output areas.

e Black boundary Each output area

e Orange wash Each risk area labelled with the planning scenario.
e Red wash Each risk area without a planning scenario.

The overlay will prompt for the major incident type.

Check on those areas that are red. These require a planning scenario.
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The following additional queries can be used to check on anomalies with major

incident data.

Feature Criteria Name Layout Name Description
Output Area Q301 OAs Without MIRA Output Areas Lists all output areas that don’t
have a major incident risk area.
Output Area Q304 OA Vehicle No L110 OA PS Vehicles MI | Lists all output areas where the
Satisfied — For Major planning scenario is not satisfied
Incidents for vehicles.
Output Area Q304 OA Vehicle No L127 OA PS Vehicles As above but lists all non other
Satisfied — For Major Exclude OB building scenario numbers.
Incidents
Output Area Q304 OA Vehicle No 128 OA PS Names As above but lists all non other
Satisfied — For Major Vehicles Exclude OB building scenario names
Incidents
Output Area Q305 OA Vehicle No L110 OA PS Vehicles MI | Lists all output areas where the
Satisfied — For Major planning scenario is not satisfied
Incidents — PS Defined for vehicles where output area
has a defined major incident
scenario.
Output Area Q305 OA Vehicle No L127 OA PS Vehicles As above but lists all non other
Satisfied — For Major Exclude OB building scenario numbers.
Incidents — PS Defined
Output Area Q305 OA Vehicle No L128 OA PS Names As above but lists all non other
Satisfied — For Major Vehicles Exclude OB building scenario names
Incidents — PS Defined
Incident Q161 Incidents Not Checked |L150 Incidents — With Lists incidents with casualties for
Casualties IPCL Reason a specified ROITYPE that have
not been checked. Use ROITYPE
18.

5.11 FSEC Outputs

5.11.1 Review discussions

The following should form the basis of the discussion:

e How does the predicted number of dwelling deaths in FSEC compare with
the actual (reported) values?

m TQ152.xls

e How does the predicted number of special services deaths in FSEC
compare with the actual (reported) values?

m TQ200.xls

e How does the predicted societal risk deaths compare to that estimated
using Section 4.9.3?

e How does the predicted property loss compare to that estimated using
Section 4.9.3?
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Where there are significant differences then the reviewer should look for reasons, for
example:

e Reviewing the results of the text queries run in the previous stages of the
process or

e Exploring other explanations for the divergence of results with the F&RS.
It should be noted that for F&RSs where the actual annual casualty figures are low

(say below 5) then a larger percentage difference in predicted versus actual fatalities
may be acceptable.



Stage 6 — Rating of Modules

6.1 Guidance

The results of the review can be summarised using the scheme below.

Module Grading Key points

Road network

Stations, crews, costs and vehicles

Dwellings

Special services

Other buildings

Major incidents

Grading Meaning

A Module has been completed with no further analysis or data cleansing needed
B Module results are adequate with minor revisions needed

C Module results have significant issues to be resolved

D Data cleansing in progress/incomplete or needs revision

N/A Module yet to be commenced
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Appendix A - Loading data, running text queries,
exports and overlays

This section of the document contains general instructions regarding functions of the
WINGS system. It includes instructions for the following:

e Loading datasets sent by candidate review F&RSs
e Using text queries, i.e. running and saving text queries
e Export data

e Running overlays

A7.1 Loading the FSEC Datasets

The following instructions should be used to create a version of Wings that can be

run for a different F&RS, in order to have multiple F&RS data on the machine.

1. Make a copy one of the brigade directories within the FSEC folder, e.g.
C:\FSEC\ AuditBrigade

2. Rename the directory to reflect the F&RS e.g.
C:\FSEC\ Lothian
3. Delete the existing contents and then copy the supplied F&RS ‘tables’ into the
new F&RS tables directory e.g. into
C:\FSEC\Lothian\tables
4. Delete the existing contents and then copy the supplied F&RS data set into the
new F&RS dataset directory as a new folder e.g.

C:\FSEC\ Lothian\ dataset\ master

5. Edit the dslist file (using notepad) in the dataset folder e.g.
C:\FSEC\ Lothian\dataset\dslist

6. This file lists the dataset names and the folder they reside in that are available
within wings. The dataset name appears before the ‘b’ character and can be
anything. The folder appears after the ‘b’ and must match exactly the name folder
name of the dataset sent from the F&RS e.g.

Lothian Datasetb\ Master
7. Save the file.

8. Go to the F&RS top level directory and edit the file (using notepad)
C:\FSEC\ Lothian\ PASSLOG.INI
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Change all references from ‘AuditBrigade’ to the F&RS folder name e.g. ‘Lothian’ e.g.
SCRIPTS=C:\FSEC\AUDITBRIGADE\LOGON

To
SCRIPTS=C:\FSEC\LOTHIAN\LOGON

Save the file

Repeat the above edit steps (8 to 10) for the following files:
C:\FSEC\ Lothian\ WINGSUP.INI
C:\FSEC\ Lothian\ WINGSuper.INI
C:\FSEC\Lothian\ WINGuser.INIT

Go to the F&RS logon folder i.e.
C:\FSEC\LOTHIAN\LOGON

Repeat steps 9 and 10 for the following files:
C:\FSEC\LOTHIAN\LOGON\GLOBALL.INI
C:\FSEC\LOTHIAN\LOGON\super.scp
C:\FSEC\LOTHIAN\LOGON\user.scp

Finally copy the desktop shortcut for the review F&RS and rename it to reflect the
new F&RS, e.g. Lothian

Click on the shortcut and choose the properties option from the menu. Amend
the target directory to be the new F&RS folder e.g.

C:\FSEC\wings32\wings.exe C:\FSEC\Lothian
Close the properties dialog and run the shortcut. The username and password are

the same as before. The dataset list should reflect that in the new F&RS. If it
doesn’t check that all the files have been amended correctly.

The contents of the ‘Export’ folder should be deleted from the newly created F&RS
data folders to avoid confusion between text query outputs from the old AuditBrigade
data and the new data.
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A7.2 Using Text Queries To Examine Results

Text queries are used to examine detailed results, which can be counted, listed or
reported to the screen. Listed or reported results can also be copied to the pasteboard
or saved to a file.

To run a text query:

e Select Action»Text Query from the main menu.

This will display the following screen, listing the FSEC features that can be queried.
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e Click on ‘+" alongside ‘FSEC features 1 to 499’ to expand selection
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e Select the required feature

e Click the OK button
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This will display the following screen showing the selected feature next to the
feature button.

Note Clicking the feature button displays the ‘Feature Type to Query’ screen, which
allows the feature to be changed.

A predefined ‘where’ clause can be used to extract a feature. This is done using the
select criteria specification.

e Select Criteria» Get from the menu.

A list of predefined ‘where’ conditions is displayed.
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e Select the required criteria specification

e Click on the Replace button.
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The Criteria name is then displayed on the Text Query screen.

To run the Criteria and retrieve a simple count of the number of items that would be
reported.

e Select Layout»Clear from the menu

e Click the Execute button

A predefined layout can be used to format the results of a query. This is done using
the layout specification.

e Ensure the ‘All’ option is selected

e Select Layout»Select Layout_Get from the menu.

Note The feature and selected for the text query determines what layouts are
available. If the required layout is not listed ensure that the correct option (Counts,
Reports, Listings or Tables) is included, and that the feature is correct.

e Tick the Listings check box
e Seclect the required Layout specification

e Click on the Get button.

The Layout name is then displayed in the Text Query screen.
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Executing the query will display the results in a window.
e C(lick on the Execute button

Note When doing Criteria to obtain a count, followed by a layout to view the
counted data, answer ‘Yes’ to use the active list as this reduces time required
producing the report.

The screen below displays the results of the query.

If the file is small enough it can be copied to the clipboard and pasted into MS-Excel.
Larger files must be copied to a file before they can be processed.
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To copy the output to a text file.
e Select Copy»Copy To File from menu.
The result of the query will be saved as a text file. Give an appropriate name

according to the data your examining; this will help you relate the correct file to the
data you wish to examine.
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e Enter a name in the ‘File name’ box, e.g. RADDwellings.txt.
e Select the ‘Save in’ drop down box to change the location of the saved file.

e Click on the Save button

A7.3 Exporting WINGS data

The following section details how to export data from WINGS. It uses the Risk
Assessment Definition data as an example.

A7.3.1 Exporting Risk Assessment Definition Data

The Risk Assessment Definition default data must be extracted from the FSEC system
for importing into an Excel file. This is accomplished using the FSEC system to create
that import file. The FSEC systems export will create a file with a 3-letter

extension ‘imp’.

e Select Overlay»Risk Assessment Definition

e Select File»Export
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e Enter the name RAD.imp in the ‘File name’ box
e Click on the ‘Save in’ drop down box to change a location to save the file

e Click on the Save button

The file is now ready to import into Excel.

A7.4 Running Review Overlays

The review overlays are used to view/spot check issues raised by the review text
queries run as part of Stage 3, and the reviewers findings in Stage 4. As part of the
review installation program a number of predefined overlays have been added to the
WINGS system. These overlays can be found in the folder
‘C:\FCM\OVERLAYS\AUDIT".

e TFrom within WINGS

e Select Overlay»Define from the main menu

e Browse to the folder ‘C:\FCM\OVERLAYS\AUDIT’

e Seclect the required overlay file, e.g. O011_MissingRoad.ODF
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If required, some of the items can be excluded from the initial display. This is done
as follows:
e Scroll down the window until the required item is displayed
e Remove the tick from alongside the item or label
e Click on ok to run the overlay
Items can be added back into the overlay as follows:
e Select Overlay»Query from the main menu
e Add the tick back to the item or label

e C(lick on ok to run the overlay
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B8.1 Importing Text Query Results into MS-Excel

To import the query results files into MS-Excel

Launch Excel

Select File»Open from the main menu

e Select Text Files from the ‘Files of type’ drop down list

Select the file you wish to import

Click on the Open button
This opens the MS-Excel import wizard and displays the following screen.
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e Ensure the ‘Delimited’ option is selected

e Click on the Next button
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The following screen is displayed:
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This screen is used to specify the delimiter that separates the columns of text file
within the file. The delimiter for saved text query outputs (i.e. .txt files) is the Tab,
and the delimiter for WINGS Export files (i.e. .imp) is the Comma.

e Tick the required delimiter, e.g. Tab (for .txt files)

e Ensure that all other check boxes are clear

e Click on the Next button

The following screen is displayed:
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This screen is used to define the format of any columns. MS-Excel selects a default
format based on the contents of the columns. The format is displayed above each

column in the ‘Data Preview’ grid. In most cases the defaults can be accepted by
selecting the Finish button.

124



Appendix B — How to import files into MS-Excel and run the review macros

If the imported data does not look correct then the default format may need to be
changed. To do this repeat the import process and then change the column format
following the instructions below.

e Highlight the required column

e Choose the appropriate ‘column data format’

e Repeat for each column that should be changed

e Click on the ‘Finish’ button to complete the import

The following formats are suggested for some of the data.

Incident Number (INCNO) Text instead of General
Any date Date in DMY format instead of General.

B8.2 How to Load and Run MS-Excel Review Macros

To run an MS-Excel macro, you first need to open the spreadsheet within MS-Excel.
If the MS-Excel file is already open this step should be skipped.

Note The MS-Excel files are located in the ‘C:\FCM\ Audit’ folder.

e From within Ms-Excel

e Choose File»Open from the main menu

e Browse for the required macro file, e.g. ‘FSEC Get_ColumnData.xls’

You will be presented with a dialog box informing you that the Excel file contains
macros:

Macroscit emced 2%
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e Click on the ‘Enable Macros’ button

e Select Tools_Macro_Macros from the main menu
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e Ensure the ‘Macros in:" combo-box is set to ‘All Open Workbooks’
e Select the required macro from the list, e.g. ‘RetrieveColumnData’
e Click on the Run button

If required, save the spreadsheet with the specified file name.

e Select File»Save As from the main menu

e Save the Excel File with the specified name, e.g. RADDefaults.xls

B8.3 How to Run Specific Macros

B8.3.1 Table comparisons macro

This macro uses the following input files. If the macro spreadsheet is not already then
it should be opened following the instructions in the previous section of this
document (Section 8.2).

Input File MS-Excel File Macro Save Output

Brosdb. TXT Macros.xls UpdateTableComparisons PSResources.xls
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e Open the ‘Table_Comparison.xls’ Excel file
e Select Tools»Macro¥»Macros from the main menu
e Choose the ‘UpdateTableComparisons’ macro and click ‘Run’

e The macro will display a ‘Select’ dialog, shown below

e Using this dialog window, select the ‘brosdb’ text file and then click the ‘Open’
button.

Note The macro assumes that all of the scenario files (bps.tab, crewing.tab,
pspeed.tab, ranks.tab, risks.tab, vcost.tab and vtype.tab) are in the same location as
the ‘brosdb.txt’ file. It will only request the location for this file. If the files are in
different locations please move them all to the same folder before proceeding.

The macro will open this file and copy the required data to the Scenarios workbook.
It will then create any additional validation data in the Scenario workbook.

When the copy has finished, the imported file will be closed. At this stage you may
receive a dialog window asking you if you want to save the data currently on the
clipboard (see below)

e If this dialog does appear, then click the No button.
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Messages will be displayed during the process, to inform the user of the current stage
(as shown below):

The macro will then proceed to open the other scenario related files.

e DBPS.TAB

e CREWING.TAB
e PSPEED.TAB

e RANKS.TAB

e RISKS.TAB

e VCOST.TAB

e VTYPE.TAB

When the Macro has completed, you will be informed via a message box:

e C(lick on ok to acknowledge the message and then review the ‘Table
Comparison.xls’ file.

Note If an error occurs during any part of the process, the macro will inform you.
Click OK to accept the message.

The macro will then continue to completion. i.e. if an error occurs during the import
of the BPS.TAB file, the macro will continue and attempt to import any remaining files.

B8.3.2 Incidents

This macro is used to process the various incident data output files. If the macro
spreadsheet is not already then it should be opened following the instructions in the
previous section of this document (Section 8.2).
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Input File MS-Excel File Macro Save Output
TQ150_IncidentsDwellingsInjuries.txt | Macros.xls Updatelncidents | TQ150IncidentsDInjuries.xls
TQ152_IncidentsDwellings.txt Macros.xls Updatelncidents | TQ152IncidentsD.xIs
TQ162_DwellingFires Macros.xls Updatelncidents | TQ162IncidentsDFires.xls
TQ163_DwellingFiresNotChecked Macros.xls Updatelncidents | TQ163IncidentsDFiresNotChecked.xls
TQ200_IncidentsSS. txt Macros.xls Updatelncidents | TQ200IncidentsSS.xls
TQB00_IncidentsMI.txt Macros.xls Updatelncidents | TQB300IncidentsSS.xls

e Open the ‘Incidents.xls’ Excel file

e Select Tools»Macro»Macros from the main menu

e Choose the ‘Updatelncidents’ macro and click ‘Run’

e The macro will display a ‘Select’ dialog, shown below

Using this dialog window, select the required text file and then click the ‘Open’

button.

The macro will open this file, remove any unwanted data and then copy this data to
the Incidents spreadsheet. Once the data has been copied the Pivot Tables will be
updated. The macro will keep you informed throughout each process:
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When the Macro has completed, you will be informed via a message box:

e Click on ok to acknowledge the message and then review the ‘Incident.xls’
workbook.

Information about the Incident Workbook

The Incident workbook (Incident.xls) contains the following worksheets:-

Dwelling Summary

This sheet contains a table showing typical figures supplied from FSEC in relation to
dwelling incidents. The table is used to compare the FSEC values against the imported
F&RS incident data. The values are automatically calculated from the incident data,
but they can be cross-checked using the following table.

Value Required Location
Incident type 1 without ROF/ ROC/ ROF | All worksheet
Incident type 1 with 1+ ROF/ ROC/ ROF | All worksheet
Incident type 1 All worksheet

ROF Fatalities worksheet
ROC Casualties worksheet
ROR Rescues worksheet
Incident Type 2 All worksheet
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Special Services Summary

This sheet contains a table showing typical figures supplied from FSEC in relation to
special services incidents. The table is used to compare the FSEC values against the
imported F&RS incident data. The values are automatically calculated from the
incident data, but they can be cross-checked using the following table.

Value Required Location

Your ‘n Casualty’ Incidents This value can be found on either the
Casualties, Fatalities or Rescues worksheets

Your Fatalities Fatalities worksheet

Your Casualties Casualties worksheet

Your Rescues Rescues worksheet
All

Contains the pivot table which shows the number of special services fatalities,
casualties and rescues by incident types.

Cat A Special Services

Contains the pivot table that shows the number of special services by incident type

Fatalities

Contains the pivot table that shows the number of fatalities by incident type

Casualties

Contains the pivot table that shows the number of casualties by incident type

Rescues

Contains the pivot table that shows the number of rescues by incident type

Check Flag
Contains the pivot table that shows the number of ‘check flags’ by incident type

IncNo

Contains the pivot table that shows the number of incidents by date

Month and Year

Contains the pivot table that shows the number of incidents by month and year

Month and Year Chart

Contains a chart plotting the data in the month and year pivot table

Incident Data

Contains all the raw data used to generate the pivot tables
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B8.3.3 Other building assessments

This macro is used to process the various incident data output files. If the macro
spreadsheet is not already open then it should be opened following the instructions
in the previous section of this document (Section 8.2).

Input File MS-Excel File  Macro Save Output
TQ255_0OBSAPeople. TXT Macros.xls UpdateAssessments TQ255_0OBSAPeople.xls

e Open the ‘OB Assessments.xls’ Excel file
e Select Tools»Macro¥»Macros from the main menu
e Choose the ‘UpdateAssessments’ macro and click ‘Run’

The macro will display a ‘Select’ dialog, shown below:

Using this dialog window, select the required text file and then click the ‘Open’
button.

The macro will open this file, remove any unwanted data and then copy this data to
the Incidents spreadsheet.

When the copy has finished, the imported file will be closed. At this stage you may
receive a dialog window asking you if you want to save the data currently on the
clipboard (see below):

e If this dialog does appear, then click the ‘No’ button.

Once the data has been copied the pivot tables will be updated. The macro will keep
you informed throughout each process:
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When the Macro has completed, you will be informed via a message box:

e Click on ‘OK’ to acknowledge the message and then review the ‘OB Assessment’ file.

B8.4 Risk Area Planning Scenarios

This macro uses the following input files. If the macro spreadsheet is not already then
it should be opened following the instructions in the previous section of this
document (Section 8.2).

Input File MS-Excel File Macro Save Output
TQ127_OAPSNotBuilding. TXT | Macros.xls UpdateBuildingScenarios | TQ119_0OAPS_NotOB.xIs
TQ130_OAPS_Building. TXT Macros.xls UpdateBuildingScenarios | TQ117_OAPS_OB.xIs

e Open the required Excel file

Excel Filename Contents
Risk Area Planning Scenarios Not OB.xls Data excluding other buildings
Risk Area Planning Scenarios OB.xls Other buildings data only

e Select Tools»Macro»Macros from the main menu
e Choose the ‘UpdateBuildingScenarios’ macro and click ‘Run’

e The macro will display a ‘Select’ dialog, shown below:

Using this dialog window, select the required text file and then click the ‘Open’

button. 133
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The macro will then ask you to specify the type of data entered (see below):

Click the “Yes’ button if the data is associated with dwellings.

Click ‘No’ if the data is associated with other buildings.

If you are not sure what data is in the Import file, then click ‘Cancel’ to stop the macro.

The macro will open this file, remove any unwanted data and then copy this data to
the Incidents spreadsheet.

When the copy has finished, the imported file will be closed. At this stage you may
receive a dialog window asking you if you want to save the data currently on the
clipboard (see below):

e If this dialog does appear, then click the ‘No’ button.

Once the data has been copied the Pivot Tables will be updated. The macro will
keep you informed throughout each process:

When the Macro has completed, you will be informed via a message box:

e Click on ‘OK’ to acknowledge the message and then review the excel file.

134



Appendix C - Standard review worksheets

Table 17 presents the progress checklist which is sent to the F&RS for completion in

Stage 1.

An electronic copy of the checklist form can be opened by clicking on the icon below.

Wl

Progress Chechlst

Rewd
Table 17: Progress checklist
F&RS name: Complete one box per row
Date form completed: No In progress Yes/ Completed
o Completed | & Checked
(state %
by F&RS
complete)

Road networks, vehicles, crews and stations

Have you completed the road network?

Have all three stages of running the travel
time matrix been completed?

Have all crews & vehicles been created, and
costs added to stations?

Incident data

Have you entered extra years of incident
data?

Dwellings

Has the location of dwelling fire fatalities,
casualties and rescues been checked?

Have dwelling risk areas and groups been
made and linked?

Have dwelling planning scenarios been
defined & applied?

Special services

Has the location of special service fatalities,
casualties and rescues been checked?

Have risk areas and groups made for each of
the following:

RTAs

Extrications

Other Special Services
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Table 17: Progress checklist (continued)

F&RS name:

Complete one box per row

Date form completed:

No

In progress Yes/
(state % Completed
complete)

Completed
& Checked
by F&RS

Water rescues

Line rescues

Ladder rescues

HAZCHEM

Lift rescues

Lock in/outs

Have you defined special service planning
scenarios for all risk areas?

Other buildings

Has the location of other buildings been
checked?

Have HMOs and purpose built flats been
added into the other buildings data?

Have site assessments been modified for
HMQOs, hotels, hostels, care homes,
hospitals?

Have site assessments been modified for
large or very large other types of other
buildings (e.g. very large shops, offices etc)?

Have site assessments been modified for
other types/sizes of other buildings?

Have you created other building risk areas,
groups and TGOBRAs?

Have you defined other building planning
scenarios for all risk areas?

Major incidents

Have you created risk areas made for all
types of major incidents?

Have you defined planning scenarios for all
major incident risk areas?

FSEC updates

What is the FSEC Version number?

(click on FSEC Version Checker)
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Table 18 presents the progress checklist which is sent to the F&RS for completion in
Stage 1.

An electronic copy of the checklist form to be sent to the F&RS can be opened by
clicking on the icon below.

Wl

Preject Managernznk
Checlit Rew3

Table 18: Project Management checklist

F&RS name:
Date form completed:

Answer

Resourcing

How many full time equivalent staff are currently working
on FSEC?

Have all of the FSEC team been trained on FSEC?

If you have been trained on FSEC, who ran the training
(ODPM or other)?

Has the staffing of the FSEC team changed since the
F&RS started using it?

Project management

Do you have a project manager/FSEC manager?

If you have a project manager, what is their job title and
rank?

Do you have a project plan?

If you have a project plan, do you have completion
dates for tasks on your project plan?

If you have a project plan, are you on target?

Do you hold regular project management reviews?

Quality control

Do you have a coding system for maintaining version
control of your FSEC datasets?

How often do you back up and is there a back up
control process?

Do you have a procedure for ensuring the correct
dataset is used and not overwritten?

Prioritisation of FSEC work

Do you have a schedule of prioritised FSEC work?

Are your priorities consistent with guidance note 87 E.g.:

e Complete geocoding of dwelling and special
fatalities, casualties and rescues only (defer geo-
coding of all other incident data);

e Correct the location of high risk other buildings
only (Hs)

e Create other building risk areas and groups
before completing site assessments;

e Run FSEC with pre-loaded road network before
attempting to update road network
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Appendix D - Standard review worksheets

The following Excel spreadsheet has been created as part of the review manual
development and pilot review programme and may be useful for the reviewer to use
to record findings at each stage of the review process.

Rz weorkshert -

rev 4. Kl
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Appendix E: Reference data

The data in Table 19 were obtained from the ODPM website in July 2005.

Table 19: Number of of fire stations in England at 31 March 2004

Fire & rescue services Numl:_)er i Fire & rescue services Numl_)er 2
stations stations

Avon 23 Lincolnshire 38
Bedfordshire & Luton 14 London 112
Buckinghamshire 20 Merseyside 26
Cambridgeshire 28 Mid & West Wales 57
Cheshire 24 Norfolk 40
Cleveland 15 North Wales 44
Cornwall 31 North Yorkshire 38
County Durham & Darlington 15 Northamptonshire 22
Cumbria 38 Northumberland 19
Derbyshire 31 Nottinghamshire 25
Devon 58 Oxfordshire 24
Dorset 26 Royal Berkshire 20
East Sussex 24 Shropshire 23
Essex 51 Somerset 24
Gloucestershire 20 South Wales 50
Greater Manchester 41 South Yorkshire 24
Hampshire 52 Staffordshire 30
Hereford & Worcester 27 Suffolk 35
Hertfordshire 32 Surrey 24
Humberside 32 Tyne & Wear 19
Isle Of Wight 10 Warwickshire 19
Isles Of Scilly 6 West Midlands 41
Kent 66 West Sussex 28
Lancashire 39 West Yorkshire 49
Leicestershire 20 Wiltshire 25
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The data in Table 20 were obtained from the Census 2001 data presented on the
National Statistics website
(http://www.statistics.gov.uk/census2001/region_county.asp#region).

Table 20: Population Count English F&RS Areas 2001

All people resident in

All people resident in

F&RS Area households Con_1muna|
Establishments

Bedfordshire County 376679 4893 381,572
Buckinghamshire County 469848 9178 479,026
Cambridgeshire County 532707 19951 552,658
Cheshire County 664929 8859 673,788
Cornwall and the Isles of Scilly 492852 8415 501,267
Cumbria 478810 8797 487,607
Derbyshire County 725667 8918 734,585
Devon County 684482 20011 704,493
Dorset County 380125 10855 390,980
Durham County 481729 11741 493,470
East Sussex County 479550 12774 492,324
Essex County 1294077 16758 1,310,835
Gloucestershire 553900 10659 564,559
Hampshire County 1214514 25589 1,240,103
Hertfordshire 1018872 15105 1,033,977
Kent County 1302329 27389 1,329,718
Greater Manchester (Met County) 2444165 38163 2,482,328
Merseyside (Met County) 1337523 24503 1,362,026
South Yorkshire (Met County) 1248808 17530 1,266,338
Tyne and Wear (Met County) 1058855 17083 1,075,938
West Midlands (Met County) 2519721 35871 2,555,592
West Yorkshire (Met County) 2050135 29076 2,079,211
Lancashire County 1111554 23420 1,134,974
Leicestershire County 596120 13458 609,578
Lincolnshire 635026 11619 646,645
Norfolk 779700 17028 796,728
Northamptonshire 619987 9689 629,676
Northumberland 301959 5231 307,190
North Yorkshire County 552998 16662 569,660
Nottinghamshire County 738168 10342 748,510
Oxfordshire 581178 24310 605,488
Shropshire County 274747 8426 283,173
Somerset 485481 12612 498,093
Staffordshire County 793470 13274 806,744
Suffolk 656093 12460 668,553
Surrey 1032781 26234 1,059,015
Warwickshire 499596 6264 505,860
West Sussex 736880 16734 753,614
Wiltshire County 420315 12658 432,973
Worcestershire County 532823 9284 542,107
London 7078632 93459 7172091
Total 40,237,785 725,282 40,963,067
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The data in Table 21were obtained from the ODPM website
(http://www.odpm.gov.uk/stellent/groups/odpm_fire/documents/divisionhom
epage/039819.hcsp).

Table 21: Dwelling Deaths per Year

F&RS Area Deaths per Year

999 2000 2001 Average
Avon 8 4 6 6.0
Bedfordshire 1 5 3 3.0
Berkshire 2 5 4 3.7
Buckinghamshire 4 7 4 5.0
Cambridgeshire 3 3 2 2.7
Cheshire 9 6 7 7.3
Cleveland 4 1 5 3.3
Cornwall 2 4 5 3.7
Cumbria 3 3 5 3.7
Derbyshire 8 9 5 7.3
Devon 4 7 3 4.7
Dorset 8 1 7 5.3
Durham 9 6 5 6.7
East Sussex 5 3 3 3.7
Essex 5 10 8 7.7
Gloucestershire 1 2 1 1.3
Hampshire 8 9 7 8.0
Hereford & Worcs 2 3 2 2.3
Hertfordshire 4 6 6 5.3
Humberside 5 7 7 6.3
Isle of Wight 0 0 2 0.7
Kent 6 9 12 9.0
Lancashire 15 17 14 15.3
Leicestershire 3 4 5 4.0
Lincolnshire 3 4 4 3.7
Norfolk 5 8 5 6.0
North Yorkshire 5 2 3 3.3
Northamptonshire 4 3 2 3.0
Northumberland 2 1 6 3.0
Nottinghamshire 9 3 6 6.0
Oxfordshire 6 1 3 3.3
Shropshire 2 8 2 4.0
Somerset 1 1 5 2.3
Staffordshire 6 8 7 7.0
Suffolk 2 4 5 3.7
Surrey 3 6 2 3.7
Warwickshire 2 6 4 4.0
West Sussex 7 3 2 4.0
Wiltshire 1 0 4 1.7
Isles of Scilly 0 0 0 0.0
Greater Manchester 32 22 27 27.0
Merseyside 11 21 16 16.0
South Yorkshire 10 10 19 13.0
Tyne & Wear 5 5 6 5.3
West Midlands 21 26 23 23.3
West Yorkshire 21 22 12 18.3
Greater London 61 45 63 56.3
North Wales 3 3 7 4.3
Mid and West Wales 5 14 9 9.3
South Wales 10 8 7 8.3
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The data for Table 22 were obtained from the ODPM website and may be used as a
guide when checking the number of vehicles entered by the F&RS
(http://www.odpm.gov.uk/stellent/groups/odpm_fire/documents/page/odpm_
fire_035604.xls).

Table 22: F&RS Vehicles (March 2003)

Front-line Appliances Reserve Appliances

Front-line Front-line Front-line

pumping aerial special Reserve Reserve Reserve

appliances appliances appliances pumps EEETS specials
FCDAs and FEPA!
Greater Manchester 67 9 17 14 4 3
London 185 16 33 0 0 0
Merseyside 42 5 7 7 0 1
South Yorkshire 33 3 7 5 1 1
Tyne & Wear 33 3 6 7 0 1
West Midlands 62 8 5 13 2 3
West Yorkshire 65 7 7 14 2 1
TOTAL 487 51 82 60 9 10
ENGLAND
Avon 37 6 18 8 0 0
Bedfordshire & Luton 22 2 15 4 0 0
Buckinghamshire 31 2 7 2 0 0
Cambridgeshire 38 2 9 8 0 1
Cheshire 37 3 17 7 0 0
Cleveland 23 2 5 3 0 0
Cornwall 43 2 30 9 0 3
County Durham & Darlington 27 2 7 3 0 0
Cumbria 50 3 13 6 0 1
Derbyshire 44 3 10 6 0 0
Devon 81 5 20 11 0 1
Dorset 41 2 24 6 1 0
East Sussex 38 4 9 7 1 0
Essex 72 5 12 15 0 3
Gloucestershire 33 2 14 6 0 0
Hampshire 76 3 34 138 0 1
Hereford & Worcester 43 3 14 8 0 0
Hertfordshire 43 3 5 6 0 1
Humberside 50 6 6 9 0 0
Isle Of Wight 16 2 6 2 0 0
Isles Of Scilly 2 0 5 1 0 0
Kent 87 7 17 13 1 2
Lancashire 63 5 12 7 0 1
Leicestershire 33 2 12 6 0 0
Lincolnshire 48 3 8 4 0 0
Norfolk 52 3 10 8 0 0
North Yorkshire 45 3 18 5 1 0
Northamptonshire 28 2 6 5 0 0
Northumberland 24 0 0 3 0 0
Nottinghamshire 36 2 7 6 1 1
Oxfordshire 35 1 7 6 1 0
Royal Berkshire 24 2 5 6 0 1
Shropshire 33 2 11 4 0 3
Somerset 40 3 18 0 0 0
Staffordshire 48 4 13 11 0 0
Suffolk 47 2 12 4 0 0
Surrey 36 3 19 12 0 0
Warwickshire 26 1 6 5 0 1
West Sussex 46 2 28 10 0 1
Wiltshire 35 2 13 6 0 0
TOTAL 1,633 111 502 261 6 21
WALES
Mid & West Wales 72 4 33 12 0 0
North Wales 54 4 27 9 0 0
South Wales 64 5 49 19 1 1
TOTAL 190 13 109 40 1 1
GRAND TOTAL 2,310 175 693 361 16 32
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The data in Table 23 were obtained from the FSEC Manual, Volume 1 Appendix 1.

Table 23: Incident Types

Incident Type Description Incident Type Description

1 FDR1 Dwellings 13 Water rescues

2 FDR1 Other buildings 14 Other special services
FDR1 Other (properties

3 other than buildings) 15 False alarm malicious
including vehicles
FDR3 Secondary fires 16 False alarm good intent
FDR3 Chimney fires 17 False alarm equipment

6 \I?;Aizér;;)t including fires in 18 Maior incident
Extrications 19 Standby
Lift rescues 20 Over the border
Lockins/outs 21 Other with mobilisation

10 HAZCHEM 22 Other without mobilisation

11 Line rescues 23 Late call

12 Ladder releases
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Appendix F - Glossary

The following is a list of Acronyms and Abbreviations used within the Review Manual

Acronym Description

Cat A Any incident involving one or more fatalities, rescues or casualties.
CFO Chief Fire Officer

CFS Community Fire Safety

DCFO Deputy Chief Fire Officer

DRA Dwelling Risk Area

DRG Dwelling Risk Group

ET Emergency Tender

FF Fire Fighter

F&RS Fire and Rescue Service

FEU Fire Experimental Unit

FSEC Fire Service Emergency Cover (Toolkit)
GLA Greater London Authority

HMO House of Multiple Occupancy
Incident Type See Table 23 for definitions

IPCL Incident Position Confidence Level
ISU Incident Support Unit

LFF Leading Fire Fighter

MISU Major Incident Support Unit

MPL Maximum Potential Loss

OA Output Area

OB Other Building

OBRA Other Building Risk Area

ODPM Office of the Deputy Prime Minister
PDA Pre Determined Attendance

PS Planning Scenario

RA Risk Area

RADS Risk Assessment Definition

ROC Record of Casualty

ROF Record of Fatality

ROITYPE Record of Incident Type

ROR Record of Rescue

RTA Road Traffic Accident

SS Special Services

TGOBRA Time Generated Other Building Risk Area
TOT Turn Out Time

TQ Text Query

VO Valuation Office

144



	CONTENTS
	Introduction
	Purpose of this document
	Scope and approach to reviewing the FSEC Toolkit
	Overview of the FSEC Toolkit Review process
	Stage 1 – Pre Review Checks and Preparation
	1.1 F&RS FSEC Toolkit Review Preparation
	1.2 Self-reporting of Progress and Project Management
	1.3 Pre-Review Text Queries
	1.3.1 Copying Pre Review files to the FSEC Machine
	1.3.2 Exporting Summary Statistics and Performance Predictors
	1.3.3 Exporting Resource Definitions
	1.3.4 Exporting Risk Assessment Definitions

	1.4 Returning the Pre-Review Information to FSEC Help Desk
	1.5 Returning the Data Set and Data Files

	Stage 2 – F&RS review qualification
	2.1 Qualification for a Review
	2.2 Possible Project Management Issues
	2.3 Output of Stage 2

	Stage 3 – Review team load and run text queries and save exports
	3.1 Introduction
	3.2 Copying Review files to the FSEC Machine
	3.3 Stage 1 Results Review
	3.4 Road Network
	3.5 Stations, Crews, Vehicles and Planning Scenarios
	3.6 Dwellings
	3.7 Special Services
	3.8 Other Buildings
	3.9 Major Incidents

	Stage 4 – Review team desk top interrogation of FSEC text queries and exports
	4.1 Introduction
	4.2 Checking Read Only Risk Assessment Definitions
	4.2.1 Introduction
	4.2.2 Macro for checking read only RADS

	4.3 Checking the Road Network
	4.3.1 Introduction
	4.3.2 TQ011, TQ013, TQ012 & TQ017 – road links and dead ends
	4.3.3 TQ018, TQ019 and TQ020 - General tests of arrival times
	4.3.4 TQ024 – Risk Assessment Definitions; Road speeds
	4.3.5 TQ025 – Vehicle speeds
	4.3.6 TQ026 & TQ027 – Road link specific road speeds

	4.4 Creating Stations, Crews, Vehicles and Planning Scenarios
	4.4.1 Introduction
	4.4.2 Resource definitions
	4.4.3 TQ100: Fire station, vehicles, crews and costs
	4.4.4 TQ104 – Vehicle and crewing cost
	4.4.5. TQ105: Vehicles without crews
	4.4.6. TQ106: Turn out times
	4.4.7 StationJunction.txt: Station not connected to road network
	4.4.8 TQ107 to TQ109: Stations connected to vehicles
	4.4.9 TQ115 to TQ118: Alignment of planning scenarios and vehicle types
	4.4.10 TQ120 to TQ123: Are planning scenarios selected for each risk area?

	4.5 Processing Dwellings
	4.5.1 Introduction
	4.5.2 TQ150, TQ152, TQ160, TQ162, TQ163: Dwelling incidents
	4.5.3 TQ153: population multipliers
	4.5.4 TQ164: Population count
	4.5.5 TQ165: Missing output areas
	4.5.6 TQ166: Dwelling risk areas missing from a dwelling risk group
	4.5.7 TQ167: Dwelling risk group robustness

	4.6 Processing Special Services
	4.6.1 Introduction
	4.6.2 TQ200, TQ202 & TQ206: Data inputs
	4.6.3 TQ203: Missing output areas
	4.6.4 TQ205: Missing risk areas

	4.7 Processing Other Buildings Data
	4.7.1 Introduction
	4.7.2 Data inputs, TQ250-252
	4.7.3 Site assessments
	4.7.4 TQ260 – Output areas overlooked
	4.7.5 TQ261 – Risk areas overlooked
	4.7.6 TQ263 – TGOBRA for all high and very high risk areas
	4.7.7 TQ273 – HMOs or flats with ‘wrong’ number of storeys

	4.8 Major Incidents
	4.8.1 Possible errors
	4.8.2 TQ300: Major incidents data
	4.8.3 TQ302: Output areas linked to major incident risk areas

	4.9 FSEC Outputs (performance predictors)
	4.9.1 Introduction
	4.9.2 TQ152 & TQ200 – Dwellings and special services predicted deaths
	4.9.3. Other buildings performance predictors


	Stage 5 – Reviewer visit to F&RS for philosophy checks and follow up to Stage 4
	5.1 Introduction
	5.2 Possible Project Management Issues
	5.3 Dataset
	5.4 Road Network and Vehicle Speeds
	5.4.1 Review discussions
	5.4.2 Guidance on road network changes
	5.4.3 Guidance on road speed changes
	5.4.4 Overlays: Road network
	5.4.5 Overlays: Dead ends
	5.4.6 Overlays: Road continuity check
	5.4.7 Overlays: False junctions
	5.4.8 Overlays: One way
	5.4.9 Overlays: Check for output areas with no junction
	5.4.10 Overlays: General test of arrival times
	5.4.11 Overlays: Road link specific road speeds

	5.5 Stations, Crews and Vehicles
	5.5.1 Review discussions
	5.5.2. Overlays: Fire station and vehicles
	5.5.3 Overlay: Stations
	5.5.4 Overlay: Correct crew
	5.5.5 Overlay: Vehicle crewing cost/vehicle speeds
	5.5.6 Overlay: Vehicle type/vehicle cost/turn out times
	5.5.7 Overlay: Stations not connected to road network

	5.6 Planning Scenarios
	5.6.1 Review discussions
	5.6.2 Do planning scenarios cover all risks?
	5.6.3 Are the vehicle combinations specified for each scenario reasonable and evidence based?
	5.6.4 Phasing
	5.6.5 Overlay: Spot checks on assignment of planning scenarios to dwelling risk areas

	5.7 Dwellings
	5.7.1 Review discussions
	5.7.3. Overlay: Risk areas and groups– implementation of potential risk factor (PRF) in creating dwelling risk areas
	5.7.4 Overlay: Risk areas – missing output areas and planning scenarios
	5.7.5 Overlay: Risk groups – missing dwelling risk areas & planning scenarios

	5.8 Special Services
	5.8.1 Review discussions
	5.8.2 Overlay: Incident location
	5.8.3 Overlay: Risk areas – missing output areas and check on planning scenarios
	5.8.4. General process check
	5.8.5 Linear features
	5.8.6 City, town and village risk areas
	5.8.7 Background risk areas
	5.8.8 Overlay: Risk groups – missing risk areas

	5.9 Other Buildings
	5.9.1 Review discussions
	5.9.2 Overlay: Missing site assessments
	5.9.3 Adding in HMOs and purpose built flats
	5.9.4 Philosophy checks of data reconciliation
	5.9.5 Amending site assessments
	5.9.6 Creating risk areas, groups and TGOBRAs
	5.9.7 Overlay: Missing output areas
	5.9.8 Overlay: Missing risk areas
	5.9.9 Overlay to spot gaps in TGOBRAs
	5.9.10 Check on other building planning scenarios

	5.10 Major Incidents
	5.10.1 Review discussions
	5.10.2 Creation of risk areas
	5.10.3 Major incident planning scenarios and risk areas
	5.11 FSEC Outputs
	5.11.1 Review discussions


	Stage 6 – Rating of Modules
	6.1 Guidance
	Appendix A – Loading data, running text queries, exports and overlays
	A7.1 Loading the FSEC Datasets
	A7.2 Using Text Queries To Examine Results
	A7.3 Exporting WINGS data
	A7.3.1 Exporting Risk Assessment Definition Data
	A7.4 Running Review Overlays

	Appendix B – How to import files into MS-Excel and run the review macros
	B8.1 Importing Text Query Results into MS-Excel
	B8.2 How to Load and Run MS-Excel Review Macros
	B8.3 How to Run Specific Macros
	B8.3.1 Table comparisons macro
	B8.3.2 Incidents
	B8.3.3 Other building assessments


	B8.4 Risk Area Planning Scenarios

	Appendix C – Standard review worksheets
	Appendix D – Standard review worksheets
	Appendix E: Reference data
	Appendix F – Glossary

